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Global and Home Page Tasks 

In the following section are tasks that affect ANGEL settings throughout the user’s ANGEL site 
and that are not limited to a specific course. They include tasks on the user Home page or that 
are accessed using the buttons or links on the left panel. 

 

How to Change Personal Information 

How to Customize the Course Page 

How to See Courses That Are Disabled 

How to Remove Courses from Course List View 

How to Merge Two (or More) Course Rosters for Multiple Sections 

How to Set Up and Use a Master Course 
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How to Change Personal Information 

ANGEL not only allows you to add and/or edit your personal information, but it also allows you 
to control who can access specific portions of the information. 

To change your personal information: 

1. From any part of ANGEL, once you have logged in, click on the Preferences button. 

 

2. Click Personal Information. 

 

This will open the User Profile Editor. Changing the Settings to Advanced will give you more 
options. 

Within each section, and sometimes for individual items, you can designate what groups of 
users can see that information. The groups are based on Rights; selecting a group specifies the 
minimum level of Rights needed to see that information. 
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You can fill in any information that you want. Information that has already been added through 
your system may vary depending upon your institution. You cannot change your Username. 
Your institution may further designate other information that cannot be changed. 

In the example below, the student is allowing other students to see her email address, but only 
Course Editors (faculty) can see her home and work phone numbers and her address. 

 

 

You can have students use the About Me section to do a small web page 
that tells about themselves. Because the HTML Editor can be used to 
format it, they can add pictures and hyperlinks. Some faculty use this as 
an alternative to having students create a simple introductory web page. 
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When finished adding all information, click Save at the bottom of the page. 

 

The User Profile information can be viewed in the Course Roster in the Communicate tab in 
any course in which that user is a member. Go to Communicate > Course Roster. 
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 Click User Profile beneath the user whose profile you want to view. 
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 The information that you are permitted to see will display. 

 

 

A student in the same course can only see the email address, as that was 
how it was set up by “Salli.” 

 

Personal information can also be viewed from the People Search on the ANGEL Log On page, 
if that option is available there. The information that can be obtained will only be information that 
has been designated for Everyone to see. 

1. On the ANGEL Log On page, click People Search. 
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2. On the next screen, add a name in the Name window and click Search. 

 

3. Salli’s name appears as Sparrow, Salli. Click on that. 
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Clicking on the name only displays her name again. Since you have NOT logged on, this 
is all you are permitted to see. 

 

If Search and Help Links has been added to your ANGEL Home page, you can also access 
personal information. The information that you can view will be limited by the information 
supplied by the person and the access levels set by them. From your Home page, click on 
People Search. 

 

1. On the next screen, add a name in the Name window and click Search. 
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2. Salli’s name appears. Click on the name. 

 

This time, since you are logged on with instructor rights, you can see the same 
information as you saw in the Course Roster. 
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How to Customize the Course Page 

You can edit the contents and organization of the Course, Resources, and Communicate 
pages within ANGEL. This allows you to add different nuggets that are most useful for you and 
your students in the delivery of your course. 

In this example, you are going to reorganize and add components to the Course page. On the 
Course page, click Edit Page. 

 

1. The editing screen will appear. Click Add Component. 

 

A pop-up window will appear advising you that the activity is being processed. 
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Another pop-up window will appear that will allow you to choose the components that 
you want to add. 

 

2. Scroll through the components and check any that you want to appear on the Course 
page. You are going to choose to add the Syllabus, Last Lesson (bookmarking), and 
Course Calendar. 
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You can also designate where the components will be placed: 

 

And how they will appear. 
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You might want to experiment with different settings to see what works best for your 
course. 

3. Click Add Selected when you are finished. 

 

The nuggets have now been added. 



How to Customize the Course Page  17 

 

You can drag and drop the various nuggets to place them where you want them on the 
page. 

 

4. Click Save when you have finished. 
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The new components are now in place. Using Edit Page, you can rearrange the nuggets 
again until you are satisfied with the course components. 

 



How to See Courses that are Disabled  19 

How to See Courses That Are Disabled 

Many institutions choose to have courses created in ANGEL in a “disabled” state. There are 
several reasons to do this. The primary reason is that students cannot see any courses that are 
disabled, even if they are on the course roster. This allows the instructor to develop the course 
before students can access it. Some institutions have all course shells uploaded into ANGEL, 
and then give instructors the choice of using the courses or not. Having them disabled keeps 
the courses that are not developed into ANGEL from being seen by students. 

However, instructors also will not see their disabled courses unless the option to see them has 
been set within the Course Edit function. If you are not seeing your disabled courses, you will 
need to set the option to see them. 

1. Log on to ANGEL and hover over the end of the Courses nugget toolbar so that the Edit 
icon is visible. Click on the Edit icon. 

 

2. You will see all your courses listed. The checkmark next to each course indicates that 
you will be able to see the courses listed on the Home page. At the bottom of the page, 
change Show Disabled courses to Yes and then click Save. 
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Note the other options that can be chosen. For example, if you do not 
want some of your courses to be displayed on your Home page, unclick 
them and then Save the settings. 

The course is now visible on the Home page. Note that it is labeled as Disabled. 

 

 
To enable the course so that students can access it, see How to 
Activate/Deactivate a Course. 
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How to Remove Courses from Course List View 

If you have courses listed on your ANGEL Home page that you no longer need to access, you 
can remove them from the list so they are not viewable. This does not actually delete the 
course; it merely removes the course from your view. 

1. Go to your ANGEL Home page. 

 

2. Roll the mouse over the right side of the Courses bar until the editing icons appear. 

3. Click on the Edit icon (the pencil). 

 

You will see all your courses listed. 
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4. Uncheck the box next to the course(s) that you want to delete from your course list. 

 

5. Click Save at the bottom of the page. 

 

The course is no longer listed on the Home page. 
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If you need to make the course(s) visible again, repeat this procedure and recheck the box next 
to the course you want to add to the list. 
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How to Merge Two (or More) Course Rosters for Multiple 

Sections 

Sometimes it is useful to merge two or more sections of the same course into one course, so 
that the course rosters from both courses are contained within one. This can also be useful for 
courses that are cross-listed and taught by the same instructor. You need to have Course Editor 
rights to all sections that you want to merge. 

 

Any content in the courses from which the rosters are merged will 
NOT be imported into the new course. If you already have content in 
one of the courses to be merged, create an ANGEL archive of the course 
contents (Manage > Export Wizard > ANGEL Archive). Once the new 
course has been created, you will be able to import the content into it 
(Manage > Import Wizard > Content Package). 

1. On your ANGEL Home page, click Merged Roster Manager. 

 
Some institutions may limit access to this procedure. Check with your 
ANGEL administrator if you do not see the Merged Roster Manager link. 

 

2. The next screen will display all the courses in which you have Course Editor rights. Click 
the box next to each course you want to merge and then click Continue. 
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3. Input a title for the merged course. Select the course with the classification code that is 
to be used by the merged course. 

4. Decide whether you want to be able to access the source (original) courses and if you 
want those courses to be disabled. 

 
By checking the Disable Source courses box, you will only allow students 
to get into the merged course, not the source course. 

Teams are created from each roster. You can change the team names if desired. 

 

Having the teams automatically created can be very helpful, especially if 
you will be creating any content items for the different course members or 
if you otherwise need to divide them into their teams. For example, within 
the Gradebook you can elect to see grades for each team separately – a 
useful feature if you need to enter final grades elsewhere for each course. 

5. Click the Create Course button to continue. 
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6. The next screen will display the progress of the merge roster process. You can then 
elect to merge more courses or return to the Home page. 

 

The new merged course now displays in the Courses nugget. 
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Once courses have been merged, you cannot change the merged course 
to add more sections. You would have to create a new merged course 
from all sections. 
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How to Set Up and Use a Master Course 

A Master Course serves as a template for a course or specific group of courses. It is imported 
into a course shell using the Import Wizard tool. It is developed exactly like any other course 
and includes the same sections and features as other courses. Access to the course is set up 
by using filters when the course is created that designate what courses can use the Master 
Course. 

A Master Course has the following uses: 

 A single course that has multiple sections with many faculty teaching it, in order to 
maintain consistency and quality 

 A course taught by one faculty member every semester, as an alternative to a Copy 
Course or importing an Archived Course 

 A template for college, division, or department courses that need to have certain 
elements included within them. 

 
Once a Master Course has been imported, faculty can add their own 
content to it. 

Tell your System Administrator that you need to have a Master Course set up. Only the 
System Administrator has rights to create Master Courses. The System Administrator generally 
needs to know: 

 The name of the course 

 The Course Editor for the course; other members can be added after the Master Course 
shell is created 

 Whether or not you want to specify a PIN (password) for the course. Only those persons 
who have the PIN would be able to import the Master Course 

 What courses need to be able to import the Master Course and how it will be used. 

Once the Master Course has been created, you will see it listed among your courses – if you 
are a Course Editor within that Master Course. Before the Master Course can be imported, it 
needs to be developed with all content completed. 

 

If a course has already been developed and you want it to be used as a 
basis for a Master Course, it can be imported into the Master Course by 
using Copy Course. You need to have Course Editor rights to both the 
Master Course and the course being copied. 

 

 

You do NOT need to have any editing rights within the Master Course in 
order to import it into one of your courses. As long as your course matches 
the filter criteria set up for the Master Course, you will be able to import it. 
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To Import a Master Course, enter the Course into which the Master Course will be imported, 
and go to Manage > Import Wizard. 

1. On the following page, click Master Course. 

 

2. You will see any Master Courses associated with the course in the drop-down list. Select 
the Master Course you want to import from this list. 

.  

If the Master Course could only be accessed through use of an assigned PIN, you would 
enter that instead of choosing a course from the drop-down list. 
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The final options on that page allow you to: 

 Convert any Quizzes (the older test/quiz tool in ANGEL) within the Master Course to the 
newer Assessments tool. If this tool was not used in the Master Course or if you do not 
choose to have them converted, do not check this option. 

 Backup the new course before importing. If no content has been added to the new 
course, however, this is not necessary. 

 Replace existing content. If any content has been already added to the new course, this 
will erase it. Uncheck it if content has been added and you do not want to lose it. 
Importing the Master Course will then add content to the course, but will not delete what 
is already there. 

 
Check for any duplications in content, especially in the Gradebook, 
Calendar, and Announcements. 

3. Click Import to continue. 

 

4. You will see a progress page as content is being imported. Click Exit Import Wizard 
when finished. 
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Importing from a Master Course creates a copy of the Master Course; it 
does not link the course to the Master Course. If any changes or additions 
are subsequently made to the Master Course only, content in any courses 
that were created from it will not reflect those changes. 

 

 

If you anticipate adding additional material to the Master Course and you 
want any courses created from it to automatically be updated as well, 
consider creating the content in an LOR (Learning Object Repository) and 
then linking to that content in the Master Course. All courses created from 
the Master Course will then also have that link to the LOR and will be 
updated as the linked content in the LOR is updated. (Be sure that the 
course also has access rights to the LOR.) 

For more information about linking and updating from an LOR, see How to 
Link or Copy Content from a Learning Object Repository into a Course. 
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Content Management Tasks 

This section addresses those procedures that involve adding content and activities within 
course sections.  Tasks in this section are listed and linked below. 

 

How to Organize Content 

How to Edit a Syllabus 

How to Upload Files for Course Use 

How to Share Content Within a Learning Object Repository with Other Courses and Users 

How to Link or Copy Content from a Learning Object Repository into a Course 

How to Copy Content Items from One Course to Another 

How to Upload Images in a Content Item 

How to Add Images to a Content Item: Creating an Image Gallery 

How to Upload a Web Page and Its Contents 

Understanding the Difference Between Assessments and Quizzes 

Assessments: Understanding Options and Settings; Creating an Assessment’s Content, Access, and 
Interaction Settings 

Assessments: Understanding Options and Settings; Review and Assignment Settings 

How to Use Question Sets 

How to Use Question Banks: Definition of Question Bank and Creating a Question Bank 

How to Use Question Banks: Creating an Assessment from a Question Bank 

How to Use Question Banks: Creating an Assessment with Question Pools 

How to Create a Secure Assessment 

How to Create a Pass/Fail Exam 

How Students Can Reenter an Exam 

How to Grade an Essay or Short Answer Question 

How to Increase the Maximum File Size for Drop Box Submissions 

How to Grade a Drop Box Assignment 

How to Grade Drop Box Submissions Offline 

How to Integrate PowerPoint Presentations 

How to Set Up and Use Games: Crossword Puzzles 

How to Set Up and Use Games: Quiz Shows 

How to Set Up Teams Within a Single Discussion Forum 

How to Create an RSS Feed 

How to Subscribe to a Course RSS Feed 

How to Set Up the Gradebook: Preferences and Grading Scale 

How to Set Up the Gradebook: Categories and Assignments 
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How to Rearrange Categories and Assignments in the Gradebook 

How to Create an Extra Credit Assignment 

How Students Can See Their Grades 

How to Create a Survey 

How to Create Teams 

How to Set Up Team Projects 

How to Rebalance Teams 

How to Set Team Access Rights for Lesson Content 

How to Automate Sending an Email to Students Who Have Not Logged onto a Course Within a 
Specified Time Period 

How to Release Content to Students 

How to Release Content Conditionally by Using an Agent 

How to Post a Grade for a Survey by Using an Automated Agent 
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How to Organize Content 

One of the best ways to organize content in ANGEL is to use folders and add content items 
within the folders. This allows you to organize your content into whatever type of unit is best 
suited for your course; that is, Modules, Units, Lessons, Weeks, Chapters, and so on. Note 
the following example. 

1. Go to Lessons > Add Content > Folder. 

 

2. Add the Settings for the Folder. You can use the Subtitle to add the dates for the unit. 

 

By using Advanced Settings, you will have access to the inline HTML Editor. This 
allows you to add some text to the folder by which you could give instructions for the 
unit. When students click on the folder and open it, they will be presented with the 
instructions and information about that unit, as well as any content that pertains. 
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There is a token used in the above example ($FIRST_NAME$). When 
users view that area, they will see their own names instead of the token’s 
text. There are a variety of tokens that can be used. See the Instructor 
Reference Manual or later in this Appendix for more examples of tokens. 
You can always do a search on the term itself to find more examples. 

The example above will appear like this when the student opens the folder: 

 

3. Add any content items needed to the folder using Add Content. In the above example, 
you need to add a Discussion Forum, an assignment Drop Box, and a Quiz. 
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4. Continue to add and set up all content items. 

 

5. If you want to rearrange the order of the content items, click Rearrange. 
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6. Then on the next screen, use the mouse to drag and drop the items into the desired 
order. 

 

7. You can use the Section Heading content item to add any additional text between 
content items. Go to Add Content > Add Section Heading. 

 

8. Add the Settings for the Section Heading and Save it. You can use the Page Text area 
to add additional text, images, and/or hyperlinks. In this instance, you are only using the 
Title. 
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After saving, the Section Heading is visible. 

 

 
You may need to use the Rearrange option again to place the Section 
Heading where you want it. 
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If you have other content items that do not pertain to any one particular module, you may want 
to create a folder for those on the main Lessons page. For example, if you have a project that 
is to be done over several weeks, you could create a folder for that and place it outside any of 
the unit folders. 
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How to Edit a Syllabus 

Once a syllabus has been created or uploaded into ANGEL, it can be edited. Exactly how it is 
edited will depend upon the format used. A syllabus can be created by using the Syllabus 
template; by uploading a syllabus created as an HTML page, a Word .doc, or other format; by 
creating it using the Create a Page option; or by linking to an external web page. Editing the 
syllabus will depend on how it was created. 

Editing a Syllabus Using the Syllabus Template 

1. Go to the Syllabus nugget, usually found within the Resources section, roll the mouse 
over the end of the Syllabus bar until the Edit icon (pencil) appears and click it. 

  

2. On the following screen, click Syllabus Editor. 

 

3. Make any needed changes. 
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4. Click Save at the bottom of the page to finish. 

 

Editing a Syllabus that was Uploaded as an HTML file: 

1. Follow step 1 above. On the following screen, click Syllabus Files. 
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Because the syllabus selected in this course is an uploaded file, the 
Syllabus Editor button does not display. 

2. The syllabus file will be displayed on the next page. Click edit. 

 

 

There may be more than one file listed here if the syllabus file had any 
images or other documents linked within it, so be sure you select the 
correct file. 

3. Scroll to the bottom of the window that will appear and click HTML Editor. 

 
The text in the window is in HTML code. Selecting the HTML Editor will 
allow you to edit any text using the more user-friendly format. 
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4. Make any changes that need to be made. 

5. Click the OK button at the bottom of the Editor. 

 

6. You will return to the Syllabus Files page. Click Exit Syllabus Files to finish. 
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Editing a Syllabus Uploaded as a Document 

While it is not preferable, a syllabus could have been uploaded as a document file. If a syllabus 
in this format needs to be changed, it has to be changed within the word processing program in 
which it was created. For example, if it is a .docx file, it has to be changed within Microsoft 
Word® 2007. 

1. Open the word processing program (for example, Microsoft Word), and then open the 
syllabus file. 

 

2. Make any changes, and Save the file. 

 

When saving the file, do NOT change the file name. You want the file 
name to be the same as the name of the file already uploaded into 
ANGEL. 

3. If you do not have the original file, you can download it from ANGEL so that your word 
processor can have access. Go to Syllabus Files, locate the original, click download, 
and then Save it to your computer so that your word processing program can perform 
the edits. 
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4. Once the file has been edited and saved, return to the Syllabus nugget in your ANGEL 
course and click on the Edit icon as previously illustrated. On the next screen, click 
Syllabus Files and the screen shown here (see above and below) will appear. 

5. Click delete beneath the correct syllabus file. (You want to delete this file so that you 
can then upload the just-edited file that has the same name.) 

 

6. The next page will say, “Are you sure you want to delete this file?” Click OK. 

 
This will completely delete the syllabus from your course, so be sure that 
you DO have the elsewhere-edited syllabus file ready to be uploaded. 

 

7. Once it has been deleted, you will be returned to the Syllabus Files page. Click Add 
Content. 
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8. Click Upload Files. 

 

9. Click Browse to locate the edited file on your computer. 

10. Locate the file on your computer and either double-click it, or highlight it and click Open. 

11. Click Upload File. 

 

12. The next page will tell you that the upload was successful. Click Exit Syllabus Files to 
finish. 
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How to Upload Files for Course Use 

There are several ways to upload files to be used in course content. Exactly which procedure to 
use will depend upon how the files are to be displayed and how they are associated with other 
content items. 

Files Used as Content Items in Lessons 

If a file is to be used within Lessons as a specific content item (that is, it is displayed as a 
content item when students go to the Lessons section), then you would use the Add Content > 
Upload file procedure. 

1. Go to the section in Lessons where the file is to appear, and click Add Content. In this 
instance, you will add a file to a folder. When students open the folder, they will be able 
to access the file. 

2. Select File. 

 

3. Click Browse to find the file to upload. 



How to Upload Files for Course Use  49 

 

4. Find the file, highlight it, and click the Open button. 

 

 

When deciding on a file format to use, consider the size of the file and the 
ability of students to open specific file formats. In this instance, a 
PowerPoint® file was converted to a PDF format both to reduce the file 
size and to utilize a format that all students can access. The most user-
friendly file formats to use are PDF, RTF, and HTML formats. 

5. The path to the file will now appear in the field adjacent to the Browse button. Complete 
the information by adding a title for the file in the Title window, and then click the 
Upload File button 
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If you do not add a title in the Title window, the “title” will be the file name 
(which will be the text that appears in the module). For example, if you did 
not add a title like the one shown here to the file you uploaded, it would 
appear as powerpoint.pdf which may not be very meaningful to students. 

.  

6. The next screen will show that the file upload was successful. Click OK to finish. 

 

The file is now in place within the module folder. 
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Uploading Files Linked Within an HTML (Web Page) Document 

Very often HTML pages contain images and links to other documents. When uploading the web 
page as a content item, you also need to upload all documents and images that are linked 
within that web page. One of the easiest ways to do this is to use the Drag and Drop option 
while uploading the web page. 

To begin, follow Steps 1 and 2 above. 

1. On the next screen, choose the Drag-n-Drop button. 

 

2. If you have never used this feature before, you will be prompted to install it. Follow the 
prompts. When you are finished, the page should display as shown below. 
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3. Locate ALL the files that you need to upload and drag them onto the Drag-n-Drop 
window. 

 

 As the files are being copied over, you may see a progress window: 
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4. Click the OK button. 

 

5. The following screen will ask you to name the content item/web page and to select the 
web page file from the group of files that were uploaded. This is the page that will display 
in the folder. 
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The Drag-n-Drop feature can ONLY be used when there is a single page 
to be displayed as a content item within Lessons that has files linked 
within it. If you want to upload multiple pages that are to be displayed as 
content items, you will need to upload them separately or you can 
compress them as a single zip file (use Manage > Import Wizard > 
Content Package to upload the zip file) and then extract all files during 
that process. 

6. Click OK to continue. 

 

7. The page is now listed within the folder contents: 
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8. Clicking on the link will display the page. 

 

 

In this example, there was a document in pdf format that was linked to the 
original page where it says Print version. When you did the Drag-n-Drop, 
you also uploaded this document file. If that file had not been uploaded 
with the rest of the files, there would be a File Not Found error when 
students click on that link. 

Below is a small segment of the web page. The image displayed is one of the uploaded image 
files. 
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How to Share Content Within a Learning Object Repository 

with Other Courses and Users 

One of the advantages of using a Learning Object Repository (LOR) is that content within a 
LOR can be shared with other courses and users. This requires settings within the LOR to make 
the content available to others. 

1. Click on the LOR button. 

 

2. Open the LOR that contains the content to be shared with others and go to the Manage 
tab. 

3. Click on Course and Group Access. 
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4. In the Add Associations From column, select Course Search. 

 

The Course Search options will appear. 

You can search for a course by using a keyword, such as the Instructor’s name or part 
or all of the title or Course ID, or you can apply as many of the criteria that might apply 
in order to select the course. Note that you can search by term, location, school, 
department, and so forth. 

The terms used here will be those that are set up by your institution, and may differ from 
the terms used in the example. If no criteria are set, you can also click the Search button 
and all courses within ANGEL will appear. In this example, you just used the search 
criteria All in the Term selector. 

5. Check the box next to all courses that you want to have access to your LOR, and then 
click the Add Selected button. 
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The courses have now been added to the access list: 

 

Going into the last course on the above list, you see that the course can now access the 
LOR. 
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Even though specific courses can access an LOR, the course editors for 
those courses cannot make any changes to the content items linked within 
the LOR unless they also have editing rights within the LOR. 
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How to Link or Copy Content from a Learning Object 

Repository into a Course 

The purpose of a LOR is to house content that is sharable, portable, and reusable. All faculty 
have their own personal LOR; and LORs can be also be created for specific courses, 
departments, divisions, and so on, so that users can share the content items. 

Using a LOR to store content is a good choice when you are teaching several sections of the 
same course and/or you’re teaching the same content for more than one semester, especially if 
you will be editing or adding to the content. By being linked to the content in a LOR, courses will 
always have the most current content without faculty having to go into each course and make 
the changes individually. 

If you have large files, such as video or audio files, that are used in more than one course, you 
can save valuable file space by having all courses linked to those files in a LOR. 

If you need to make changes to specific content items within the courses themselves, however, 
using a LOR may not be helpful because it will not allow you to edit any linked content items 
except from within the LOR. 

1. Open your personal LOR. If you have never used your personal LOR, use the 
Repository button to create the LOR. 

 

If your LOR has already been created, you can also access it from your Home page. 
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Curricular, departmental, divisional, or institutional level LORs are not 
automatically created by the system. You should check with your ANGEL 
administrator if you want to create a LOR for the level of curriculum, 
department, division, or institution. The same procedure illustrated here 
will apply to those LORs as well. 

2. Click Add Content. 

 

You are going to add a folder, and then add a file to that folder. 

 

By adding a folder, and then linking within a course to that folder, you can 
be sure that such contents for that course will be updated every time new 
items are added to the folder. 
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3. Apply Settings to the New Folder and Save. 

  

4. The next screen allows you to upload content into the folder. Click Add Content > Add 
a Content Item. 

In this example, you are uploading a document. 
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For more information on how to upload files as content items, see How to 
Upload Files for Course Use. 

 

 

In order for the content in this Repository to be used by other courses, you 
will need to give them access to the Repository. See How to Share 
Content Within a Learning Object Repository with Other Courses and 
Users. 

5. Close the Repository and open the course that is to be linked to the content in the LOR. 
Click the Lessons tab. 

6. Click Add Content in the location where you want the content to be added. In this case, 
you are going to add a Module folder; so you will add it to the main Lessons page. 

7. On the Add Content screen, scroll down to the More Options section and click Import 
from Learning Object Repository. 

 

8. In the top section, use the drop-down list and highlight the Repository that you want to 
link to. 
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9. Then click the Browse button. 

 

10. The content items within that Repository will be displayed. Click the box next to any item 
that you want to use in your course, and then click the Link to Items button. 

 

Linking to the item will allow the content to be automatically updated within 
the course every time it is updated in the LOR, including the addition of 
new content items if they are added to that folder in the LOR. 
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11. The next screen will show that the items have been imported. Click Done to finish. 

 

12. Returning to the Lessons page, you will see that the new folder has been added. The 
small upward-pointing arrow in the lower corner of the folder icon indicates that this is a 
link. If any changes need to be made within this folder, they can only be done within the 
folder in the LOR. 
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13. Opening the folder, you see that the file which was within the folder in the LOR is now 
within this folder as well. 

 

14. If you return to the LOR and add another document to the folder... 

 

...it will also be added to the folder in the course: 
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15. If you add an Assessment in the LOR, then you also need to add it as an Assignment to 
the Gradebook within the course. 

If this is not done, all submissions and grades will only appear in the LOR and will not be 
recorded within the course. In this example, you have already added an Assessment to 
the LOR. When it was created, you added it as an Assignment. It now appears in the 
course also. 

 

 

Because this is linked to this actual Assessment within the LOR, you 
cannot make any changes to the settings within the course. All settings 
must be changed within the LOR. 



How to Make an Assessment a Gradebook Assignment 69 

How To Make an Assessment a Gradebook Assignment: 

1. Go to the Gradebook (Course Management > Gradebook) within the course. 

 

2. On the following screen, click on Import Assignments. 
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3. Select the Repository from the drop-down list and then click Select. 

4. All Assessments available within the Repository will appear. Check the box next to the 
correct Assessment, choose the Category, and then click Import. 
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5. The list of Assignments will appear with the new Assignment in place. 

 

 

If Drop Box Assignments and Discussion Forums are linked to a LOR, all 
submissions will post to the LOR and not within the course. Therefore, 
unless there is a specific reason to do so, you need to copy those items 
and not link them. 

Items that are copied and not linked will NOT update if they are updated in 
the LOR. 
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How to Copy Content Items from One Course to Another 

You can copy individual content items from one course to another. You need to have Course 
Editor rights in both courses to have access to the content. This procedure only copies items 
found in Lessons. 

 

If you need to copy an entire course, which would include 
Announcements, Calendar items, Gradebook, and so forth, then you need 
to use a different option, such as importing from a Master Course by using 
Copy Course, or importing from an Archive. 

1. In the course where you want to place the content, go to Lessons and the location to 
where the content is to be copied. In this example, you will copy the Module 1 Folder 
and all its contents from one course to another. 

2. Click Add Content. 

 

3. Select Import from a Course or Group. 
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4. Select the course (from which the content items will be taken) from the drop-down list on 
the next screen, and then click Browse. 

 

All of the content items in the course will appear. Clicking the link on any folder will also 
expand its contents and allow you to choose individual items within that folder. 

 

For example, clicking on the Module 1 link above will expand that folder to reveal its 
contents. Clicking the box next to any item will select it to be copied. You can select 
more than one item. 

 
While you can click on individual items within a folder and only copy those, 
you cannot choose individual items within one folder and then also copy 
another folder in its entirety at the same time. You can only copy items at 
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the same level at one time. 

 

5. Here you will copy Modules 1, 2, and 3 by clicking the box next to each one. Click Copy 
Items to continue. 
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Note that there are some additional options that can be checked for Quizzes and 
Assessments. 

6. After all items have been copied, the following screen appears to show that the process 
was successful. In this example, the screen states that 20 items have been copied 
(Imported). This refers to all of the content items contained within the folders. Click 
Done to return to the Lessons section, or click Continue to return to the Import Menu 
screen and import more items if necessary. 

 

7. The folders have now been added: 

 

8. Apply any Settings needed to content items so that they apply to this course. 

 

You can also export content items from one course to another course by 
selecting Export Item from the Utilities link of any content item. However, 
while this would allow you to export an entire folder and all its contents in 
one step, you can only EXPORT one content item at a time (that is, one 
folder OR any of its individual contents). Using the above procedure allows 
you to COPY as many items as needed at one time. 
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You can also copy items from a LOR by using a similar procedure, except 
you would select Import from Learning Object Repository. 
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How to Upload Images in a Content Item 

Images can easily be uploaded and appear within any content item by using the inline HTML 
Editor, which is available wherever text can be added – including emails, discussion forum 
postings, content item descriptions, assessment questions, and other areas. 

In this tutorial, you will upload an image into Directions for an Assignment Drop Box. The 
procedure is the same that would be used anywhere the inline HTML Editor is available. 

1. Click Add Content wherever the content item is to be added. In this example, you are 
adding content to the Module 1 Folder. 

2. Click the content item type that you want to add. Here you are adding a Drop Box. 

3. Add a title to the Drop Box, and then go to the inline HTML Editor section. In this 
example, it is used to format the Directions. 

 

 

You may need to be in the Advanced view to bring up the inline HTML 
Editor for some content items. For example, the editor is only visible in the 
Advanced view when creating a Folder. 

4. Add any text and format it as needed. 

 

5. Place the cursor where you want to embed the image, and then click on the Image 

 icon. 
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6. The following pop-up window will appear. Click the Browse Server button to continue. 

 You must disable any pop-up blocking software. 

 

7. Another pop-up window will appear. Click Browse to find the image file you want to 
upload. 
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8. Locate the file and double-click on it to select it, or click on it and then click the Open 
button. 

 

9. The path to the image file will now be in the Browse field. Click Upload File to upload it. 
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10. The file will be listed in the larger window. Click on it to select it. 
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11. The first pop-up window appears with the image in the Preview window. You could also 
add text beneath the picture within that window. Note that you have added a very short 
title in the Alternative Text field. This text would appear if someone were using a screen 
reader or otherwise could not view the image. Click OK to continue. 

 

The picture is in place below the text within the Directions section. 
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12. Continue with any other settings needed for the assignment, and then click Save. 

 

This is how the assignment will appear to the student: 

 

 

When selecting pictures to embed, keep the picture dimensions (height 
and width) and file size in mind. Most digital cameras come with some 
type of imaging software that will allow you to edit photos and also resize 
them. In this example, the original photo (3488 x 2688 pixels and almost 5 
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MB in size) was reduced to 300 x 225 pixels and 12.4 KB. This editing 
greatly reduces the time that the picture takes to load, and the picture also 
fits better within the screen. 

 

 
For more information on using the inline HTML Editor, see the HTML Editor 
Reference Manual in the Guides section of online Help. 



How to Add Images to a Content Item: Creating an Image Gallery 84 

How to Add Images to a Content Item: Creating an Image 

Gallery 

Most content items in ANGEL can access the inline HTML Editor. Using this editor is one of the 
easiest ways to add an image to the content item. The HTML Editor is generally available in the 
Content tab of the content item settings; but it is also available wherever you can add text, such 
as in a Discussion Forum posting, in the Calendar, in an Assessment question, or in an email 
message. Students also can access the HTML Editor when making Discussion Forum postings, 
sending emails, or creating pages in Team files. 

In this tutorial, you will add some images to a folder. This will have the effect of a photo gallery, 
so that when the folder is opened the pictures will display. The procedure for adding images is 
the same wherever the HTML Editor can be used. 

1. Create the folder by going to Lessons > Add Content > Folder. 

 

2. Check Advanced Settings so that the HTML Editor appears in the Page Text section 
below the Subtitle. 

3. Add a Title for the New Folder. Then click within the Page Text section and begin 
adding text. 
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4. In this example, you want to embed images within table cells so that those images will 
be in columns and rows. Click on the Table icon to add a table. 

.  

5. The following pop-up window appears so that you can set the table format. You are 
going to create a table of 2 Columns and 3 Rows. If you need to add or delete a column 
or row later, the table can be edited. You are also going to cause the table to be 85 
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percent of its full size in Width, and you want its Alignment to be centered on the page. 
This table also has its Cell spacing and Cell padding set to 3, which allows more space 
between table cells. Click OK when all the details have been entered. 

 

6. The table framework is now in place within the Page Text field. To put an image in one 
of the table cells, click within one of the cells and then on the Insert/Edit Image icon as 
shown below. 

 

7. A pop-up window will appear. Click the Browse Server button. 
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Be sure that any pop-up blocking software has been disabled, so that pop-
ups are allowed within ANGEL. 

 

8. Another pop-up window will open. Click the Browse button to upload the desired image 
file from your computer. 
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9. Browse to find the file you need, select it, and then click the Open button. 

 

10. You will be returned to the pop-up window. Click Upload File to continue. 
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11. You will see the image file that you uploaded in the window. Click to select it. 
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 As other files are uploaded, they will also be listed in this window. 

12. The original pop-up window will display with the image (in this case, a photograph) and 
details listed. Click OK to add the picture to the table. 

 

It is good web practice to add descriptive text in the Alternative Text field 
for accommodation purposes. This text would appear if someone were 
using a screen reader, for example, and unable to see the image. 
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13. Add other image files using the same procedure, putting a different picture in each table 
cell. When you are finished, all cells will have pictures. Below is a partial view of the 
completed gallery. 
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How to Upload a Web Page and Its Contents 

While ANGEL allows users to create web pages using the HTML Editor, you can also upload 
existing web pages together with all images and other files linked to them. In this tutorial, you 
will upload a web page that has several images embedded within it. 

1. Go to the location within Lessons where the web page needs to appear, and select Add 
Content > File. 

 

2. In order to have the web page appear with all associated images, all of the files – 
including the image files and the web (HTML) file – must be uploaded. On the following 
screen, add a title for the file and then click Drag-n-Drop. 

 
You could browse and upload each file separately, but choosing Drag-n-
Drop allows for all files to be uploaded at the same time. 
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3. Locate all of the files to be uploaded and drag them onto the Drag-n-Drop window where 
indicated. 

 The first time that you use Drag-n-Drop, you will be prompted to install it. 

 

4. Once all the files have been uploaded, click OK. 
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5. On the following page, ANGEL asks for the Default File. This is the web page file that is 
to appear as the content item. It will have either an .htm or .html file extension. 

 

6. Click OK to finish. 
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The web page will now appear as a content item. 

 

When clicked, it will display with all images intact. 
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Understanding the Difference Between Assessments and 

Quizzes 

The addition of Assessments brought some significant improvements to online testing abilities 
within ANGEL. 

Changes in Settings 

 No change in Content, Access, Automate, and Assignment sections. 

 The Delivery section in Quizzes is renamed Interaction in Assessments. 

Delivery Settings 

 New Quiz: Normal or Advanced. 

 Take Quiz: choice of Enabled or Disabled. 

 

 Assessments: 

You can set specific dates and times for Date Enabled and Date Disabled. 

  

Significance: Enabled refers to the condition that allows the Assessment to be taken. 
Disabled means that the Assessment can no longer be taken. This is different from the 
Start Date and End Date that refers to how long the Assessment content item is visible 
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to students. Allowing an Assessment to remain visible after it is Disabled permits student 
access for further review and feedback. 

In Assessments, what used to be a manual process (changing Enabled to Disabled) can 
now be done automatically. 

Display Mode 

 Quizzes: 

You can choose to have questions display all at once, a single question at a time, or a 
single question with no backtrack. Within this section, you can also cause questions to 
be randomly scrambled and/or answer choices to be randomly scrambled. 

 

 Assessments: 

You can choose to have questions display all at once, one set of questions at a time, or 
one question at a time. A Question Set, something new in Assessments, allows for the 
grouping of questions with different configurations and settings. This is somewhat 
analogous to Section Headings in Quizzes, but Question Sets have more options. Note 
that you can also create Question Titles in Assessments, with the option of having them 
displayed with the questions. 

 

Question Set Defaults  

 Quizzes: Not available. 

 Assessments: 
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There are options that can be applied to each Question Set, but some of these options 
are only available with specific question display choices. 

 

See Assessments: Understanding Options and Settings; Creating an 
Assessment’s Content, Access, and Interaction Settings for more 
information about these options. 

 

Submission Settings 

 Quizzes: 

These are found in the Submission section. You can set the number of times students 
can take the Quiz, as well as the validation options. This section also allows for some 
Auto-save options and anonymous submissions. 

 

 Assessments: 

Submission Settings remain in the Interaction section. 

New options are available, such as Mastery and Save. With the Mastery option, 
students can retake assessments until they attain a specified score. You can set the 
maximum number of tries in Attempts Allowed. The Save button allows students to 
save their work and return later. There is no longer any need for Auto-save because all 
answers are automatically saved. 
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Time Settings 

 Quizzes: 

Time Settings remain in the Delivery section. 

 

 Assessments: 

Time Settings remain in the Interaction section. The same options as for Quizzes are 
available, but now you can choose between Unlimited and set time limits. 

 

Review 

A Review section exists for both Quizzes and Assessments. 

 Quizzes: 
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Review is labeled Review Settings. You can choose what is displayed when a Quiz is 
submitted, such as: Full Review (determined by Feedback settings) or Summary Only 
(Points possible, Points earned, Score) or Disabled (Results not displayed). 

Full Review options determine what displays if Full Review is selected. 

 

 Assessments: 

This is labeled Results Review. As with Quizzes, you can choose what is displayed with 
the same options. However, Review Availability (a new section) gives you the option to 
select WHEN the review is available, including allowing the selected review to be 
available after the Assessment has been disabled. It also allows for the review to be 
disabled after a set time period. 

Feedback Options are identical to the Full Review options in Quizzes. 

 

Item Analysis 

This feature is available in Quizzes, but not as detailed as is available in Assessments. In both 
formats, it is accessible through Reports for the Quiz or Assessment. 

 Quizzes: 

Each question is listed with the number of answers, responses, and points received. 
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 Assessments: 

Each question is listed with more detailed information about the responses. Note that 
this example was divided into two sections, so that more detail could be displayed. 

  

 

 Questions can be edited and re-graded from this screen in Assessments. 

New Features in Assessments 

 Question Sets 
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Questions can be grouped into Question Sets. You can have one or more sets, and 
each can have different configurations and settings. They are somewhat similar to 
Section Headings in Quizzes, but Question Sets offer more options. For example, each 
Question Set can draw questions from a different Question Bank or Question Pool. 

 

 
For more information about Questions Sets, see How to Use Question 
Sets. 

 Question Banks 

A powerful new feature in Assessments is the creation of Question Banks. Each of these 
banks is a database of questions. When creating an Assessment, you can draw 
questions from Question Banks based on keywords, difficulty level, standards and 
objectives, type of question, and/or specific text. As new questions are developed, they 
can be added to a Question Bank. 

  

 

For more information about Question Banks and how to use them, see 
How to Use Question Banks: Definition of Question Bank and Creating a 
Question Bank and also How to Use Question Banks: Creating an 
Assessment from a Question Bank. 

 Question Pools 

A Question Pool is a group of questions randomly drawn from one or more Question 
Banks based on set criteria including keywords, difficulty level, type of question, 
standards and objectives, and/or specific text. 
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For more information about Question Pools, see How to use Question 
Banks: Creating an Assessment with Question Pools. 

 At a Glance 

This feature allows you to view a “snapshot” of your Assessment and Settings. It is 
accessed when you click on the Assessment link. 

 

Below are the different sections that display on the At a Glance screen. 

1. The top section gives some statistics on the Assessments completed to date, including a 
graphical depiction of recent results by user. 

:  

2. The top right column of the page shows how many of each type of question is used, as 
well as the percentage of each type related to all types. 
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3. The rest of the screen gives a complete picture of all settings associated with that 
Assessment. 
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Features in Quizzes and Not Assessments 

Quizzes have several features that are not found in Assessments. 

 Section Headings 

Adding a Section Heading allows you to choose a set number of questions from all 
questions that are added under each Section Heading but before the next Section 
Heading. The question results will appear on the Item Analysis, questions can be 
deleted or changed, and a Quiz can be regarded as based on these changes. These 
differ from Question Pools in that they cannot be chosen based on keywords, objectives, 
standards, level of difficulty, or type of question. Therefore, questions need to be 
manually selected and added. 

All other features found in Section Headings are also found within Question Sets in 
Assessments. 
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 Email a Quiz 

Selecting Utilities > Email Quiz allows the Quiz to be emailed and completed by 
specified users. 
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 Export Submissions and Grade Data 

Selecting Utilities > Export Submission and Grade Data allows for Quiz information to 
be downloaded in CSV, PRN, or TXT formats. 

 

 Add to Pool 

Choosing the Add to Pool option (Utilities > Add to Pool) allows you to assign a single 
keyword to all questions within the Quiz, which will then allow those questions to be 
added to a Question Pool. 

 

When converting a Quiz to an Assessment (another option in Utilities), use 
the Add to Pool option first to assign a keyword to all questions in the 
Pool. Then when the Quiz is subsequently converted to an Assessment, 
its Pool will automatically be added to the Question Bank. Otherwise, each 
question would need to be individually added to a Question Bank. 
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Assessments: Understanding Options and Settings; Content, 

Access, and Interaction Settings 

To create a quiz, exam, or test, you create an Assessment. This can consist of a variety of 
question types, including multiple choice, multiple choice with more than one answer, true/false, 
matching, ordering, fill-in-the-blank, short answer, essay, and off-line. There are many options 
that can be applied to an Assessment, making it very customizable. Understanding these 
settings will help you in creating an Assessment that is specific to the objectives you want to 
achieve. 

 
For information on setting up a more secure exam, see How to Create a 
Secure Assessment. 

1. Go to the location in Lessons where you want to add the Assessment. In this tutorial, 
you are adding an Assessment to Module 1. Click Add Content. 

2. Click Assessment. 

 

3. Select Settings: Advanced. 

4. Add a Title and a Subtitle, if needed. Put any directions for the Assessment in the 
Description window. 
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The text in the Description will appear when students click on the 
Assessment link. They will not have to begin the Assessment to see the 
text. 

 

 

Whatever text is added to the Title field will be the label used to identify 
that Assessment in the Gradebook. For this reason, it is a good idea to 
keep the title short and descriptive. Putting any dates associated with the 
Assessment into the Subtitle field will make such information available 
without adding to the Title size. 

5. Go to the Access tab. User Tracking is useful if you want a detailed report on student 
activity within this Assessment. In this example, you have set it to Students Only. You 
can also designate whether the Assessment is to be taken by the entire class or only by 
specific teams. 

 

Consider assigning a password if the test is to be administered in a testing 
center or by a proctor. Give the password to the testing center or proctor 
to be given to each student when properly identified. 

 

 

For more information about designating specific teams and customizing 
settings for teams, see How to Set Team Access Rights for Lesson 
Content. 
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Checking the Do not allow users to view this item box will prevent 
anyone other than Course Editors to see the Assessment. It will override 
any other settings, including Start Date and End Date. 

6. Set the Start Date and End Date if you do not want the Assessment link to be visible 
until a specific date and time. When specified, the item will be hidden until the Start 
Date/Time, and will be hidden again after the End Date/Time. 

 

These settings will NOT affect when the test is actually available to be 
taken, they only make the Assessment link visible. The Enable/Disable 
settings are what determine when the test is available to be taken. 

 

 
Remember that the boxes next to the Start/End Dates need to be checked 
in order to set the dates. 
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Setting the End Date to a date and time AFTER the exam is no longer 
available will allow students to see their scores as well as any other 
allowable information as part of the Review. 

7. With the Browser Security option, select the level of security that you need for the 
Assessment. None means that no special measures will be applied. Medium will disable 
the right mouse clicker when taking the exam to prevent copying or printing or using the 
Back button. High involves the Secure ANGEL browser and can only be used in lab 
settings with the browser installed. 

 

 

No online test can be totally “secure.” If you need a high-stakes 
assessment, consider requiring a testing center or proctor for test 
administration. 

 

 
An IP Filter can be used to designate specific IP addresses, limiting 
students to taking the test from only those locations. 

8. Go to the Interaction tab. Set the Date Enabled and Date Disabled, checking the box 
for each. 

Date Enabled refers to the date and time the Assessment is available for students to 
take. 

Date Disabled refers to the date and time when the test can no longer be taken. 

 
If there is no Date Enabled and/or Date Disabled set, the test will be 
available to take between the Start and End dates already set. 

9. Decide how you want the questions to be presented. 
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All at once will display all of the questions at one time, which is similar to seeing and 
taking a paper test. 

Question set at a time will display each question set separately. 

 

When configuring the Assessment, you can create different Question Sets 
of questions. Each Question Set can have different settings, such as 
different time limits, different titles, and randomization and display options. 

Question at a time will display each question separately. 

 
For more information about options for the Question at a time setting, see 
How to Create a Secure Assessment. 

 

10. Some Question Set default options can next be set. These allow for some randomization 
of question options within a Question Set, as well as some options that are only 
available when the Question at a time option is chosen. 
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Randomize the order in which questions are delivered would change the order of 
questions within a Question Set. 

 

If an Assessment is covering several different topics and you want to have 
randomly ordered questions by topic, create a Question Set for each topic 
and then select the Randomize the order in which questions are 
delivered option. 

Randomize the order of each question’s answer options would reorder the answer 
choices primarily for multiple choice questions. 

 

Sometimes the order of answer choices should not be reordered, due to 
the nature of the choices. For example, you would not want an answer 
choice of All of the above to appear anywhere except as the last answer 
choice. There is an option that can be selected within each question to 
prevent randomizing the answer choices for that particular question. 

Don’t allow backtrack only applies with the Display Settings of Question set at a time 
or Question at a time options. It means that once a set of questions has been submitted 
or each question has been submitted, students cannot go back and change their 
answers. 

Display feedback after each question only applies with the Display Setting of the 
Question at a time option. It means that after each question has been submitted, any 
feedback for that question will display. 

Correct answer must be selected before next question is presented is another 
option that is only relevant when questions are displayed one at a time. 

 

These settings are applied to all Question Sets. Further options can be set 
for individual Question Sets once the Assessment settings have been 
saved. 
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11. Choose your Submission Settings options: 

Mastery Settings. This would allow students to retake the Assessment as many times 
as it is available until they reach a certain percentage grade. 

Attempts Allowed. Choose how many times students can retake an Assessment. The 
options range from 1 to 10 times to Unlimited. 

12. Choose the Validation option needed: 

Do not allow. This means that students cannot leave any questions unanswered. A 
pop-up window will display and will not allow students to submit the Assessment without 
answering all questions. 

Allow, but issue warning. This option means that if students leave a question 
unanswered, they will receive a warning. A pop-up window will display advising them 
that the question has not been answered and giving them the option to answer it or go 
forward. 

Allow, without warning means that students will not be advised of any unanswered 
questions, and they can still submit the Assessment. 

Click the Save Option if you want to allow students to save their work and return later. If 
a time limit has been set, they will need to return to complete the Assessment within that 
time limit. 

Anonymous Mode should only be checked if you do not need to know who submitted 
which test. If this is selected, scores cannot be recorded in the Gradebook. 

Time Limit allows you to set the period of time available for students to take the test 
once they have begun. If you do not want to set a time limit, then check the Unlimited 
option. 

Time Warning, if selected, will display a pop-up window to advise students of the time 
remaining, according to the minutes selected here. You also have a choice of selecting 
No warning. 

 

Remind students to take the time limit into consideration when beginning 
their Assessments. They need to begin the Assessment and allow enough 
time to finish BEFORE the Disabled date and time is reached. 

If the Automatically submit assessment when time expires box is checked, it means 
that as soon as the allotted time for taking the test has expired, the test is automatically 
submitted – no matter what other settings have been selected. 

 

If this option is chosen, warn students that “the clock starts ticking” as 
soon as they begin the Assessment, no matter what. When the time is up, 
the test will be gone! If students wander away from the test and later 
return, they will not be able to answer more questions if time has expired. 
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Assessments: Understanding Options and Settings; Review and 

Assignment Settings 

Within an Assessment, you can designate what kind of feedback the students will receive upon 
completion of the Assessment, and you can even change this feedback based on set 
parameters. The Assignment tab is used to set up the Assessment as an Assignment in the 
Gradebook. 

1. Within the settings for an Assessment, select the Review tab. 

 

2. View Submission History: Select what you would like students to see at the time that 
they submit their Assessments, or according the Review Availability settings that 
follow. These options will remain open for students until the set End Date and Time, or 
until the Review options are changed. The options are as follows. 

Full review: Students will see all feedback as set in Feedback Options. 

List only: Students will see only their score, points possible, and points awarded. 

Disabled: Students will not receive any feedback or score information. 

 

3. Go to the Review Availability. This section allows you to specify when you want 
students to view the option you selected in View Submission History. 

4. Specify when the Review is active with Review begins. The default is User 
submission. You can also have the Review begin a set number of days after the 
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Assessment is disabled (so that it is not viewed until the Assessment can no longer be 
taken), or you can have it begin on a specific date. 

If the box in front of the days text is left blank, the Review will be active according to the 
designation in the drop-down list. In the example below, User submission is 
highlighted, so that the specified Review will be available as soon as the Assessment is 
submitted. 

 

5. You can also specify how long the Review will remain available to students by inputting 
the number of days when the Review ends. 

6. If the Assessment contains manually graded questions, such as short answer or essay 
questions, clicking the Restrict review until all questions are graded option makes the 
Review unavailable until after all questions have been graded. 

 

7. Finally, you have the option of having any feedback associated with the Assessment 
display either after a Question Set has been completed or after the entire Assessment 
has been completed. 

 
The ability to see feedback after completion of a Question Set is only 
available if the question display mode is set to Question Set at a Time. 

 

Feedback Options allow you to designate exactly what will be displayed in the Review if the 
Full review option is chosen (see Step 2 above). 
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Be aware that choosing Answer key and Question text will give students 
a complete copy of the Assessment, which they could copy and share. If 
this is a high-stakes Assessment that WILL be used again, these may not 
be good options to select. 

1. Go to the Assignment tab. Selecting one of the options in the Milestone Settings 
section will create a Milestone and also put Assigned and Due Dates on the Calendar. If 
this Assessment will be automatically graded, Item completion can be selected for the 
Milestone. 

 

2. Selecting a Milestone option will allow you to select both the Assign Date and the Due 
Date for the Assessment. 

 

 
Using the Milestone feature is a good way to have assigned and due dates 
automatically appear on the calendar, as shown in this example: 
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3. To connect the Assessment to the Gradebook, go to the Gradebook Settings section 
and use the drop-down menu to select New Assignment. 

4. Continue completing the remaining options, giving the Assessment a Title, selecting a 
Category, assigning Points Possible, and determining a Calculation Type. 

 

 

When selecting a Calculation Type, the default is First submission. 

If you are allowing students to take the Assessment multiple times, change 
this to Maximum score, Last submission, or Average score. 

Even though you may be manually grading some or all questions (if the 
Assessment contains essay or short-answer questions), DO NOT change 
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this to Manual unless you intend to input the grades within Gradebook 
instead of adding them within Assessment. 

5. Click Save when you have finished with all settings. 

 

The Assessment is now in place. 
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How to Use Question Sets 

Assessments use Question Sets to group questions. These groupings allow instructors to 
configure different options for each set of questions. An Assessment might consist of one or 
more Question Sets, depending upon the needs of the test or exam. 

1. Create and Save an Assessment. Once it has been saved, the Assessment Editor will 
display so that you can create Questions Sets and add questions. You can return to the 
Assessment Editor at any time by clicking on the Assessment in Lessons. 

 

For more information on creating an Assessment, see Assessments: 
Understanding Options and Settings; Creating an Assessment’s Content, 
Access, and Interaction Settings and Assessments: Understanding 
Options and Settings; Review and Assignment Settings. 

.  

2. Select Configure to apply options for a Question Set, if needed. 

 

3. The next screen will open in the General section. Add a Title for the Question Set (the 
default is Questions). You have the option of making the Title display to the students 
who are taking the Assessment. The Heading Text window allows you to input 
information pertaining to the questions in the set. Because it gives you the option of 
using the HTML Editor, you can add hyperlinks, images, and formatting to the text that 
you add. 
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You could use the Heading Text in a variety of ways: 

 Give directions for the questions within the set 

 Provide a scenario or case study for the questions within the set 

 Add a diagram or map or other illustration referred to in the 
questions. 

 

4. The Interaction tab provides other settings for the individual Question Set: 

Use assessment settings. If this is checked, the settings will use those already 
configured in the Assessment settings. 

Question set display mode. This is determined by the Assessment settings and cannot 
be changed in the Question Set configuration. 

Question set display options. These can be changed only if Use assessment 
settings is NOT checked. These allow for randomization of questions within the 
Question Set, as well as randomizing the answer choices. 

Time limit. This can be set as long as the Question set display mode is set to 
Question set at a time and a time limit has been set for the overall Assessment. This 
would assign a specific time limit in which the Question Set would need to be completed. 
You can also have a time limit warning display, and cause the Question Set to be 
automatically submitted when the allotted time is up. 

5. Click Save when you are finished. 
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6. Add a new Question Set by clicking Add Question Set. 

 

7. A pop-up window will appear. Add a Title for the next Question Set. Leaving the box 
next to Edit Question Set settings upon save as shown here will allow you to 
configure the Question Set as described in Steps 3 and 4 (above). Click Save to 
continue. 
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8. Continue to add all Question Sets needed for the Assessment, unless you need only 
one. 

9. Click Add Questions to add questions within each Question Set. You can use 
Questions and Question Pools to add questions, or you can create individual questions. 

 

For more information about adding questions from a Question Bank or 
Question Pool, see How to Use Question Banks: Definition of Question 
Bank and Creating a Question Bank, How to Use Question Banks: 
Creating an Assessment from a Question Bank, and How to Use Question 
Banks: Creating an Assessment with Question Pools. 

 

10. You can add the following types of questions: 

 Multiple Choice 

 True or False 

 Multiple Select (Multiple Choice questions in which more than one choice is selected) 

 Ordering (gives a list of items to be sequenced in proper order) 

 Matching 

 Fill in the Blank 

 Short Answer 

 Essay 

 Offline Item (a question that is not answered within the test itself; for example, a 
question that is answered orally) 

 Algorithmic (questions generated automatically based on mathematical formulas and 
variables) 

All types of questions can be graded automatically, except for Short Answer, Essay, and 
Offline Item. 
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Questions can also be added through copying and pasting questions from a text file that 
follows a specific format. 

 

11. Once the questions have been added, they will be listed in the Assessment Editor within 
their respective Question Sets. 

 

12. There are options that are associated with questions in the Assessment Editor: 

Checking Drag ‘n’ drop enabled allows you to change the order of questions by 
dragging them into place with the mouse. 

You can Delete Questions or Change Point Value of one question or several 
questions by checking the box next to each question, selecting the desired action, and 
then clicking Go. 
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13. To see how the questions will display, click Preview. 

 

14. The Assessment will display based on the assigned settings. In this example, the 
Assessment was set up to display one question set at a time: 
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To answer the Assessment in just the same way that a student would, 
preview the course as if you are a student and access the Assessment. 
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How to Use Question Banks: Definition of Question Bank and 

Creating a Question Bank 

Question Bank Defined 

A Question Bank is a database of questions that can be shared between and among Courses, 
Learning Object Repositories, and Master Courses. Question Banks are searchable, so that 
questions meeting specific criteria can be drawn from them to create Assessments. 

Creating a Question Bank 

As you add questions to an Assessment, you have the option of adding each question to a 
Question Bank. 

 

Questions in the Question Bank are grouped within their respective Question Sets, which 
appear as folders having the same names as the Question Sets. 
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Creating Assessment questions within a LOR will, in effect, create 
“Master” Question Banks of questions that can be shared with all courses 
in which you have Course Editor rights. 

Questions can also be added to a Question Bank within the Question Bank Manager itself. 

Adding Questions to a Question Bank Within the Question Bank 

1. Open a course or LOR with the Question Bank where you want to add the questions. Go 
to Manage > Question Bank Manager. In this example, you are adding questions to a 
Question Bank within a LOR. 

 

2. First you will add a folder for the questions that will be created. Click on the small 
triangle underneath the Course/LOR name. 
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3. In the window that opens, select Add subfolder. 

 

4. Another window will open asking for a folder name. Input a name and then click Save. 

 

When creating an Assessment from a Question Bank, one search option is 
to search by folder. Therefore, it is a good idea to label the folder to 
indicate the subject matter covered by the questions it contains. 
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5. You will see the folder now listed. Click on the small triangle beneath the folder to begin 
adding questions. 

 

6. Click the Add question option. 

 
The Edit options would also allow the creation of a subfolder for further 
organization. You could also Rename or Delete the present folder. 

 

The Add Question screen will appear. 
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7. Create all questions as you would for an Assessment. The questions will automatically 
be saved in the Question Bank.  

 

As you create questions, you can designate a keyword and a difficulty 
level which can be used to limit questions to be pulled from a Question 
Bank. Because this question was already created within the Question 
Bank Manager, the option to save the question to the Question Bank does 
not appear. 

 

8. Returning to the Question Bank Manager, you can verify that questions have been 
added to the Creating Tests folder by clicking on the “+” next to the Creating Tests 
folder. 

 

All questions that have been created will appear beneath the folder. 
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Clicking on the small triangle beneath each question will bring up an edit 
menu that allows you to edit or delete the question. When a question is 
deleted from a Question Bank, it is permanently deleted – unless it has 
been added to another Question Bank or an Assessment. 

 

 
You can add multiple questions from a test bank by using the Import 
Questions option. 
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How to Use Question Banks: Creating an Assessment from a 

Question Bank 

Once a Question Bank has been created, you can create an Assessment from questions in the 
Question Bank. If an Assessment that is created from a Question Bank is ever deleted, the 
questions will still remain within the Question Bank. 

 

This is one significant difference between tests created using Quizzes and 
tests created using Assessments. Once a quiz has been deleted, all 
questions within the quiz are also deleted – unless the quiz has been 
duplicated elsewhere. Questions within an Assessment that are derived 
from a Question Bank will not be deleted if the Assessment is deleted. 

In this example, you will be creating an Assessment in a course from a Question Bank created 
in a LOR. 

1. Open the course in which the Assessment will be created, and go to Lessons > Add 
Content. In this example, you are adding the Assessment into the Module 1 Folder. 

2. Select Assessment in the next screen. 



How to Use Question Banks: Creating an Assessment from a Question Bank 136 

 

3. Continue setting up the Assessment, choosing the options that you need. 

 

For more information about setting up an Assessment, see Assessments: 
Understanding Options and Settings; Creating an Assessment’s Content, 
Access, and Interaction Settings and Assessments: Understanding 
Options and Settings; Review and Assignment Settings. 

4. Once the Assessment has been created, the Assessment Editor (allowing you to create 
Question Sets and Questions) will appear. Click the Configure option if you want to 
apply any settings to the Question Set, such as a Title or other specific options for that 
set. This would be especially important if the Assessment is to contain more than one 
Question Set, with different settings for each set. 
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5. Once the Question Set is configured, or if you do not need to configure the Question Set, 
click the Add Question option. 

 

To add questions from a Question Bank, you have two choices: you can browse and 
choose questions from the available Question Banks, or you can search and add them 
according to specific criteria. 

Using the Browse Option 

1. Click Browse Question Bank in the Select Questions from Other Sources section in 
the lower part of the Add Questions screen. 
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This will open up a screen that will display all of the Question Banks in which you have 
access. This includes Question Banks in all Courses, Groups, and Master Courses in 
which you have Course Editor rights. 

It will also include LORs that are either associated with the course or in which you have 
Course Editor rights. 

 

 

The same LOR is listed twice in this example. You have editing rights to 
the LOR DEMO ANGEL 1 (under My Repositories) and the course has 
access to the same LOR (under Course Repositories) because of the 
way the LOR was set up. If someone were a Course Editor for this course 
– but not an editor for that LOR – the LOR would only be listed once, 
under Course Repositories. The criteria set within the LOR determine the 
courses that will have access to it. 

2. For this example, you will choose the Question Banks in the DEMO ANGEL 1 Course 
Repository by checking the box next to it. (Choosing the same Repository in My 
Repositories would give the same results). You could also choose more than one 
Question Bank. 

3. Click the “+” next to the Question Bank to expand it and see all the folders and 
subfolders within it. 
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4. Check the box next to the Question Bank that you want to use. This will copy ALL of the 
Questions in that Question Bank into the Assessment. 

5. Clicking the Configure copy options link allows for the standards, keywords, and 
difficulty level associated with each question to also be copied. Checking Automatically 
accept changes made to these questions when the master sources change will 
allow for the question to be updated if the question is ever changed within the source 
bank (that is, the DEMO ANGEL 1 Repository). Click Done to continue. 

 

 

Clicking on the “+” next to the Question Bank would expand it and allow 
you to choose specific questions from that Bank instead. Those would 
then be the only questions copied to the Assessment. 

 

6. On the next screen, you will see that all the questions from that bank have been added. 
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Using the Search Option 

The other option for adding questions from a Question Bank is to use the Search option. This 
will select questions from all Question Banks, or selected Question Banks, by using specific 
criteria, including keywords, Question Bank folders, difficulty level, type of question, and text. 

1. From the Add Question screen, choose Search Question Bank. 

 

2. The following screen will display. You could input a search term here, but click 
Advanced search to access the different criteria for searching. 
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One of the choices that you can use for the advanced search is: Limit results by 
keyword. 

3. Select a keyword by clicking Choose keywords. This will bring up a list of all keywords 
associated with questions within all the Question Banks that the course can access, and 
that enables you to click on the keywords you need. 

The Match ANY keyword option will select all questions that contain any of the 
keywords selected. Limiting the search to Match ALL keywords would select only 
questions that contain every keyword selected. 

 

4. The following screen appears: 
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5. Click to highlight the Course or LOR that contains the Question Bank you want to use, 
and then click the Select button. (Note that you can also select all of the Question Banks 
or more than one.) 

 

6. Then select the keywords for the questions you want to use and click the Add Selected 
button. 
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7. Finally click the Save button at the bottom. 

 

Limit by question type 

1. Check the boxes next to the type(s) of questions that you want to appear on the 
Assessment. 

 

Selecting a keyword and then a question type will limit the questions 
selected to only those questions that contain the selected keyword and 
ALSO are of the selected question type(s). 
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2. Choose Question Bank Filters limits the search to specific Question Banks indicated 
by the folders selected. Click Choose folders to select the specific folders you wish to 
have the questions taken from. 

 

This works much like it does in Browse. It will allow access to all of the Question Banks, 
so that you can choose the specific banks to include in the questions. 

 

Since you have already designated the questions to be selected using 
Keywords, you did not need to select a folder (Question Bank) here. This 
is mentioned simply to illustrate the procedure if you had not searched by 
keywords. 

If you wanted to select questions from a Question Bank with no other 
search criteria applied (such as Question Type or Level of Difficulty), you 
would use the Browse Question Bank search option. 
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3. When you are returned, you will see the folder listed by name, and the name of the 
Question Bank from which it came is shown beneath it. 

 

Limit by difficulty level  

This feature allows you to specify the difficulty of the questions selected. As with Keywords, the 
Difficulty Level needs to have already been set within each question in order to enable this 
feature. 
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You can also filter by Standards or Objectives, if they have been mapped to questions. This 
would narrow questions to those that have been mapped to the specific standards or objectives 
selected. Use the Choose Standards Filters or Choose Objectives Filters to select the 
desired Standard(s) or Objective(s). 

You can also search for questions containing specific Text by inputting it in the field next to the 
search button. 

 

1. Click the Search button to continue. 

 

2. All questions matching the criteria you have set are now added to the screen. You can 
further select the questions you want to use from the question list by checking the box 
next to each one, or you can select all of them at one time by checking the Select all on 
this page box and then clicking the Save button. In this example, you selected all. 
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The Select all on this page option ONLY selects the questions on that 
ONE page. If there were more than one page of questions, you would 
need to navigate to each page and then repeat checking the Select all on 
this page option and clicking the Save button to save the results. When 
there are more pages, there will be links to the other pages shown on the 
screen. 

3. The questions are now added to the Question Set. 



How to Use Question Banks: Creating an Assessment from a Question Bank 148 
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How to Use Question Banks: Creating an Assessment with 

Question Pools 

A Question Pool is a group of questions selected from one or more Question Banks. They are 
selected based on specific criteria and are used to create Assessments with randomly chosen 
questions pulled from the pool. Each pool is created during the Add Question process: it does 
not exist independent of the Assessment in which it was created. 

The pool of questions can be selected based on keywords, difficulty level, question type, 
standards, and searchable text. 

1. Open the course in which the Assessment will be created, and go to Lessons > Add 
Content. In this example, you are adding the Assessment into the Module 1 Folder. 

2. Select Assessment in the next screen. 

 

3. Continue setting up the Assessment, choosing the options that you need. 
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For more information about setting up an Assessment, see Assessments: 
Understanding Options and Settings; Creating an Assessment’s Content, 
Access, and Interaction Settings and Assessments: Understanding 
Options and Settings; Review and Assignment Settings. 

4. Once the Assessment has been created, the Assessment Editor (which allows you to 
create questions and Question Sets) will appear. Click the Configure option if you want 
to apply any settings to the Question set, such as a title or specific options for that set. 
This would be especially important if the Assessment will contain more than one 
Question Set with different settings for each set. 

 

5. Once the Question Set is configured, or if you do not need to configure the Question set, 
click the Add Question option. 
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6. On the next screen, select Question Pool in the Select Questions from Other 
Sources section. 

 

7. At the top of the next screen, input the Number of questions that you want to be 
selected for each individual test from the pool of questions. 

 

No matter how many questions are in the pool, each student will only be 
presented with a test with the number of pool questions selected here. The 
questions will be randomly drawn from the pool for each student, so that 
each student will see a different set of questions. 

8. Add the total Question Pool Points for the pool questions. In this example, you will 
have 5 questions drawn from the pool for each test; each question will be worth 1 point 
so the total value of the pool questions will be 5 points. 

 

9. In the lower section of the screen, choose the criteria that will select the questions for the 
Question Pool: 

Limit results by keyword will only select those questions containing the keywords 
designated. 

Match ANY keyword will select questions that have one or more of the keywords 
selected. 
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Match ALL keywords will only select those questions that contain all of the chosen 
keywords. 

10. Click Choose keywords. 

The following screen will appear. 

 

Only select a Course if you want to limit the keyword terms to questions in the Questions 
Banks in a specific course or courses. You are not going to limit this to a course, so you 
will skip that section and go to the keywords (Select from List) section. 

11. Select each keyword, and then click the Add Selected button. You can select more 
than one by holding down your Control key while clicking on the selected keywords. 
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12. To finish, click the Save button at the bottom. 

 

Limit by Question Type: Check the boxes next to the type(s) of questions that you want 
to appear on the Assessment. 
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Selecting a keyword and then a question type will limit the questions 
selected ONLY to those questions that contain the selected keyword and 
ALSO are of the selected question type(s). 

 

Choose Question Bank Filters: This option limits the search to the specific Question 
Banks indicated by the folders selected. Click Choose folders to select the specific 
folders from which you want to have the questions taken. 

 

This works much like it does in Browse. It will allow access to all of the Question Banks 
so that you can choose the specific banks to include in the questions. 

 

Since you have already designated the questions to be selected using 
Keywords, you did not need to select a folder (Question Bank) here. It is 
demonstrated simply to illustrate the procedure if a search by keywords 
was not used. 

If you wanted to select questions from a Question Bank with no other 
search criteria applied (such as Question Type or Level of Difficulty), you 
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would use the Browse Question Bank search option. 

13. When you are returned, you will see the folder listed, with the name of the Question 
Bank from which it came beneath it. 

Limit by difficulty level: This feature allows you to specify the difficulty of the questions 
selected. As with Keywords, the difficulty level needs to have been set within each 
question to enable this feature. 

 

You can also filter by Standards or Objectives, if they have been mapped to questions. 
That would narrow questions to those that are mapped to the specific standards or 
objectives selected. Use the Choose standards or Choose objectives links to select 
the desired Standards or Objectives. 
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You can also search for questions containing specific Text by inputting it in the field next 
to the search button. 

14. Click the Search button to continue. 

.  

15. All questions that meet the criteria set will display. You can edit or delete any of the 
questions, or check Select all on this page to choose all of them. 

 

16. Click the Save button at the bottom to add this Question Pool to the Assessment being 
created. 
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The Question Pool has now been added to the Assessment. It will appear as a single 
item on the Assessment (Question Pool) along with the total point value of the pool. 

 

17. To view a sample test, click Preview. 



How to Use Question Banks: Creating an Assessment with Question Pools 158 

 

The preview will only contain the number of questions to be randomly drawn from the 
pool (in this case, 5 questions). 
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.   

 

To take the test just as a student would, change to Student View and then 
migrate to the Assessment. The Assessment would need to be enabled in 
order to take it. 
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How to Create a Secure Assessment 

The Assessment component in ANGEL has options for creating a more secure test 
environment. These options can be selected at the time the Assessment is created within the 
Settings environment. They can also be changed at any time by returning to Settings within the 
Assessment. 

 

Just as in the classroom, no online test can be made completely secure. 
However there are options that can make it more difficult for students to 
share test questions or to look up answers while taking the test. 

 

 

To discourage academic dishonesty when giving a high-stakes exam, 
consider having online users use a test center or proctor. Essay and 
short answer questions also encourage originality. 

1. Create the more secure test by going to Lessons > Add Content > Assessment. 
Select the Advanced settings to be able to access the options that are needed. 

 

2. Click on the Access tab, AFTER completing any needed instructions and information in 
the Content section. Set User Tracking to Students Only. This will allow you to track 
all student activity pertaining to this test. 

 

Adding a password is recommended if the student will be taking the test 
in a testing center or will have a proctor deliver the test. Give the 
password to the testing center or the proctor to be released to the student 
at the time of the test upon proper identification. 



How to Create a Secure Assessment  161 

 

3. Team Access should be set to All Teams unless you need to set different parameters 
to students in select teams. Set the Start Date and End Date as well as their times. 

 

 

Start Date indicates the date and time when the Assessment will be 
VISIBLE to students. 

End Date is the date and time when the Assessment will be HIDDEN from 
students. 

Start and End dates do NOT determine when the test is actually available 
to be taken; they only specify when the Assessment link is VISIBLE. It is 
the Enable and Disable options that determine when the test itself is able 
to be taken. These options are further explained elsewhere in this 
Appendix. 

 

 
When setting the Start and End dates and times, be sure to check the 
box next to each one or else the settings will not be saved. 

4. Select the security level (Browser Security) for the test. For an online test, the Medium 
setting will offer the most security. The High setting can only be used in computer lab 
settings where the Secure ANGEL Browser can be installed on each computer. The IP 
Filter could only be used in controlled settings to limit test-taking to just those computers 
with specific IP addresses. 
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While the Medium setting does prevent using the right mouse button for 
copying, printing, highlighting, and so forth, it is NOT 100% secure. 

5. Go to the Interaction tab. Set the Date Enabled date and time, and also the Date 
Disabled date and time. 

 

 

Date Enabled indicates the date and time that students are able to access 
and take the test. Date Disabled is the date and time when the test is 
closed and students will no longer be able to take the test. 

This is different from the Start Date and End Date. Those indicate when 
the Assessment link itself is visible and do NOT govern when the test is 
actually open for students to access and take. 

 

 

For a more secure test, make the time period for students to take the test 
very short, perhaps just a few hours. The longer the test is available, the 
more time students have to share information about it. 
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Remind students that they need to begin the test as soon as possible in 
order to allow enough time to finish it before it is disabled. 

 

 

When selecting the Date Enabled and Date Disabled dates and times, be 
sure to check the boxes next to each of them, or else those dates and 
times will NOT be saved. 

6. In the Display Mode section, choose the Question at a time option. This will display 
questions only one at a time and would make it more difficult for students to copy or 
otherwise record each question because of the time it would take. 

 

7. Selecting the Question at a time option opens up additional options. For a more secure 
test, select Randomize the order in which questions are delivered, Randomize the 
order of each question’s answer options, and Don’t allow backtrack. The other two 
options would likely make the test less secure. 

 

 

Randomizing the order of questions ensures that each student has a 
different test, at least as far as the question order is concerned. 
Randomizing the order of answer options further enhances this difference. 

 

 If you choose to randomize the order of answer options, be sure that 
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such is appropriate for your test answers. If you have answers such as 
“only A and B” or “All of the above,” this option will not work. If you do 
select this option, however, you can edit individual questions to NOT 
allow this randomization. 

 

 

Not allowing students to backtrack (that is, to go back and change 
answers or to answer questions they have not yet answered) prevents 
students from looking up answers and going back to change them, or from 
getting help and then making changes. (There have been instances of 
students telephoning others and asking for look-up help while they went 
on to answer questions they knew; and then later going back to answer 
questions for which they received help. “No backtracking” prevents that.) 

 

 
When you use the Don’t allow backtrack option, it is important to inform 
students that they won’t be able to go back and change their answers. 

 

 

For an even more secure test, cause its questions to be randomly drawn 
from a Question Bank using a Question Pool. This allows you to have a 
specific number of questions randomly selected from the larger supply, 
thus creating a different set of test questions for each student. 

See How to Use Question Banks: Creating an Assessment from a 
Question Bank and How to Use Question Banks: Creating an 
Assessment with Question Pools” for information on how to do this. 

8. In the Submission Settings section, you have options as to how many times the test 
can be taken and also how unanswered questions will be handled. 

For a secure test, leave Mastery Settings blank and set Attempts Allowed to 1. 

With the questions being delivered one at a time and no ability to go back and change 
previous answers, setting Validation to Allow, but issue warning will activate a pop-up 
window advising students after they did not answer a question and giving them the 
opportunity to answer it before moving on, or else to go on to the next question without 
answering the present one. The Do not allow option will not let them go on to the next 
question until they have answered the present question. 

 

Using either the Allow, but issue warning or Do not allow options can 
safeguard against students accidentally submitting the test before all 
questions are answered. Pop-up windows appear reminding them when 
questions have not yet been answered and prompting them to resolve the 
unanswered ones. 
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Adding a Save Option would allow students to save all answers, and then they could 
potentially leave the test and return to it later. Because all answers are automatically 
saved, leave this unchecked. 

Anonymous Mode should be unchecked for a secure test. 

 

In the Time Settings section, you set the Time Limit for the test as well as other 
options. 

 

 

Keeping the time limit fair, but not generous, will prevent students from 
having more time to look up answers or consult with classmates. Having 
the test automatically submit when the time is up will add to this security. 
Putting in a Time Warning is up to you, but students probably would 
appreciate the “heads up!” 

 

 

Warn students that once they begin the test, “the clock starts ticking.” 
Even if they stop taking the test and close ANGEL, the clock keeps 
running. Once the allotted time has expired, the test submits even if they 
have not finished it. If they leave ANGEL and time expires in the 
meantime, the test will submit the moment they log back on. 

9. Go to the Review tab. This section governs the type of feedback information that will be 
available to students once the test has been submitted. 
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10. For a secure test, choose List only as the View Submission History option. You could 
also choose Disabled. “List only” will give the score for the test, including the number of 
points earned out of the number of points possible. “Disabled” will not provide any 
feedback. 

 

If choosing Disabled because you do not want students to see their 
grades, you might also want to check Hide assignment in Gradebook 
when setting up the assignment as a Gradebook assignment. 

Review Availability gives you the option to allow students to see additional information 
about their tests at a time you specify. Set the date on which students can begin to 
review their tests, and input how many days the Review period will last. 

 
For a more secure test, do not allow the Review to occur until AFTER the 
test has closed to all students, and keep the Review availability short. 

Feedback Options allow you to specify exactly what information will be available to 
students during the review. Check all options that apply. 

 

If this is a test that you intend to use for future classes, be careful what 
feedback you allow students to view. If they can view the questions and 
the answers, they can potentially copy the entire test and share the 
information with other students. 

 

 

If you don’t want students to be able to see their own tests, but do want to 
be able to give them feedback, consider some alternatives: 

Use a course wiki, blog, or discussion forum to give the entire class 
general feedback about the questions that were missed most often. 

Conduct a Live Office session and give individual students specific 
feedback about their tests. 

Email students with specific information about their test results. 
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11. Go to the Assignments tab and input all settings needed for the test to be recorded in 
the Gradebook and then Save the settings. 

 

Create a practice test with the same settings as the real test, so that 
students will be familiar with the testing environment and will understand 
the limitations that have been set. This is particularly important when 
questions are delivered one at a time with no backtrack, so that students 
realize they cannot skip questions with the intention of going back and 
answering them later. 

 

 

For more information about setting up an Assessment, see Assessments: 
Understanding Options and Settings; Creating an Assessment’s Content, 
Access, and Interaction Settings and Assessments: Understanding 
Options and Settings; Review and Assignment Settings. 
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How to Create a Pass/Fail Exam 

You can create an exam that has a Pass/Fail outcome by designating the percentage score 
that needs to be attained in order to pass. The grade that the student sees will then either be a 
P or an F, or whatever other label you would like to display in the Gradebook. 

1. Set up the Assessment in the course and add questions. 

 

See Assessments: Understanding Options and Settings; Creating an 
Assessment’s Content, Access, and Interaction Settings and 
Assessments: Understanding Options and Settings; Review and 
Assignment Settings. 

When setting up the Assignment section for this Assessment, set the Display Setting to 
Letter Grade. 

 
This method will ONLY work if you have not set up any other criteria for 
Letter Grades within the course. 

2. Go to the Gradebook in the Manage section. 

3. In the Gradebook, go to Grading Scale in the Gradebook Management section. 

 

4. On the next page, input the label that you want to have display in the Gradebook for a 
passing grade (for example, P) and then input the Minimum Percent (that is, 
percentage of correct answers out of total questions) needed for a passing grade. Click 
Add New to proceed. 
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5. You can then input the label for a failing score (for example, F) and set the Minimum 
Percent as 0 (zero). Then click Back to Main Menu. 

 

 
The labels do not have to be letters. They could be “+” and "–" or any 
other single-character text. 

When students view their grades for any assignment set up to display as a letter grade, 
they will see either a P or an F. 
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How Students Can Reenter an Exam 

When students take an Assessment, they can be given the option to save their answers and 
return later to complete it. Some examples are a “take-home” type of exam with essay questions 
that do not have to be answered at one sitting, or an untimed open-book exam. 

1. To allow students to save and return at a later time to complete an Assessment, the 
Save Option must be selected in the Settings. This is located under Submission 
Settings within the Interaction section. Check the Show save button to activate it. 

 

 

If using this option, you may NOT want to also check the “Automatically 
submit assessment when time expires” option. Checking that would mean: 
if students did NOT return within the time limit, the Assessment would 
automatically submit (unfinished) as soon as they tried to reenter it. 

2. When students take the exam, they will see the Save and Continue Later button at the 
bottom of the questions screen. If the exam is set to deliver questions one at a time, or 
one Question Set at a time, the button will appear on each screen of questions. 
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Warn students NOT to click the Submit button until they have completed 
the entire exam. The Submit button does just that: it submits the exam for 
grading. Once it has been submitted, it cannot be reopened again or 
reentered for students to resume. 

3. When Save and Continue Later is clicked, a pop-up window appears – advising 
students that their exams can be saved and not submitted – also with an option to 
cancel this action and immediately continue with the exam. Click OK to save and 
continue later. 

 

4. When students are ready to reenter the exam, they will open it and immediately see this 
option to resume the exam: 
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5. When students click on the proper Resume link, they are reentered and may then 
continue taking the exam. 
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How to Grade an Essay or Short Answer Question 

ANGEL allows you to grade essay and short answer questions by using a “blind” approach with 
the Grade by Question option. This allows you to grade essays and short answers without 
knowing which student submitted them. 

When you log into your course and check the Tasks menu, you can see if you have any 
answers to be graded. In this example, you see you have three (3) Ungraded Items. 

1. Clicking on the “+” next to Ungraded Items expands that item and shows what needs to 
be graded. 

.  

2. To grade by question, go to the proper Assessment (in this case Exam 1, as noted in 
your Tasks menu) and click on Utilities. 
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3. In Utilities, click Grade by Question. 

4. The following screen shows what question needs to have its answer(s) graded and how 
many responses have been submitted. Click on the response number (in this case “3”). 

 

5. Scrolling down the next page, you can see all of the responses submitted for that 
question. You also have the option of selecting the number of responses to be displayed 
at one time, whether the student’s name appear with the response, and whether any 
“correct answer” text should appear at the top. Check your option choices. 
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6. Evaluate each response and input your score for each, as well as any comments you 
want to make. Notice that the HTML Editor is available to be used if you want to apply 
any formatting, add images, or post hyperlinks. 

 

7. Each score will then be appropriately added to that student’s total scores for that 
Assessment. 
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How to Increase the Maximum File Size for Drop Box 

Submissions 

By default, ANGEL does not allow students to submit files any larger than 2MB (2,000,000 
bytes). Sometimes this size is too small, especially if students are submitting files with images 
or PowerPoint presentations. This setting can be changed within a course by creating an 
Environmental Variable. 

 

Your school may also have limitations on the maximum file sizes allowed 
for submissions. Before changing these settings, it is VERY important to 
check with your ANGEL administrator to ensure that you do not exceed 
these limits and that you are adhering to policies already established. Your 
administrator may also prefer to change the file size allocation globally, 
rather than have Instructors do so at the Course level. 

1. Go to the Manage tab in your ANGEL Course and click Environment Variables in the 
Course Settings section. 
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2. On the next screen, click Add a Variable. 

 

3. For the Variable Name, input DROPBOX_MAX_MB. 
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4. In the Variable Value box, type in the new file size (in megabytes, or MB). Do not 
exceed the limits set by your school policy. Then click Save. 

 

The new value is now established. In this example, students will be able to submit files 
that are 5MB or less in size (but not greater). 

 

 

Consider alternatives to large-size file assignments when possible: 

Have students save files as PDF files. There are several free programs 
available on the Internet that will convert presentations and documents to 
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PDF format. Microsoft Office® 2007 also has the ability to save as PDF. 

If the assignment is a PowerPoint presentation, have students use 
smaller-sized graphics and few, if any, animations. PowerPoint 
presentations with sound, animations, transitions, and larger graphics 
(especially digital photographs) greatly increase the file size. 

If using digital photographs, have students use digital editing programs 
(often packaged with digital cameras) to reduce the file size. 

Use a file compression program to create “zip” files. 
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How to Grade a Drop Box Assignment 

A Drop Box Assignment can either be submitted by inputting text into the Message Box or by 
uploading a document file. Once submitted, the assignment can be graded within the Drop Box 
and the grade will go to the Gradebook if it has been set up as an Assignment. The Instructor 
can download an attachment, make comments on it, save it, and then upload it again for the 
student to read. 

1. Set up the Drop Box, including setting it up as a Gradebook assignment. During the 
setup, decide if you want students to input their answers as text in the Message Box, as 
a document file, or if either would be acceptable. In the Submissions section of 
Settings you can disable either feature. 

 

If the assignment is lengthy, it is a good idea to disable the Message Box. 
Otherwise students could copy and paste their entire text into that window 
with the end result being a large, unformatted, hard-to-read document!  
Even though the HTML Editor is available to format the text, most students 
will probably not use that feature. The Message Box is best used for short 
assignments. 

 

2. For this assignment, you are disabling the Message Box and only allowing 
Attachments. Also, students can only submit once, but they can submit more than one 
document at that one time. 

 

Advise students of the file types that are acceptable for submission. 
Students may have a variety of word processing programs and could 
submit file types that you cannot open or read. 

3. Include any special instructions, such as how you would like the assignment to be titled. 
Save all settings. 
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Student submissions can be graded in two different areas of the Drop Box. Each area 
works the same, so it is up to the Instructor to decide which to use. 

4. When you click on the Assignment Drop Box link in Lessons, you will see the student 
submissions at the bottom. Click on the submission title to continue. 

 

5. The following screen will appear. Click on the document title to download and view it. 

 

OR go to the utilities link for that Drop Box. 
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6. On the next screen, click View, Grade or Delete Submissions. 

 

7. You will see all students who have submitted the assignment. Click the Grade button 
next to any one of the student names to continue. 

 

The screen will be the same as the one accessed using the other method. 
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8. Click on the file to download and open it in your word processor. 

9. Add comments to the document. Using a different color will help differentiate Instructor 
comments from the student writing. 

 

 

Another method would be to use the Track changes option in your word 
processing program to identify and illustrate any corrections you make 
within the document. 
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10. Save the document. Use a different file name to differentiate it from the originally 
submitted file. 

 

11. Return to the Drop Box and click Attachments to upload the corrected document 

 

12. A pop-up window will appear. Click the Browse button to find the file to upload. 



How to Grade a Drop Box Assignment  185 

 

13. Locate the file, click it, and then click the Open button 

.  

14. The pop-up window will reappear. Click the Upload File button to upload the file. 
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15. The uploaded file will appear in the Uploaded Files window. Click Finished to continue. 
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16. The corrected file will now appear below the Attachments button. 

 

17. You can also input any other comments in the Remarks window. Enter the Grade in the 
Grade box. 

18. Click OK at the bottom to finish. 
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The Assignment now has a grade when viewing grades in Utilities. This grade will also 
appear in the Gradebook if it has been set up as an Assignment for the Gradebook. 

 

Students will see their grades when they return to the Drop Box or view their grades. If 
they click on the link within the comments, they will be able to see the corrected copy 
uploaded by the Instructor. 
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How to Grade Drop Box Submissions Offline 

The Drop Box tool in ANGEL has a “batch download” option that allows you to download all 
submissions from a specific Assignment Drop Box, grade them offline, and then upload all 
graded submissions with any comments and/or attachments back into the ANGEL Course. 

1. Go to the utilities link for the specific Assignment Drop Box and click on it. 

 

2. Select Download Submissions on the next page. 
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3. On the following page, select whether you just want to download ANY ungraded 
submissions or ALL of the submissions. In this example, none have been graded yet so 
either option can be chosen. 

4. Click Download to continue. 

 

Firefox®: If you are using this Internet connection (browser), you will be prompted either 
to Open the file (with a specific program) or to Save the file to disk (your C: drive). 
Choose Save to Disk. 

 

Internet Explorer®: If you are using this Internet connection (browser), click Save. 
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Windows XP® 

1. To continue the offline grading process using the Windows XP platform (operating 
system on your C: drive), locate the folder where you want to save these downloaded 
“zipped” files and then click Save. 

 
Create a folder within the folder where you have all your course files 
located, and then download the zipped files into that folder. 

 

2. Go to the location where the zipped files are now saved, and then click on that folder. 
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3. The folder will open and you will see several files and folders. Click Extract all files in 
the Windows® File and Folder Tasks menu. 

 

4. The Extraction Wizard window will appear. Click Next to continue. 
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5. The next screen will ask for a location for the files to be put that will be extracted. The 
default will place them in a folder in the same location as the original compressed 
(zipped) folder. Click Next to continue. 

 

6. Once the process has finished, click Finish. 
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7. You will see folders labeled with each student’s name, along with some other files. Click 
the Grade.htm file to continue. 

 

Vista® 

1. To continue the offline grading process using the Windows Vista platform (operating 
system on your C: drive), locate the folder where the file has been saved and click on 
the folder. 
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2. All files will appear when you click on the folder name. Click Extract all files. 

 

3. On the next screen, you can accept the default location for the extracted files or you can 
migrate them to a new location. Click Extract to continue. 
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4. All of the folders and files will appear, similar to Step 2. 

 

5. Click the Grade file to continue. 
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6. The rest of this procedure will apply to either operating system (Windows XP or Vista). 
The following screen will appear once the Grade file is clicked. 

 

7. On the left are each student’s submissions. Across the top is the form that will be used 
to insert each student’s grade. The bottom right is where the files will appear once each 
submission is selected. 

8. Click on one of the student’s submissions. Here you are going to click on Salli Sparrow’s 
name. 
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9. Her document will now appear in the lower-right section. The _about.htm file is empty; it 
would have data in it if the Drop Box Submissions used the text box instead of uploading 
a file as an attachment. Clicking on the Word document (.doc file) will open it for 
reading and grading. 
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10. The document will open up in Microsoft Word or whatever word processing program is 
being used to read the documents. 

 

11. You can make any comments directly on the document for uploading back into ANGEL, 
so that the student can read your comments. 
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12. If you did add comments to the document for the student to read, you need to save the 
document. Go to File > Save or click the Save option to save your work. 

 

 

Because both the student file and the corrected file would have the same 
file name, you could select Save As instead and save the file with a 
different name to avoid any confusion. An easy protocol would be to add 
your initials at the end of the original file name. 

13. To add a grade for the assignment, go to the top of the Grade page and find the 
student’s name. 
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14. Enter a grade. You can add any additional comments in the large window. 

15. If you had made comments in the student document, you will need to upload the saved 
file copy. If so, click Browse to continue. 

 

16. Locate the file to be uploaded and click Open. 

 

Unless you specifically saved it elsewhere, the saved/renamed file 
(containing your comments) will be located in that same folder with the 
student’s name on it. 
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17. Checking the box next to the student’s name will add it to all submissions to be 
uploaded when the grades are submitted. 

 

18. Grade the other assignments in the same manner. When finished, click the Submit 
button at the bottom of the form. Be sure that you have an Internet connection 
established before continuing. Note that you can also check to have the grades emailed 
to the students. 

 

You do not have to grade all of the assignments at one time. Only grades 
that have the box checked next to the student’s name will be submitted. 
You can return later to grade the others. 

 

19. The grades are now displaying within the Course. 
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How to Integrate PowerPoint Presentations 

Integrate PowerPoint presentations so that they launch directly from your course and will not 
require students to download the presentation and run it locally. 

Preparing Your PowerPoint Presentation 

Saving your PowerPoint presentation as a web page is the best way to include it as a Lesson 
item within ANGEL. This tutorial uses the Windows XP operating system. 

1. Within PowerPoint, select File > Save As and save your PowerPoint presentation as a 
Web Page. Make sure to note the location where you are saving the file (in this case, 
your PowerPoints folder). 

 

 

PowerPoint’s animations and triggered actions do not always translate into 
HTML perfectly. If you rely on these advanced PowerPoint options, you 
may want to Save As a PowerPoint Show rather than a Web Page. As a 
PowerPoint Show, your students will have to download the file before 
playing it, but it will perfectly render more complicated slides. 

2. PowerPoint will save your presentation so that you have a single HTML file that 
launches the slide show, as well as the folder of data files in support of the slide show. In 
this case the file name is class-slides.htm, and the folder of supporting files is named 
class-slides_files. 
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Remember or write down the name of the HTML file that will launch your 
slide show (in this case class-slides.htm). You will need this name in 
order to execute various steps that follow. 

3. Create a zipped file from saved PowerPoint HTML files. You do this by first selecting 
both the folder (class-slides_files) and the file (class-slides.htm) – use Ctrl + Left 
Click to select multiple objects – and then right-clicking the mouse. A menu appears 
where you can then choose Send To > Compressed (zipped) Folder. 

 

4. Windows will then compress the file and you will see the new compressed file appear 
within your designated folder (PowerPoints). It is this new “zipped” file that you will 
upload into ANGEL. 
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You are now ready to upload the presentation to your ANGEL Course. 

Uploading Your Presentation to ANGEL 

5. Next you will upload your presentation to ANGEL by using the File tool on the Lessons 
Add Content page. 

6. Go to the Lessons tab and click Add Content. 

 

7. Click on File (content type). 
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8. Click the Browse button and select the zipped folder created in Step 3 above, and then 
click Open in the Choose file window. 

 

9. Title and upload the file (zipped folder) by inputting a Title and clicking the Upload File 
button. Leave the File Type setting at AutoDetect. 

 

10. After your file uploads, you’ll see the Upload Results page with a File Upload 
Successful message. 
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11. Click the Default File pull-down and select the name of the HTML file that will launch 
your presentation (in this case, class-slides.htm). 

 

12. Click Extract Files. 
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If you mistakenly click OK instead of Extract Files, your presentation will 
be loaded as a compressed file and your students will be forced to 
download the file before accessing it.  

13. After you click Extract Files, the presentation will automatically load in a two-pane 
model, with a list of the slides on the left and the actual slides on the right. You may then 
browse through your presentation. 

 

Note that the HTML version of your presentation has four different 
presentation and control options listed in the gray bar along the bottom of 
the presentation: 

Outline – hides or displays the outline for the presentation. 

 

Expand/Collapse Outline – expands or collapses the presentation 
outline. 

 

Slide Controls – allows users to navigate through the slide show. 

 

Slide Show Option – presents the slide show in a new full-screen 
window. 
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How to Set Up and Use Games: Crossword Puzzles 

Games can be an effective way to do a formative assessment of student learning, as an 
alternative to online testing. You can create two kinds of games in ANGEL: a crossword puzzle 
and a quiz show. Both types of games can be scored and be Gradebook Assignments. To set 
up a game, you first add the game and then designate the type of game to be used and create 
the game. 

1. Go to the location where you want to add the game within Lessons. In this example, you 
will go to Module 2. 

2. Click Add Content. 

 

3. Select Game as the content item to create. 
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4. On the next screen, select Advanced Settings to access more options and add a Title 
(in this case, Chapter 2 Crossword). You can use the Page Text window to add any 
specific directions for the game. 
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5. Within the Access section, you can put in a Start Date and End Date and add any other 
settings needed. Start Date indicates when the game will be visible to students. End 
Date indicates when it will no longer be visible. 
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6. Use the Automate section only if there are some specific actions to be used with the 
game. In the Assignment section, designating an Assign Date and Due Date will add 
the dates with the Assignment to the Course Calendar. 

 

7. If this is to be a Gradebook Assignment (meaning that the score will automatically be 
recorded in the Gradebook upon submission), then input the Assignment and other 
information under Gradebook Settings. 
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8. When finished with all settings, click Save. 

 

9. The Game is now in place. To set up the game questions, click on the Game link (in this 
case shown as Chapter 2 Crossword). 
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Setting up a Crossword Puzzle: 

1. Specify the Game Type that you want to set up. In this instance, you are setting up a 
Crossword Puzzle. 

 

2. Add (input) the puzzle’s questions/descriptions and their correct answers. Click the Add 
Question button for adding more questions. 

3. When all questions and answers have been entered, click Save. 
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4. After a moment, the completed Crossword Puzzle will load and display. To work the 
puzzle, click inside one of the boxes. 

 

5. When one of the boxes is clicked, the applicable question will appear and the student 
can type in the answer. 

 

If the student clicks the hint button... 

 

...the first letter of the answer will appear. 
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 Advise students that they will lose points every time they use Hint. 

6. Once the answer has been typed into all the displayed boxes, the student clicks the 
Submit button. 

 

7. All boxes are completed using this procedure. If any answers are incorrect, students 
retry that answer. They can also use the Hint button. 
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8. Here is an example of a completed puzzle: 

 

9. Click Submit to score the puzzle. 
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10. Students will then see their final score that will be submitted into the Gradebook. Click 
the Continue button to exit this puzzle. 
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How to Set Up and Use Games: Quiz Shows 

You can create two types of games in ANGEL: a crossword puzzle and a quiz show. The quiz 
show is based on a popular TV show; students score by answering questions and earning 
specified “dollar amounts” based on the difficulty of the question. The more difficult the question, 
the higher the earned score (but no actual prize money). 

1. Go to Lessons > Add Content > Game. 

 

2. Add and set up the game. 

 
See How to Set Up and Use Games: Crossword Puzzles for directions on 
how to add a game (Steps 1 – 8). 

3. Once the Game has been added, you can set up the Quiz Show options. Click the Quiz 
Show link; then select Quiz Show as the Game Type. 
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4. Next, set up from 1 to 4 Question Categories. Each question will be associated with a 
particular category. (Users will be given questions based on the Category chosen). 

 

5. On each line under Enter Questions: input a question, input (assign) a value in terms 
of “dollars” (Set Value) and assign its category from the Assign Category drop-down 
list. 

 

6. In the last column (Create Answers), click the Edit button. 
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7. A pop-up window will appear. Input the Answer and click Done. If there is more than 
one acceptable answer, add each on a separate line. 

 

8. Continue inputting all questions and answers. You can use the Add Question button if 
more are needed or desired. Click Save when all have been entered. 
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9. The completed Quiz Show will appear. 
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How to Set Up Teams Within a Single Discussion Forum 

Discussion forums can be difficult to facilitate if there are many students discussing the same 
topic on the same Discussion Forum. One solution could be to divide the students into teams 
and then create a Discussion Forum for each team. However, ANGEL allows you to create a 
single Discussion Forum and assign it to teams. While each team then only sees the posts 
belonging to the members of that team, the Instructor can view the postings from each team 
separately. 

1. Create the teams and assign members to them. You can either use the Random Team 
Generator or you can add them manually, and specifically assign members to each 
team. 

 
See How to Create Teams for more information. 

2. Create the Discussion Forum. Go to Lessons > Add Content > Discussion Forum. 
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3. Choose Advanced Settings, and within the Content tab input the Discussion Forum 
Title and any other information needed. Directions for the Discussion Forum can be 
typed into the text box. 

 

4. Go to the Access tab. Use the drop-down list in Team Access to change to Selected 
Teams, and then check the boxes next to the teams that are to be included within this 
Discussion Forum. 
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5. Go to the Post Permissions tab. Check the Read, New Post, and Reply boxes ONLY 
for every team that is to be included in the Discussion Forum. 

 

6. Go to the Interaction tab. Change the Mode to Private Team Journal. 

 

7. Continue setting up the Discussion Forum with all needed settings. Click Save to finish. 

 

8. To see postings from a specific team, go to the titled Discussion Forum (in this example, 
Module 1 Discussion) and then select that specific team from the drop-down list at the 
top of the page. 
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How to Create an RSS Feed 

You can create a folder in ANGEL that can be read by an RSS Reader. (“RSS” most commonly 
stands for Really Simple Syndication, although other terms are sometimes substituted.) With 
regard to ANGEL software, it means that if students have set up an RSS Reader and then 
subscribe to this folder within the ANGEL Course, they will be immediately able to access new 
content as it is continually added and/or updated from within that folder. This type of folder that 
is set up within ANGEL is called an RSS Feeder (that is, it “feeds” content to RSS Readers). 
Google® Reader, iTunes®, and Internet Explorer® 7 RSS Feed are all examples of RSS 
Readers that can be installed on personal computers. Content items that are continuously 
added and read by these Readers are often called Podcasts, although this term usually just 
applies to audio or video files. Content items in the ANGEL folder RSS Feed can be in any 
format that can be viewed on individual computers. 

 

A popular use of RSS Feeds is downloading content to a portable media 
device. However, the content used by these devices must be in a specific 
format (such as MP3, MP4, or QuickTime) in order to be accessible. There 
are a number of programs available for both PC and Mac users that can 
convert content so it can be viewed or heard on a portable media device. 

1. Go to Lessons > Add Content. 

 

2. Select Course Syndication Folder. 
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3. Set up the folder with Advanced Settings in the Content section as for any other folder 
in your Course, including any specific settings needed. Input a Title. 

 

4. On the next screen, choose Add Content to add any items to the (Chapter Notes) 
folder. As new items are added, they will be listed on the RSS Reader that is used by the 
student. 
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5. Choose the appropriate content item being added. In this instance, you will be adding a 
document File (called Chapter 1 Notes). 

 

You can add OR link to any content item. In many institutions, audio and 
video files are often stored on a separate server and linked within an RSS 
Feed folder. 

 

6. Browse for the file and then click Upload File (or add the link). 
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7. The new content is now in the RSS Feed folder (Chapter Notes). 

 

 
See How to Subscribe to a Course RSS Feed for more information on how to 
set up an RSS Reader to access the content in an ANGEL RSS Feed folder. 
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How to Subscribe to a Course RSS Feed 

Once an RSS Feed folder has been created within a Course, students can “subscribe” to it, and 
thus any new content that is added to the RSS Feed folder will immediately appear in the RSS 
Reader that is used by the student. This is a tutorial on how to set up an RSS Reader (generally 
in a student’s computer) using Internet Explorer 7 and also iTunes. 

1. Select the RSS Feed folder (Chapter Notes) in Lessons. 

 

 

See How to Create an RSS Feed for information on how to set up an RSS 
Feed folder in ANGEL. Note especially how the example cited here was 
created. 

2. To subscribe to an RSS Reader in Internet Explorer 7, click RSS Feed. 

 

3. On the next screen, click Subscribe to this feed. 
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4. A pop-up window will appear. Check that all information is correct, and then click 
Subscribe. 

 

5. This will add the folder and its contents to the Common Feed list that can be viewed 
using the Favorites link in Internet Explorer 7. 

6. To see any content that has been added to the folder, click the Favorites icon on the 
Internet Explorer 7 tool bar. 

 

7. Next, click the Feeds icon. 
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8. The folder in this example (Chapter Notes) will be listed: 

 

9. Click on the folder; and its contents will be listed. 

 

10. The file can then be opened or saved by clicking Open or Save. 
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You can also add content to iTunes. For this example, you have made an audio recording of the 
“Chapter 1 Notes” and “Chapter 2 Notes” .doc files and have uploaded them to the Chapter 
Notes folder. 

1. To use iTunes as the RSS Reader, you will first need to download and install iTunes in 
your computer. In the example, that has already been done. Click the Add to iTunes 
link. 

 

2. To view any new contents, open iTunes and click on the Podcasts menu item. 
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3. You will see the Chapter Notes folder for this example. Click on the arrow next to the 
folder name to expand the list of content items available. You now see the two above-
mentioned audio files. 
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How to Set Up the Gradebook: Preferences and Grading Scale 

Points- vs. Percentage-Based System 

When setting up the Gradebook, you must first decide how all of the grades will be calculated 
for a final grade. ANGEL allows you to use either a points-based or percentage-based system. 
The way in which each calculates the final grade is very different, so understanding this 
difference is important. The grade-calculating system, or mode, to be used is selected within 
the Gradebook Preferences. 

Points-Based System 

In a points-based system, every assignment is given a point value. The final grade is 
determined by adding up all the points awarded in the assignments and dividing that by the total 
points possible. Weighting of assignments is done purely through the point value of each (that 
is, an assignment of 20 points will be worth twice as much as an assignment of 10 points). 

Here is an example: The total points possible in an English Composition course are 1,000 
points. Student A earns 875 points. This student’s final grade is then 875 out of 1,000, which 
can be expresses as a fraction (875/1000) or a percent (87.5%). 

Percentage-Based System 

A percentage-based system groups all assignments into categories and assigns a percentage-
value to each category. The sum of all the categories will always be 100%. For example, 
categories could be set up as follows:  

 Quizzes = 20% 

 Discussions = 30% 

 Research Paper = 20% 

 Midterm = 10% 

 Final = 20%. 

While each assignment is given a point value, the final grade is based on the weight of the 
category, not the total points possible. For example, even if the total number of points possible 
in Quizzes equals 500 and the total possible in Discussion only equals 100, the Discussions 
category still contributes 10% more than the Quizzes category towards the final grade. 

Weighting of individual assignments within a category can be done through points awarded. An 
assignment worth 20 points (within a category) will be worth twice as much as an assignment 
worth 10 points within the same category. 

 

No matter which system you use, all assignments need to be linked to a 
category. With a points-based system, you could create just one category 
and then have all assignments linked to it. 
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Remember that categories cannot be graded, only assignments. All 
categories need to have assignments linked to them, even if it is only one 
assignment. For example, a Midterm Category needs to have the Midterm 
Assignment linked to it or it cannot be graded. 

Setting up Gradebook Preferences: 

The first step in setting up the Gradebook is to set up Preferences. This is where the points-
based or percentage-based mode is set, as well as other default settings. 

1. Go to Manage > Gradebook > Preferences. 

 

The first time you open the Gradebook within a Course, you will be 
presented with the Gradebook Wizard. You can click the “Skip Wizard” 
button to bypass this Wizard and access the Preferences section first. 

 

2. Set the Default Display Format for how you want the grades to appear in the 
Gradebook. Note the choices available. All grades entered will appear in this format, 
unless you override the default when setting up individual assignments. In this example, 
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the grade for each assignment would display as points earned (with percentage value in 
parentheses). For example, a graded score of 10 out of 10 possible points would display 
as 10 (100). 

 

The grade range for Letter Grades has to be set in the Grading Scale 
section of Gradebook Management. This procedure is described later in 
the Appendix. 

 

 

The Default Display Format set here is NOT dependent upon which 
Gradebook Mode is used (points-based vs. percentage-based) and vice-
versa. Either of these formats could be used as a default format. For 
example, a points-based system could still display grades in Percent if that 
is what is preferred. The default format does NOT change the mode. 

 

3. The next section allows for some Options to be selected. 

Treat Ungraded Items as Zero – will enter a 0 as a grade for all assignments that have 
not been graded.  

 

This option will place a 0 (zero) for ALL assignments that do not yet have 
a grade – including those assignments that have no grade because they 
are not yet due. It works well at the end of a term when all assignments 
have been completed and you want to enter a 0 for any assignments that 
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were not done by individual students. 

Limit Course Assistants by Team – only allows persons with Course Assistant rights 
to see grades (and enter grades) for students with the same team membership as they 
have. 

 

This is a good option when you have TA’s, GA’s, or Preceptors and you 
want only them to have access to their own students’ grades. Give them 
Course Assistant rights and then create teams for each Course Assistant 
and their respective students. 

Exclude Instructors from Averages – will display a class average that does not 
include any Instructor submissions. 

 

Instructors will appear in the Gradebook and do have the option of 
“testing” any assignments (that is, doing them for a trial to see how they 
work). Using this option will prevent these “test grades” from being 
included with any class grading averages. 

Gradebook Mode – allows for the selection of either a points-based or percentage-
based modality, as discussed above. In this example, the Percentage mode is selected. 

 

While the mode selected here CAN be changed later, even after grades 
have been entered, it does have an impact on how grades are calculated. 
Be sure that you understand the differences between the two modes 
before making any changes. 

The next section (Average Settings) in Preferences contains Options for the final 
grade display. 

4. Check Display Overall Average if you want students to see a running tally of their 
course average. You can also leave this unchecked, and change it later when you want 
the students to see their final grade. 

5. Overall Display Format is similar to the Default Display Format set earlier. However, 
this only applies to the final grade and allows for a different setting. In this case, Score 
(Letter Grade) is selected. 

6. Click Save to keep all preferences as set. 

Setting Up Grading Scale (Letter Grade Scale) 
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Next, a good step would be to set up the scale designating the Letter Grade criteria, especially 
if you will be displaying letter grades in the Gradebook. 

1. On the Gradebook Management (main menu) screen of the Gradebook, select 
Grading Scale. 

 

2. On the next screen, under Label, input the first (best) Letter Grade of your Scale 
(generally A) and the Minimum Percent required to achieve that grade. Click Add New 
to go to the next (second best) Letter Grade. 

 

 

If you want the grade’s calculation to “round up” to the next whole number, 
put the minimum percent as .5 LESS than the minimum whole number. (In 
this example, an A is actually 90%. Entering it as 89.5% will ensure that 
anyone with a total score between 89.5% and 89.9% would still attain an A 
grade.) 
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3. Continue adding all other Letter Grade values in the same manner. Use the Edit or 
Delete links to make any changes. Note that there is no Save button. When you are 
finished, click the Back To Main Menu link. 

 

 

The Grading Scale is not limited to ABC-type grades. You can put in any 
Labels that are applicable. For example, you could have Pass/Fail 
designations by using P and F for Labels and inputting the Minimum 
Percent required for each. 
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How to Set Up the Gradebook: Categories and Assignments 

Differences between Categories and Assignments 

In the ANGEL Gradebook, “Assignment” refers to any graded item. Assignments can be added 
manually within the Gradebook, as part of the setup process when a content item is added to 
Lessons, or through an automated Agent. All Assignments have to be associated with a 
Category. 

A “Category” is a group of one or more Assignments that are weighted together. In a points-
based grading system, there may only be one category with all Assignments linked to it. In a 
percentage-based system, there may be several categories with a specific percentage-weight 
assigned to each category. 

 
See How to Set Up the Gradebook: Preferences and Grading Scale for more 
information about points-based and percentage-based grading systems. 

Only Assignments can be graded; Categories cannot. 

Setting Up Categories 

The first step is to determine what Categories are needed and how they will be weighted. 

If a points-based mode is selected, no weights are needed and only one Category is necessary 
(although you can create more than one). 

If a percentage-based mode is being used, calculate what percentage each Category will 
contribute to the final grade. For example: 

Quizzes 20% 

Discussions 30% 

Research Paper 20% 

Midterm 10% 

Final 20% 

Total 100% 

In this example, there would be five Categories: Quizzes, Discussions, Research Paper, 
Midterm, and Final. 

There are several ways to create Categories. They can be created during the process of 
creating an Assignment when setting up a content item in Lessons. They can be created when 
using the Gradebook Wizard. Finally, they can be created within the Gradebook. 

Setting Up Categories while Creating Assignments in Lessons 



How to Set Up Gradebook: Categories and Assignments 244 

1. Go to Assignments > Gradebook Settings when setting up a content item. Ensure that 
you are in Advanced Settings view. 

 

2. Select New Assignment from the drop-down list. 

 

3. Enter a Title for the Assignment. Note that in Category, the only option is Default, 
which means that no categories have been set up for this course. Click the other button 
to add a category. 

 

4. Complete the information indicated in the pop-up window and then click Add. 
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This example illustrates a percentage-based system with a Weight of 20 
(meaning 20%) entered. For a points-based system, leave Weight blank, 
and check the auto calculate box. 

The extra credit box is only checked if this category has been designated 
an extra credit Category. 

5. Complete the rest of the information to set up the Assignment, and then click Save. (This 
process will be discussed in more detail later in this Appendix). 

 
There are more options available for Categories within the Gradebook 
Manager. These options can be designated later. 

 

Setting Up Categories when Using the Gradebook Wizard 
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The Gradebook Wizard will appear the first time the Gradebook is entered within a new course 
and can be used initially to set up the Gradebook. 

1. Go to Manage > Gradebook. The Gradebook Wizard will appear. 

 

If the Gradebook Wizard no longer appears, you can reactivate it by 
deleting all Categories set up. Generally this is not a good idea, but good 
to know if someone has been testing it out but not really setting up the 
Categories and Assignments needed and now wants to start over. 

2. In the first example here, a points-based system is selected: 

 

3. Some Categories have already been prelisted. These can be changed by overwriting 
them. Notice that in the points-based system, weights are not designated. 

 

4. Here you are changing the Homework Category to Discussion. The Calculation 
options allow you to designate how many Assignments within the Category will be 
counted. In this example, you will drop the Assignments with the lowest grades. 
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5. The next example will illustrate a Category within a percentage-based system. It has 
already been selected. Note that now there is a Weight column. 

 

6. Continue with the rest of the Wizard to set up Assignments and other options. 

 
There is a tutorial illustrating how to use the Gradebook Wizard at the top of 
the first screen of the Gradebook Wizard. 

Setting Up Categories Within the Gradebook 

This can be used either instead of the Gradebook Wizard or to add new Categories when the 
Gradebook Wizard is no longer available. 

1. Open the Gradebook (Manage > Gradebook) and go to Categories within the 
Gradebook Management section. 

2. You will first demonstrate using a percentage-based system. Note that there is one 
category (Default) already listed. It has 0 Weight.  

 

Any Assignments associated with this Default Category will NOT be 
included in any calculations toward a final grade. If no Categories are 
created, all Assignments will automatically be assigned to this Default 
Category and will NOT create a final grade. This Category can be deleted 
or edited. 

3. At the bottom of the Categories section, click the Add New button. 
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4. The Category Editor section will open beneath the row of buttons. Enter a Title for the 
Category you are creating. 

.  

5. In the next section, you will put in the calculation information. In this example, you have 
decided to drop the Assignments with the lowest 3 grades within this Category. 
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6. The Weight is 30 and will ultimately be worth 30% of the final grade once the other 
Categories are added. You can leave the Description blank, or else add some 
descriptive information. 

 

7. The Advanced view offers more options, such as a Release Date and Time if you do 
not want students to view the Category until a specific date/time. Other options include 
changing the way the Category will display; the ability to add a formula; and the option to 
not display the Category average. 

 

For more information on developing formulas for Categories and other 
Advanced options, refer to the Online Instructor Manual and the Instructor 
User Manual. 

8. When finished, click the Save button. 

 

When using a points-based system, there is no Weight designation and you cannot use 
a formula (in Advanced view). 
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With all of these methods available, which is the best to use? It is often 
most efficient to create the categories when setting up the Assignment as 
part of the content item set-up and then go to the Gradebook and create 
any other Categories that might not be associated with a content item (that 
is, Categories with Assignments that are completed outside of the ANGEL 
environment). 

You may also need to go to the Gradebook to add any options to a 
Category that cannot be done when creating a content item, such as the 
ability to drop the lowest Assignment grades in a Category. 

Setting Up Assignments 

As with Categories, there are several ways to set up Assignments. The method used will 
depend upon how the Assignment is graded. Drop Box assignments, Quizzes and 
Assessments, and Discussion Forums can all be set up and graded as content items. Grades 
are generally entered through the Utilities options, or they are automatically graded, such as 
with multiple choice Quizzes and Assessments. 

The Gradebook Wizard can also be used to create Assignments for content items that weren’t 
already created during the item set-up. 

Assignments that are completed outside of the ANGEL environment can be manually added 
and graded through the Gradebook Manager. 

 

Some content items that are not usually set up to be graded, such as 
surveys, can be graded through use of the Automate function. See How to 
Post a Grade for a Survey by Using an Automated Agent for more 
information. 

Setting Up Assignments Within a Content Item 

1. Continue with the creation of an Assignment as already described above. Input the 
number of points to be awarded and determine which grade will display in the 
Gradebook and count towards the final grade. 



How to Set Up Gradebook: Categories and Assignments 251 

 

First submission – the first grade entered. 

Average score – if more than one grade is given (more than one submission), the 
average will be counted. 

Maximum score – the highest score attained if more than one submission has been 
graded. 

Last submission – if an assignment has been submitted several times, the grade for 
the last entry. 

Manual – will be graded in the Gradebook and not through the content item. 

 

If students are allowed to have more than one submission or take an 
assessment more than once, be sure that Calculation Type is set to 
Maximum Score or Last Submission or Average Score. Otherwise, only 
their first effort will count in the Gradebook. 

 

 

Even though a Drop Box Assignment and a Discussion Forum cannot be 
“automatically” graded, they are NOT considered to be “manually” graded 
in this context. Select one of the other options instead (usually First 
Submission, unless the student can submit more than one time). 

2. Select how you want the grade to display in the Gradebook (the default value for the 
display format is set up in Gradebook > Preferences) and then click Save. Only check 
hide gradebook assignment from students IF you do NOT want them to see their 
grades until you are ready to release the Gradebook grade for this content item. 

 

You might want to hide a grade when the assignment is something like a 
research paper where you may not have all the grades completed at the 
same time, and you do not want students to see their grades until all of the 
papers have been graded. You can “unhide” them when you are ready. 
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Setting Up Assignments Within the Gradebook 

This method is used when the Assignment has to be manually graded (that is, outside of 
ANGEL) and cannot be graded via a content item in Lessons. This might be for things like 
awarding credit for attending a performance, or for adding grades for tests not given online. 

 

While Drop Box assignments and Essay questions cannot be 
automatically graded, they are still created within their content items setup 
and are not considered to be “manually graded” assignments in this 
context. Therefore they would NOT be set up using this method. 

1. Go to Manage > Gradebook > Assignments in the Gradebook Management section. 

2. At the bottom of the next screen, click Add New. 
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”  

3. The Assignment Editor will appear beneath the Add New button. Input a Title for the 
Assignment. 

 

 

Keep the title short as this will be the Label for the Assignment in the 
Gradebook. Long titles will be truncated and could be more difficult to 
recognize. 

4. Continue completing the fields. Select the appropriate Category for the Assignment. 
Note that the Calculation Type must be Manual, since this is not associated with any 
content items and is graded outside of ANGEL. (For the purpose of this tutorial, this 
Assignment is an in-class presentation for a blended/hybrid course). 
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Categories need to be set up BEFORE Assignments can be created and 
assigned to them. 

Setting Up Assignments Within the Categories Menu 

Manual Assignments can also be created within the Categories section, and can be done at the 
same time a Category is created. 

1. Go to Manage > Gradebook > Categories. 

2. On the next screen, click the box next to the Category associated with the Assignment 
you are creating, and then click the Show Tasks button. Note that the Category is 
bolded once it is selected. 

 

3. This will open up a number of tasks that are associated with Categories. 

Click the Add Assignments link. 
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4. This will open a screen that is the same as the one in the Assignments section 
previously discussed. Complete the steps as already described. 
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How to Rearrange Categories and Assignments in the 

Gradebook 

Assignments and Categories are arranged within the Gradebook in the order in which they were 
created. This sometimes causes the Assignments or Categories to appear in a different order 
than what is wanted. For example, if Quiz 3 was created after Quiz 5, it will appear in the 
Gradebook in that order, which could cause some confusion for students viewing their grades. 
This order can be changed within the Gradebook Management section. 

Rearranging Categories 

1. Go to Manage > Gradebook > Categories. 

 

In this example, you will move the Category Quizzes up so that it appears above 
Midterm. 

 

2. Check the box next to the Category to be moved. 
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3. Click the Show Tasks button. 

 

4. The [Category_Name] Tasks section will appear below the Categories. Click the Move 
Up or Move Down link to move the Category into the desired location. In this instance, 
you will use the Move Up link. 
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You may need to click the “Move Up” or “Move Down” link more than 
once, depending upon where you want to place the category that is being 
moved. 

5. Click the Done button when finished. 

 

In this example, the Quizzes Category has now been moved above the Midterm 
Category. 



How to Rearrange Categories and Assignments in the Gradebook 259 

 

Rearranging Assignments: 

1. Go to Manage > Gradebook > Categories (see previous Step 1). 

 

Assignments can only be rearranged within their own Categories. For 
example, if you had a “Discussion” Category and a “Quiz” Category, you 
could not move the Assignment “Discussion 1” so that it would appear 
next to assignment “Quiz 1” if they belonged to different Categories. 

2. Click the box next to the Category that contains the Assignments that need to be 
rearranged. In this example, you will be rearranging the order of some quizzes within the 
Quizzes Category. 

 

3. Click the Show Tasks button. 
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4. The [Category_Name] Tasks section will appear below the Categories. Click the 
Reorder Assignments link. 

 

5. The Reorder Assignments screen will appear. Select the Assignment that you want to 
move, and then use the Top/Up/Down/Bottom buttons to move the assignment into the 
correct position. In this example you are moving Quiz2 so that it will appear before 
Quiz3 or Quiz4, so you will click the Up button twice. 
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The buttons will move the selected Assignment as follows: 

Top moves it to the top of the list of Assignments. 

Up moves it up one place. 

Down moves it down one place. 

Bottom moves it to the bottom of the list. 

6. Click the Save button when everything has been rearranged as needed. 

 

7. This will bring you back to the main menu screen for the Gradebook. To check the 
results, click Assignments. 
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8. The Quizzes are now listed in their correct order. 

.  

The Gradebook view also shows the Quizzes in the correct order. 
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How to Create an Extra Credit Assignment 

ANGEL allows you to create Extra Credit Assignments using two different methods. Which 
one you use will depend upon how you want the extra credit to be applied. You can create 
either an Extra Credit Category or an Extra Credit Assignment. You can have both Extra 
Credit Assignments and Extra Credit Categories, as long as you do not put an Extra Credit 
Assignment in an Extra Credit Category 

 

This is an “either-or” proposition. You cannot designate a single 
Assignment as “extra credit” within an Extra Credit Category. ALL 
Assignments within an Extra Credit Category are automatically calculated 
as “extra credit.” 

Creating an Extra Credit Category 

This option would be most useful if you wanted to add extra credit to the total grade. The Weight 
assigned to this Category would increase the grade accordingly. [For example: If the Gradebook 
were using a percentage-based mode, the weight were 2, and the student was awarded full 
credit for that category; this would increase the final grade by 2%. (That is, if the final grade is 
80%; then receiving the full amount of extra credit from a category with a weight of 2 would 
increase the final grade to 82%.)] 

Exactly how the grade is computed depends upon the type of grading system used: percentage-
based or points-based. 

 

For more information about using a percentage-based grading system versus 
a points-based grading system, see How to Set Up the Gradebook: 
Preferences and Grading Scale. 

1. Go to Manage > Gradebook. 

2. On the following screen, select Categories under the Gradebook Management section. 
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3. On the next screen, click the Add New button to add a new category. 

 

4. Add a Title and Weight (if applicable). This example illustrates a percentage-based 
system. 

 
In a percentage-based system, the amount added will add that many more 
percentage points to the final grade. 
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If using a points-based system, you will not see the Weight option; the 
Weight will be determined by the point value of the assignments 
associated with that category. 

 

5. Check the box next to Extra Credit. 
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6. And then click the Save button. 

 

7. With both the percentage-based and points-based system, the Category will now be 
listed with all the other categories. 

8. Percentage-based system: 

 

With the percentage-based system, the Weight is listed with no Percent Overall value 
indicated, but with a weight of 2. 
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Looking closer at the Weight and Percent Overall columns above, you can see that the 
overall percent is computed WITHOUT the 2 weight for the Extra Credit Assignment, so 
that it will count as an extra 2%. (Note that the values in the Weight column actually add 
up to 102). A student who earned an 88% before adding in the extra credit and receiving 
full credit for the assignments associated with the Extra Credit Category would then 
receive a grade of 90%. (If the student did not get full credit, the grade would reflect the 
credit the student did receive.) 

9. Points-based system: 

 

With the points-based system, the Weight for the Extra Credit Assignment is listed as 0 
because no assignments have been added to it. Once an assignment has been added, 
the weight will reflect the total point value of all Extra Credit Assignments associated with 
that Extra Credit Category. 

In the example below, an Extra Credit Assignment has now been added with a value of 
20 points. However, it is not computed into the actual Weight value. If it had been, the 
total weight would be 565 instead of 545. 
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Using this example, if a student had received a score of 480 points (before adding in 
extra credit points), that student’s grade would be 480/545. If the student then received 
15 extra points (out of the potential 20 extra points) from the Assignments in the Extra 
Credit Category, that student’s grade would be 495/545 (that is, the points earned 
increase to 495, but total points stay the same). Expressing this as a percent; the grade 
would have increased from 88% to 91%. 

Add the Assignments to be associated with the Extra Credit Category, designating the 
Extra Credit Category, when prompted. 

 
See How to Set Up the Gradebook: Categories and Assignments for more 
information on how to create Assignments. 

 

 

When creating the Assignments that are associated with an Extra Credit 
Category, do NOT check the “Extra Credit” box within the Assignment 
Settings. 

Creating an Extra Credit Assignment 

As noted previously, you can either: 

 create an Extra Credit Category and place all Extra Credit Assignments within that 
category, OR 

 you can designate any Assignment as an Extra Credit Assignment. An Extra Credit 
Assignment will add the extra credits to the total of the category in which it is assigned. 
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If you are using a points-based system, all points are cumulative. So using 
either an Extra Credit Category or an Extra Credit Assignment will have the 
same effect. 

One very simple way to assign extra points to any assignment is to assign more points to the 
assignment than originally designated. For example, an assignment worth 20 points could be 
assigned extra points to deserving individual students by awarding 25 points (5 points more 
than designated) instead. 

1. To create an Extra Credit Assignment that will be graded manually (that is, not through 
ANGEL – as in an Assignment Drop Box, Discussion Forum, or Quiz/Exam), go to 
Manage > Gradebook. 

2. Select Assignments in the Gradebook Management section. 

 

3. Click the Add New button. 
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4. Input a Title, select the appropriate Category, assign Points, and check the Extra 
Credit box. Click Save to finish. 
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5. For Assignments that are graded through an ANGEL content item, create the 
Assignment through the Assignments tab in the settings for that item. The Category 
selected CANNOT be an Extra Credit Category. 

 
See How to Set Up the Gradebook: Categories and Assignments for 
instructions for setting up an Assignment for a content item in ANGEL. 

When creating this type of Assignment, you CANNOT designate it as Extra Credit within 
the settings. You will need to edit the Assignment in the Gradebook after it has been 
created. Once the Assignment has been created, follow the above instructions to begin 
editing it. 

6. Check the box next to the Assignment that you want to designate as Extra Credit, and 
then click the Edit Selected button. 

 

7. On the following screen, check the Extra Credit box, and then click the Save button to 
finish. 
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The Extra Credit Assignment WILL raise the total grade within the Category to which it is 
assigned. In a percentage-based system, it will NOT affect the overall Weight of the 
Category towards the final grade. Therefore, it may have either a greater or lesser effect 
on the final grade as compared to using an Extra Credit Category. 
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How Students Can See Their Grades 

ANGEL allows students to see their grades in a variety of ways. The Instructor can decide what 
tools might work best for the course. Students can see only their own grades, not anyone else’s. 

Using the Grades Nugget 

The Grades nugget appears on the Course page by default. It displays a graphical depiction of 
the student’s grade per category as compared with the class average. 

1. As the Instructor, you will see the combined averages of all student grades. Go to the 
Course page to see the Grades nugget. The nugget will appear in its collapsed state. 
Click the Expand icon by hovering the mouse over the end of the  toolbar to make the 
icons appear. 

 

2. Note that now all Category averages appear. Only one of the Categories has any grades 
entered for it at this point. Students see only their own grades, compared with the class 
average. 

 

 
Remind students to click the Refresh link; otherwise they will not see the 
most current results. 

3. By clicking on one of the grade bars, the student can view the specific assignment 
grade(s). 
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Doing so will bring up the Reports Console with the Learner Profile and Gradebook 
Grades already selected as the default. 

4. Select the appropriate report view. Table view will display a table with each assignment 
and the associated grade and the class average. Chart view displays a bar graph with 
the same information. In this example, the student is selecting Table view 

5. Click Run to continue. 

6. The student’s grade(s) will now appear. 

 

7. If the Assignment title is a clickable link, clicking on it will return the student to the 
Assignment within Lessons where the submission, Instructor attachment (if any), grade, 
and Instructor comments will be viewable. 
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Using the Reports Console 

Students can go directly to the Reports Console to see their grades by using the Reports tab. 

1. Go to the Reports tab. 

2. Keep the Learner Profile Category selected, and change Report to Gradebook 
Grades. 

 

3. Follow steps described above to view the grades. 

Using Course Tools 

Course Tools is an optional nugget that can be added to the Course page or the Resources 
page. It shows all grades in a different format than on the Reports Console. 

1. Go to the page where you want to add the Course Tools nugget and click Edit Page. In 
this example, you are putting this nugget on the Resources page. 
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2. On the next screen in the Add Component window, highlight Course Tools and then 
click the Add Component button. 

 

3. Course Tools will now appear with the other nuggets on that page. 
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4. Click the Save button to continue. 

 

 

When you return to the Resources page, you will NOT see the Course 
Tools nugget as an Instructor or Course Editor. Only students see that 
nugget. 

5. When students go to the Resources page, the Course Tools will be available. Notice 
that there are a number of options available. Click My Grades. 
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6. The student will see all grades and comments. 
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How to Create a Survey 

Within ANGEL, you can create Surveys using a variety of options. ANGEL Surveys could be 
used for everything from simple course feedback to complete end-of-semester student 
evaluations. The results from the Survey can be reviewed using the Response Summary 
report option. 

1. Go to the location where you want to place the Survey within Lessons, and click Add 
Content. In this example, you are going to add it as a top-level content item that is not 
within any of the modules. 

2. On the following page, click Survey. 

 

3. Set up the Survey as for any other content item: add a Title, any specific Directions, 
and also the Access settings that are needed. 
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4. One setting that may be different from what is usually chosen is in the Submission 
section. Check the box next to Make submissions anonymous to keep users from 
being identified with their answers. 

 

5. Save all settings when you are finished. 

6. After you save the settings, you will be able to add the questions for the survey. Click 
Add Question to continue. 

 

7. These are the types of questions that can be added: 

 Section Heading 

 Text Box 

 Text Area 

 Checkbox 

 Check List 

 Drop-down List 

 Option List 
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 Likert Scale 

 Copy Questions 

 Import Questions. 

8. The Section Heading Editor will allow you to add some information about the questions 
that follow. There is an Editor for each type of question. 

 

 In the completed survey, the Section Heading will appear like this: 

 

As you enter each question, you will be returned to the original page so that you can add 
more questions. Note that there is an Edit and a Delete button next to each question. 

 The next question you will add is a Text Box question. This will allow users to type their 
answers into a single-line answer box. Add the question by typing it in the Question 
window 
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In the completed survey, a Text Box question will appear like this: 

 

 A Text Area question is similar to the Text Box question, except that users have a larger 
window in which to type their response. 
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In the completed survey, a Test Area question will appear like this: 

 

 A Checkbox question displays a checkbox next to a label. The user would check the 
box as directed. 

 

In the completed survey, a Checkbox question will appear like this: 

 

 A Check List question allows you to ask a question and then display a series of choices. 
Users can check their applicable choice(s). Type your question in the question box. 

In the Choices section, click Add to add the first choice: 
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In the pop-up window that appears, type in the first answer choice, and then click OK. 

 

Continue adding all answer choices. You can use the Up/Down options to rearrange 
any answers. 

The Unselected/Selected section beneath the answers allows you to have one of the 
choices preselected in the user’s view of the Survey. To preselect an answer, highlight 
it and then use the drop-down list to choose Selected. If no choices are to be 
preselected, then leave them Unselected. Also: 

“+” – next to the answer choice indicates it has been preselected; 

“–“ – next to the answer choice indicates that it has not been preselected. 

If a choice IS preselected, there will be a check in the box next to the choice when the 
user views that question; however, the user can change to a different choice. Also users 
can select more than one choice. 

Click Save to continue. 
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In the example below, none of the choices were preselected. 

 

 The Drop-down List question is similar to the Check List, except that users see a drop-
down list of choices rather than a checklist of choices. Setting it up is identical to setting 
up a checklist. Users highlight their answer choice, and only one may be selected. 

 

 An Option List is also similar to a Check List and is set up the same way. For this too, 
only ONE answer may be selected. 
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 A Likert Scale question is very similar to an Option List and allows you to create a 
question that asks users to rank their ONE answer choice according to personal 
preference (that is, their intensity of agreement or disagreement). The Likert Scale also 
differs from the Option List in the way the results are formatted. 

 

 Copy Questions allows you to copy a question from another survey within the same 
Course, similar to the Copy Question feature in Assessments. 

 Import Questions allows you to import questions from a text document by copying and 
pasting. The document has to be in a specific format as noted on that screen. You can 
specify the type of question within the document. You can also paste-in as many 
questions as you need all together at one time. The Import Questions page has full 
instructions as to how to format the document, including the format to be used to 
designate the type of question you want. A sample format is displayed for you in the 
Import Questions window, as shown below. 
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9. When all the questions have been added, you can view the completed Survey by 
clicking Preview. 

 

10. The Survey will display. While you can answer any of the questions, none of the 
responses will be saved and therefore will not be included within the Response 
Summary. 

11. After users take the survey, the results can be viewed by clicking Reports. 
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12. And then click on Response Summary on the next page. 

 

13. Responses will be displayed differently, depending upon the type of question. If the 
question required users to type in their answer, you will see the Total number of 
responses further subdivided by the number of Valid versus Blank responses. (“Valid” 
means answers that were completed.) Then click on the Responses link. 

 

14. All of the responses to that question will be listed. Since only one person has taken this 
“example” survey so far, only one response is listed. Click Done to return to the 
Response Summary page. 



How to Create a Survey  289 

 

15. If a question required the user to use a Checkbox, Drop-down List, or Option List, the 
number of responses for each option will be listed for that question. 

 

16. If a question required a Likert Scale answer, the number of responses for each choice 
on the scale will be listed, as above, along with an Average Response derived from all 
of the answer-choices. 

 

 
If you want to award points for taking a survey, see How to Post a Grade for a 
Survey by Using an Automated Agent. 
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How to Create Teams 

There are many ways that ANGEL takes advantage of the ability to create teams. Each content 
item can be configured so that it is only open to certain teams, or to allow for its settings to be 
customized for specific teams. Emails, Announcements, and Calendar Items can be limited to a 
particular team or teams. Teams can also be utilized for Group Projects, with Chat Rooms and 
Discussion Forums limited to team members. Teams can share files and can display a project to 
other Course members. 

 

For more information on customizing settings for specific teams, see How 
to Set Team Access Rights for Lesson Content. 

For more information about sharing files among team members, see How 
to Share and Edit Files Among Multiple Users. 

Teams can be created either through randomly generating the teams and members, or by 
adding a team and directly assigning members to that team. 

Randomly Generating Teams and Members 

1. Enter the Course in which you want to create teams. Go to Manage > Teams. 

 

2. On the next screen, select Random Team Generator. 
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3. On the following screen, you will set the criteria for the teams to be generated. In the first 
section, you will assign the Root Name for the team names. All team names will contain 
that name followed by a consecutively-assigned numeric designation. In this case, the 
team name will begin with the name Group. 

 

4. The next designation is Criteria. This will determine how many members will comprise 
each team. You can either specify the number of teams to be created, or denote the 
maximum and/or minimum number of team members to be assigned to each team. In 
the example below, each team must have at least 2 members, but no more than 3 
members. 

 

5. The following section, User Pool, sets the criteria for the membership for the teams. 
Membership is designated by user rights; the default is to assign all students. You can 
add other course users with different rights, depending upon the need. 
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Teams can also be created as sub-teams of already-created teams. There 
is an option to draw team members from the entire roster or only from a 
specific team. 

 

 

When the teams are generated, they can only draw membership from 
users who are already on the Course roster. If additional users are 
enrolled into this Course after the teams have been created, they will 
either have to be manually added to a team, or else  the Rebalance 
Generated Teams option can be used to assign them. 

 

6. Click the Next button to continue after all criteria have been set. 

 

7. The Adjustment page will display with the team members assigned to each team. You 
can adjust the team membership by clicking on a specific name, using the Move option 
to select another team from the drop-down list, and then clicking the Move button. 
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8. When all adjustments are made, click Generate Teams. 

 

9. The following screen will be a display of all teams and assigned members. Click 
Continue to finish. 
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Save this screen as a PDF or HTML document, and then upload to 
Lessons so that students can see their team assignment and their fellow 
team members. 

10. You will be returned to the Teams Editor screen where all teams will be listed. 

 

 

If you need to apply any settings to the teams created, such as enabling 
file sharing, you will need to edit the team by going to the Teams Editor 
page and clicking the settings link for that team. You can also add or 
remove members, rename the team, or delete the team from this page. 

Creating Teams and Assigning Team Members Manually 

If you want to create specific teams and add specific members to the teams, you can do this by 
using the Teams Editor Add a Team option. 

1. Go to Manage > Teams, as in Step 1 of the previous section. 

2. On the Teams Editor screen, click Add a Team. 



How to Create Teams  295 

 

3. The New Teams – Team Settings page will open. 

 

You can return to this page to add or change any options for the team by 
clicking the settings option beneath the team name from the Teams 
Editor page. 

4. Name the team and add any other values. If the team has a homepage, you can input 
the URL for that page. If the team has created a project, input the URL in the Project 
URL field. Hidden will hide the team from student view. Disabling the team will prevent 
members from any team-associated access. 

 

When a URL is added as a Project URL, a new section will appear in the 
Communicate section called Team Projects. This will allow anyone not on 
the team to view the URL, which generally is some type of presentation. 
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If you have a single student who needs to have different settings for an 
assignment (for example, a student has to take a test on different date or 
needs different accommodation settings), create a team consisting of that 
one person only and set Hidden to Yes so that this Team is not visible to 
other students. You can then go to the Assignment and customize settings 
for that one-student Team. For more information on customizing settings 
for specific teams, see How to Set Team Access Rights for Lesson 
Content. 

5. If you want the team to be able to share files, then select the Enabled option for File 
Sharing and designate the maximum file size for the team file area. Click Save when all 
settings have been entered. 

 

 
For more information about sharing files among team members, see How 
to Share and Edit Files Among Multiple Users. 

6. The next screen will allow you to add members to the new team. Check all members to 
be included within the group, and then click Add Selected. Note that other team 
memberships are displayed for each user. 
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7. The new team members now have the already a member icon next to their names. Also 
note that the “Red” team has now been added to their team list. Click Done to finish. 

 

 

If the class had so many members that there were more than one page of 
users, there would be a link to the other pages at the bottom. You can only 
add members one page at a time; so you would select all users on the first 
screen, click Add Selected, then go to the next screen of names, select 
the users, and again click Add Selected. You would NOT click Done until 
all members were selected on all screens. 

8. The new Team has now been added. 
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How to Set Up Team Projects 

When creating a Team, you can set up a section for team members to share files.  If they are 
developing a Team Project to be viewed by other members of the course, you can also create a 
nugget to display that. 

 
See How to Create Teams to learn how to add teams to the course. 

1. Enabling file sharing is done during the Team set up, or it can be done later by going to 
Manage > Teams. 

 

When adding teams using the Random Team Generator, you will not have 
the option to enable file sharing. Once the teams have been created, you 
will then need to enable it using this procedure. 

 

2. On the next screen, click on settings for the team for which you want to allow file 
sharing. 
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3. Go to the Team Tools section and change the File Sharing option to Enabled. Also put 
in the maximum amount of file space for the team. This may be set by your institution’s 
policy; so check with your System Administrator. This may also be set when adding a 
team using the Teams Editor > Add a Team option. 

 

If teams are creating PowerPoints, caution them as to their file restrictions. 
PowerPoints with large pictures, animations, sounds, and so on, can 
become quite large. Helping them to convert the PowerPoints to PDF files 
or having them upload the PowerPoints as web pages can greatly reduce 
their presentation’s size. 

 

4. Click Save to finish. 
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5. This will display the Team File Sharing nugget in the Communicate section of the 
Course. 

 
Students will only see the link to the File Sharing area of the team(s) in 
which they are members. 

 

 

The Team File Sharing nugget can be added to other sections of the 
Course, including the Course page and the Resources page, through the  
Edit Page feature. 
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When team members click on the Files link, they will first be able to click Add Content. 
Then they will be able to create a folder, create a web page, and/or upload files. 
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If students are creating a presentation to be viewed by all the other Class members, you can 
add a Team Projects nugget. To add individual student projects, you will need the URL to that 
team’s project. If the team has created a web site, you would use that URL. 

If the file that the team wants to use for the Team Project is in their file sharing area, you can 
determine that URL going into their team file area by clicking on their team name. The file(s) will 
be listed there. 

In this example, the team has uploaded a PowerPoint file that has been converted to a PDF. 

 

Microsoft Office 2007 has a utility that will allow the user to save a 
PowerPoint as a .pdf file. In addition, there are a number of free programs 
that can be downloaded that will save documents and PowerPoints as .pdf 
files. 

 

1. Do a right mouse-click on the file name (if using a Mac, click and hold). Depending 
upon the browser you are using, select either Copy Shortcut (Internet Explorer) or 
Copy Link Location (Firefox) from the drop-down menu. This will copy the link so you 
can paste it later. 

2. Click Exit Team Files. 
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3. Go to Manage > Teams. 

4. Go to the settings link of the Team from which you copied the URL (above). 

5. Click inside the Project URL field and do a Paste. That will add the URL that you copied 
earlier. 

6. Save your settings by clicking the Save button. 
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7. Returning to the Communicate section of the Course, you can see that the Team 
Projects nugget has now been added and that Team A’s Project is listed. 

 

8. Clicking on Team A’s Project link will open the file for others to view. If the team project 
is a web site which is housed elsewhere, this would link to that site. 
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How to Rebalance Teams 

Teams that have been created with the Random Team Generator can be reconfigured by using 
the Rebalance Generated Team option. This may be necessary if new members need to be 
added to already-created teams, if members need to be deleted from teams, or if the 
membership needs to be redistributed for other reasons. 

 
The Rebalance Generated Teams option can ONLY be used with teams 
that were created using the Random Team Generator. 

1. Go to Manage > Teams. 

. 

2. Click Rebalance Generated Teams. 

 

3. On the next screen, select the Team to be rebalanced from the drop-down list, and then 
click the Next button. 
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4. On the following screen, you can make any changes to the teams. In the first example, 
you will add a new student to a Team. In the Unassigned User column, highlight the 
name of the user that you want to add to a team. 

 

 
If you have more than one user to select and move to the SAME team, 
you could hold down the control key while selecting each member. 

5. Going to the bottom of the Unassigned Users column, select the Team to which the 
user(s) will be assigned from the drop-down list. 
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6. Once the Team has been selected, the user will immediately be moved to that team. 

 

7. You can also move a student from one Team to another. Highlight the user that you 
want to move. 
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8. At the bottom of the column, choose the Team to which the user will be moved. 

 

9. Once the Team is selected, the user will be moved into that team. 

 

10. When all changes have been made, click the Generate Teams button at the bottom of 
the page. 
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11. The next screen will display the new team configurations. Click Continue to finish. 

 

Save this screen as a PDF or HTML document and then upload it to 
Lessons, so that students can see the new team assignments and their 
fellow team members. 

 

 

If you need a copy of a group of teams with members at any time in the 
future, you can use the Rebalance Generated Teams option, as long as 
the teams were created with the Random Team Generator. Follow Steps 
1-3 above. On the Adjustment Page screen that will open after Step 3, 
without making any changes or corrections, click the Generate Teams 
button. The team memberships will not change, but you will have all the 
Teams from that group displayed with members as in the example below. 
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How to Set Team Access Rights for Lesson Content 

By creating Teams, you can control access and settings for Lesson content items. You can both 
restrict content items to one or more teams, or you can change settings within a content item for 
different teams. A Team can consist of one or more members and you can have as many 
different configurations of teams as you need. Course members can belong to more than one 
team. 

There are some examples: 

 One student needs to take a test at a different time than the rest of the class, or needs to 
have different test settings for accommodation purposes. You can create a Team for that 
one person and then create the individualized settings. 

 A cross-listed course contains students at both the graduate and undergraduate level. 
You could create 2 Teams, one for undergraduate students and one for graduate 
students, and then restrict some assignments and content to one Team or the other. 

 Students are divided into groups to create group projects and need access to different 
content. Create a different Team for each group and then limit content items according 
to their needs. 

Restricting a Content Item to One or More Teams 

This can be done when setting up the content item, or by accessing the content item settings 
after the content item has been created. In this example, the content item has already been 
created. The procedure is basically the same for any type of content item. 

1. Go to the Settings link of the content item you want to have restricted to a Team. In this 
example, you are using a folder of documents for Team A. 

2. Select Advanced view. Go to the Access tab, and then to Team Access. 

3. Use the drop-down list to select Selected Teams. 

4. You will then be able to check the Team that you want to have access to this content 
item. In this case, you will check Team A. 
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5. Click Save to finish. 

 

This example uses a Folder as the content item. By default, all settings will 
automatically cascade down into any NEW content item added to the 
Folder as well as content already within the Folder, so that those items will 
also be restricted to the Team specified. 

Creating Different Settings for Different Teams 

This option is most often used with tests and exams. It will allow different settings for different 
teams, such as a different date and time, or longer time period to take the test. 

1. Follow Steps 1-4 above. For this example, you will use an Assessment. 

2. Instead of checking the box next to the Team, click on the Team name. In this example 
you are going to change the settings for Team A, so you click Team A. 
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3. This will bring you to the screen that will allow you to customize the settings for this 
Team. In this case, you will set a different date and time for the test to be taken by first 
checking the Advanced Settings and then changing the Delivery Start Date and the 
Delivery End Date and also checking the boxes next to them. 

 

4. Click Save to finish. 
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5. The new settings will now allow those persons in Team A a different date and time in 
which to take the test. 

In order for everyone else in the course to take the test, they need to be members of 
another Team, and that team also needs to be checked in the Selected Teams 
designation. By default, their settings will be the settings originally designated for that 
test, since they have not been customized. In this example, the rest of the students are 
members of Team B. 

 

 

Create a Team and make all students a member of that Team. Then when 
you need to customize settings for a different team, you won’t have to 
create more teams for the students NOT in the team that needs the 
custom settings. 

You can indicate a priority for students who are members of both teams. In 
this example, all students are members of Team B. Only a few students 
are members of both Team A and Team B. When customizing the settings 
for Team A, there is an option to indicate Priority in the Advanced 
Settings. Giving Team A a priority of “1” means that anyone who is a 
member of Team A (no matter what other teams they are members of) will 
have the settings customized for Team A. 
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6. Click Save to finish. 
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How to Automate Sending an Email to Students Who Have Not 

Logged onto a Course Within a Specified Time Period 

By using Automated Agents, you can create an Agent that will send an email to all students 
who have not logged onto a course within a time period that you specify. You can also have the 
email automatically sent to yourself so that you know which students were included. 

1. Go to the Automate tab within the Course and click Add New Agent. 

 

2. Name the Agent something descriptive (in this example, Log on Email). 

3. Select the Scheduled Agent type. This procedure will be set to check log-ons according 
to a specific schedule. 

 

4. Choosing this type of Agent opens up some scheduling options. In this instance, you will 
have the Agent run every Monday at 11:55 PM. Note that Agents can be scheduled to 
run Daily, Weekly, Monthly, or On demand (manually activated), or on a specific date 
and time. 
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.  

 

Consider your own Course requirements when deciding on a schedule. In 
this case, the Course has assignments due every Tuesday at 8 AM. So 
the Instructor is interested in knowing who has not accessed the course 
since the previous Monday evening one week ago. 

5. The criteria selected to this point are summarized at the bottom of the screen. Click the 
Next button to continue. 

 

6. On the next screen, you can further delineate which users are to be included within the 
search criteria. You want to include all users, so you will not make any more specific 
changes to the User Selection section. 
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7. In the following section, designate the conditions that apply to this Agent. In this case, 
you are monitoring Last Logon. 

 

8. Choosing that option opens up more options to further delineate the users to which this 
Agent will apply. 
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9. In this instance, you want to target all users who have not logged on in 7 days. There 
are also other time frames that could be chosen, depending upon the desired result. 

10. At the bottom of the screen, all of the criteria that have been set up are summarized. 
You could add more criteria to select more users, but this is all that you need for this 
Agent. Click Next to continue. 

 

11. Now that you have established the users that need to be targeted for this Agent, you 
need to specify what action you want to occur once the Agent runs. 

In this instance, you want the students who have not logged onto the Course within the 
past 7 days to receive an email reminding them of the class requirements and also 
requesting further information from them about their absence from the Course. 

Therefore, the action you want is Email (External) (that is, the Agent will send an email 
to the Internet address of all students who have not logged onto the course within 7 
days. 
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Students who have not logged on within the past 7 days are not likely to 
be monitoring their internal emails sent within ANGEL. Therefore, it is 
more probable that they would see the email if it is sent to their external 
email account as associated with them by ANGEL. 

12. Since Email (External) is selected, you need to tell the system to what email addresses 
to send the emails, and you also need to create the email message to be sent. In doing 
this, you use several tokens. The system will substitute the actual data for each token. 

 

In the example above, the email will be sent to the Instructor (the To recipient) so that 
the Instructor knows who received the email. 

In the Bcc field, you are using the token $USER:EMAIL$. When the Agent is run, it will 
substitute the external email addresses – in place of the token – for all students that 
meet the criteria. By using the Bcc (Blind carbon copy) field, the students who receive 
the email will NOT know who else is receiving the email, thereby complying with FERPA 
regulations. 

13. You will need to create the email message (such as partially shown below) that all the 
students who meet the criteria will receive. In the body of the email, you are using 
another token to personalize the email: $FIRST_NAME$. When students read this 
email, they will see their own names instead of this token. 

 
For more information on tokens, refer to the Instructor Reference Manual or 
the Online User Manual. 
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14. The bottom of the screen summarizes all of the criteria set. You could add another 
action at this point, but in this instance you are not going to do that. Click Next. 

 

15. The final screen allows you to look at everything that has been set up and edit as 
needed. Click Save if everything looks satisfactory. 
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Editing the Agent Type will completely negate all settings and require you 
to start over from the beginning. 

16. Once you have saved the Agent, you will be returned to the Agent Console screen 
where you can see that this Agent is now set to run on Mondays at 11:55 PM. Once the 
Agent has run, you will be able to see when it last ran and whether or not there were any 
errors. Since you have just created this Agent and it has never run before, there is an 
N/A (Not Applicable) listed for both Last Status and Last Run. 
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How to Release Content to Students 

Within the settings for any content item, you can specify when the content will be released for 
students to access. You can also preview and ensure that students are not seeing any content 
that you do not want them to access. 

1. You control the release of content items using the Settings for that content item. In this 
example, you will set a Folder and its contents to be released on a specific date. This is 
done in the Settings for that content. If the content has already been created, you can 
adjust the Settings for that content. Otherwise you can set the release controls when the 
content item is created. 

2. Go to the content item and click settings. 

 

3. Go to the Access tab and select Advanced settings 

4. Go to the View Restrictions section. Setting a Start Date and Time will release the 
content on that date and time. If you want the content item to also stop being accessible 
at a specific time and date, you can set that as well in the End Date settings. 

 
Be sure that you check the box next to the date and time. If this is not 
checked, the date and time will not be set. 

5. Click Save when you have finished with the settings. 
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6. The content item now will NOT be released until the set date and time. 

 

When working with folders, all settings within the folder cascade to any 
content items ADDED to the folder after the settings have been done. 
However, if settings to the folder are made AFTER the folder contains 
content items, the new settings will not cascade to the items within the 
folder unless the specific Cascade Settings are applied (in the Access 
tab, Advanced View). 

 

 

There are several other ways to release content to students: 

You can restrict content by Team (see How to Set Team Access Rights for 
Lesson Content). 

You can have content released based upon an action taken by a student, 
using an Agent (see How to Release Content Conditionally by Using an 
Agent). 
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How to Release Content Conditionally by Using an Agent 

Releasing Content by Using the Unlock Action 

By using an automated Agent, you can release course content based on specific criteria. For 
example, you could release new content based upon a Drop Box or Assessment grade. This 
content could be remedial in nature, based upon an unsatisfactory score, or it could open the 
next module of content based upon the student’s score. Another example would be to release 
content after students have taken a pretest or survey. 

One way that content could be released by using an Agent is to “unlock” the content for 
students meeting specific criteria. 

1. To begin, you need to create a password for the content to be released. Go to the 
Settings option for the content. In this example, you will be releasing the content in the 
Module 3 folder. 

2. In the Access section, add a Password. The characters that you enter will appear as 
asterisks. 

 

 
Beginning the Password with a “!” (exclamation point) will hide the content 
item from the students’ view. 

3. Click the Save button when you have finished adjusting any other settings. 
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4. The folder will appear with a small Padlock icon on the side when you are in Course 
Editor view. 

 

In Student view, the Module 3 folder does not appear. 
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If you had not used “!” as the first character in the Password, the Student view would be 
similar to the Course Editor view: 

Only the Password will unlock the Module. In Course Editor view, when you roll the 
mouse over the padlock icon, the password will appear. 

 

5. Go to the Automate tab. 

6. In Agents Console click Add New Agent. 

 

7. Supply a name for the Agent that will help you identify it easily, and then choose 
Content Agent as the Agent type. 
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8. Click the Select content to monitor link that will appear when Content Agent has been 
selected. 

  

9. Select the Lesson Type of content that will be monitored (that is, what type of content 
item is going to trigger the Agent to activate). In this example, it is going to be an 
Assessment. (Students will have to meet or exceed a specific grade on the Assessment 
for the content in Module 3 to be available to them.) 
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10. Select Specific assessments in order to designate the Assessment that will be used for 
this Agent. In this example, it is Exam 1 (which is the only Assessment set up in this 
Course at this point). Click Add. 

 

11. Then click Close Window. 
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12. You will need to indicate WHEN the agent is to run. Because the specific action will 
occur based on the grade that the student receives, the choice here is graded. 

 

13. Because graded is chosen, more options will appear so that you can set the criteria for 
the content to be available. In this instance, you want the Module 3 content to appear if 
the student receives a grade of 80% or more. 

 

14. The summary for everything that so far has been set up for the Agent will now appear at 
the bottom of the screen. Click Next to continue. 

 

15. The next screen allows you to select which users would be included within the Agent. In 
this instance, you want all users to be included, so you will NOT make any changes in 
this section. 
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16. A summary for the Agent will be displayed at the bottom of the screen. Click Next to 
continue. 

 

17. On the following page, you will designate the action that is to occur if a student scores a 
grade between 80% and 100% on Exam 1. You want Module 3 to be viewable by the 
student; which means you need the password-protected Module 3 folder to become 
unlocked. Therefore, the action is Unlock. 
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18. Next you need to designate which users are to have access to the content (that is, have 
the content “unlocked”). Select Event Originator as the user. This means that any 
person that triggers the “event” (which is achieving a score of 80% or better) is to be 
included. (That is, this isn’t just limited to users on a particular team.) 
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19. Finish this section by putting supplying the Password that will unlock the Module 3 
folder. 

 

 

If you forget what the password is, remember that you only have to roll the 
mouse over the Padlock icon for the content item and the password will 
appear! 

20. The summary appears at the bottom of the page. Click Save to complete the procedure. 
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You could add more than one password if you had several content items 
to be released based on the action set. 

21. The final page allows for any changes to be made. Click Save to activate the Agent. 

 

22. The Agent has now been added to the Agents Console. 

 

 
This same procedure could be used to open remedial content by setting 
different grade criteria and unlocking other content items. 
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How to Post a Grade for a Survey by Using an Automated 

Agent 

Sometimes Instructors want to give students a specific grade for completing a survey. Since 
surveys are not “graded” the same as an Assessment (that is, there are no correct or incorrect 
answers, so the student does NOT receive a score that will be automatically recorded in the 
Gradebook), this can pose a problem. There are some manual solutions; for example, the 
Instructor can check the Reports for the survey to see who has completed it, and then record a 
grade in the Gradebook. However, you can also create an Agent that will automatically submit a 
grade to the Gradebook for every student who submits the survey. 

Create the Survey Assignment 

1. Create the Survey (Lessons > Add Content > Survey) by completing all sections in 
Settings as needed except for the Assignments section. 

 
See How to Create a Survey for instructions on creating surveys. 

2. Ensure that you are in the Advanced Settings view. 

 

3. Go to the Assignment section. You will be working with the Gradebook Settings. 

 

4. Using the drop-down menu for Assignment, select New Assignment. 

5. Add a Title, select the correct Category for the Assignment, and designate the point 
value (Points Possible) for the Assignment. This is the grade that each student 
submitting the survey will receive. Set Calculation Type to Manual. 
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Keep the Title for the Assignment short, since this will be the label that 
will display in your Gradebook. It will make this Assignment easier to 
identify since longer titles will be truncated in the Gradebook view. 

6. Save your settings. 

Create the Automated Agent 

1. Go to the Automate tab to access the Agents Console. 

2. Click Add New Agent to begin the process. 

 

3. The first step is to Name your Agent. In this example, it is Survey 1. 
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4. Select Content Agent as the Agent type. 

 

 

Content Agents will work on content items in Lessons. These are items 
that are viewed or reviewed (files, folders, and all content within them), 
taken (surveys or tests), and/or that require a submission (Drop Box, 
discussion post, survey, and tests). 

5. Notice that new choices will now display beneath the selected Agent. Click Select 
content to monitor to designate the content item that will be used for this Agent. 
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6. A new window will appear. First select the Lesson Type from the drop-down list. In this 
case, the item is a Survey. 

 

 

Notice all the different content items that could be selected, including 
items that are not normally graded within the content item, such as files 
and folders. This same procedure could be used to assign a grade for 
viewing a file, link, web page, and so on. 

7. Select Specific surveys, then click on the survey to be graded (in this case, there is 
only one to select from), and then click Add. 
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8. Click Close Window to continue the process. 

 

9. Now that the survey has been selected, you need to indicate at what point the Agent will 
run. In this case, you need the Agent to run when the survey has been submitted (that 
is, students will receive the grade when they submit the survey). 
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10. The summary at the bottom displays the criteria that have been so far set up at this point 
of the process. Click Next to continue. 

 

11. The next screen defines to whom the Agent will apply. In this case, you want it to apply 
to all users and do not need to designate any specific criteria. Therefore, do NOT make 
any changes on this screen. 

 

There are several ways that user criteria can be set up. Users could be 
restricted to specific users, or users with only student rights (for example), 
or only users on specific teams. Because you have already set up the only 
condition needed (survey submission) and it pertains to all users, you do 
not need to define that further. 
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12. The bottom of this screen summarizes the criteria selected up to this point. Click Next to 
continue. 

 

 

There is an option to define more than one user criteria (Add Another User 
Selection). This is not necessary in this case, but might apply to other 
situations. 

13. On the next screen, designate the action to be taken when the Agent is run. The Action 
Type needed is Grade Assignment. 
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14. Selecting this action opens up other criteria that need to be designated. First, select the 
survey that is to be graded. 

 

 

The Assignments displayed here are those that have already been set up, 
either by creating Assignments in the Gradebook itself or when creating 
the content item. If you had not set up the Assignment when creating the 
survey, you could have set it up as a new Assignment in the Gradebook. 

15. Next, fill in the other information about the Assignment. The point-value (Max Points) for 
the survey was already designated when setting up the survey. Grade For Event 
Originator means that each student who triggers the Agent (by the “Event” which is 
submitting the survey) will receive the grade. Click Add to continue. 
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16. Finally, complete the other information about the Assignment. The choices here indicate 
that everyone (100%) who submits the survey will receive the full points as well as the 
comment. The Locked box is checked to prevent any grades from being overwritten. 

 

17. Click the Next button to continue to the final section. Note that there is an Agent 
Summary of all criteria selected. 

 

18. On the following screen, you will be able to review all settings and edit any as needed. 
Click Save to complete the process. 



How to Post a Grade for a Survey by Using an Automated Agent 345 

 

 
If Agent Type is edited, the entire process will need to be redone, as the 
other Agent types require a whole different set of criteria. 

19. Returning to the Agent Console, you can see that the Agent is now ready to run when 
students submit their surveys. To ensure that this works, try taking the survey yourself 
and then check the grade in the Gradebook. 

 

 

The grades will NOT display in the results for that survey (Utilities > View, 
Grade, Delete Submissions: see example). They will ONLY appear in 
the Gradebook. 
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Course Management Tasks 

This section contains procedures to help you in the management and maintenance of a course.  
It includes such things as grading, setting up calendar items, using course mail, adding 
announcements, and creating course back-up. 

 

Understanding Course Rights 

How to Customize Tabs 

How to Create a FAQ (Frequently-Asked Questions) Section in a Course 

How to Check Student Activity Within a Course 

How to Add or Remove a Student from a Course 

How to Post an Announcement 

How to Add Assignment Dates to the Calendar 

How to Link to Content Items from a Calendar Event 

How to Set Up Live Chat 

How to Set Mail Privileges Within a Course 

How to Create Folders in Course Mail 

How to Share and Edit Files Among Multiple Users 

How to Use the HTML Editor: Changing Fonts and Colors 

How to Backup a Course 

How to Activate/Deactivate a Course 

How to Archive and Export a Course 

How to Populate Course Content into a New Course Shell 

How to Use the Copy Course Wizard to Copy Content from One Course to Another 
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Understanding Course Rights 

Within any course or group, there are several access levels with rights that can be customized. 
Using different levels, the Course Editor or Administrator can limit access to specific content 
items as well as allow certain levels to perform specific functions. Some of the limitations are set 
by the system, and others can be changed by the Course Editor. 

Course rights are set when users are enrolled into a course. The following rights can be 
assigned (these are listed from the lowest to highest access levels): 

 Authenticated Guest 

 Student 

 Team Leader 

 Mentor 

 Course Assistant 

 Course Editor. 

How You Can Limit Access in a Course 

You limit access for different access levels by using specific settings within different sections of 
the course; for example, Content Items. 

1. Within the Access settings of all Content Items, you can specify who can view the item 
in the Viewable By field. 

 

2. You can limit Access to different sections in Manage > Tab Settings. This allows you to 
designate the minimum rights needed to have access to the sections. 
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3. . Go to Manage > Tab Settings. 

 

4. On the next page, use the drop-down list for each tab setting to designate the MINIMUM 
rights needed to access that section. 
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In this example, anyone can view the Home (Course) page. The minimum rights for the 
rest of the sections are: Students/Members (Calendar, Resources, Communicate, 
Report); Course/Group Editors (Automate); or Course/Group Assistants (Manage). 

5. You can further limit the rights of any particular user by editing their permissions. Go to 
Manage > Roster. 
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6. Click the Edit box next to the user whose permissions you want to change. 

 

7. On the next page, click the Permissions tab. 

 

8. The next screen will allow you to change some settings. It will not allow you to give any 
permissions that are not within the access rights for the level of the user. Click the Save 
button at the bottom of the page when you are finished. 
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Authenticated Guest 

An Authenticated Guest is someone who has been authenticated through the ANGEL system 
(that is, someone who has a User account on the ANGEL site) and who was either enrolled into 
the Course and assigned that right, or entered the Course through the Search tool (Find 
Course). This level has very limited access rights. An Authenticated Guest cannot view any 
Student or Instructor tools, and can only view content items that are made viewable to either 
Everyone or Authenticated Guests. 

You might use Authenticated Guest rights for someone that needed to see certain portions of 
the Course, but was not a student in the Course. 

For example, this level could be used to show the Course to someone from another institution. 
You could allow Authenticates Guests to see some of the content items, but not allow them to 
view any discussion forums or any other sections where student names might be revealed. 

 

 
If you want the Course to be accessible to either Anonymous 
(unauthenticated) or Authenticated Guests, you need to set Guest Access 
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to either Anonymous or Authenticated Guest in Manage > General 
Course Settings > Access. 

Student 

Most of the enrollees in the Course will have Student rights. Students normally have Access to 
the Course, Calendar (if used), Lessons, Communicate, and Reports sections. They only have 
access to their own grades. 

 

Team Leader 

This designation would have the same Access rights as Students. You can restrict any content 
items to this Access level and above by designating Team Leader as the minimum Viewable 
By level in a content item setting. A Team Leader would not have any editing rights or Access to 
grading. 

Mentor 

This level also has the same Access rights as Student and might be used for a Librarian or 
Preceptor who does not need grading or editing privileges. As with the Team Leader, you could 
restrict certain content items to be accessible only to this level and above by designating 
Mentor as the minimum Viewable By level in a content item setting. 

Course Assistant 

This Access level would be reserved for Teaching/Graduate Assistants or other course 
members who need to be able to grade and/or take attendance. It does not allow for editing of 
content. They normally have access to the Manage tab as well as the other tabs available to 
Students. Within a content item, they have access to the Reports and the Utilities options. 

 

If the Course Assistant only has responsibility for a specific group of students and not the entire 
class, you can restrict them to only grading that group. 

1. Create a team with a group and its assigned Course Assistant as members. 
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See How to Create Teams for more information. 

2. Go to Manage > Gradebook > Preferences. 

 

3. On the next page, check the box next to the Limit Course Assistants by Team option, 
and then click Save. 
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Course Editor 

This level has the full Access rights and can also set the Access rights for other Course users. 
Course Editors have full editing rights within the Course and can create Agents. As with the 
other levels, some content items could be restricted by limiting it to users at this level. This is the 
level that is typically assigned to course faculty. 
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How to Customize Tabs 

There are several options that can be used to change the way that the tabs display. You can 
choose which tab should be active when a user enters the Course, you can rename a tab, and 
you can delete a tab from a user’s view if it is not being used in your Course. 

 

If you change the display of the tabs, you need to advise the users within 
the Course that these changes have been made to avoid any confusion, 
especially if these changes only pertain to your course(s). Users may be 
accustomed to the normal tab display and will need to know where they 
can find components within the course. They may also be confused if they 
are referring to tutorials that use the default names. 

The default Student view of any course contains only these tabs: Course, Calendar, Lessons, 
Resources, Communicate, and Report. 

 

The Course page is like the course Home Page. By default, it contains the following nuggets: 
Activity at a Glance, Course Announcements, and Grades. 

 

 

See How to Customize the Course Page to learn how add, delete, and 
rearrange components (called “nuggets”) on this and on the Resource and 
Communication pages as well. 
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The Calendar Page contains the Course Calendar. 

 

The Lessons Page is where the course content, activities, and assessments are placed. 

 

The Resources Page contains the Course Syllabus, links to Wikipedia® and Google® Search, 
Course Resources, and Institutional Resources. This page can be edited to have nuggets both 
added and deleted, as well as rearranged. 
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The Communicate page contains the Course Mail, Course Roster, and Course News and 
Announcements nuggets. It also can be edited and customized. 

 

The Report tab opens the Reports Console. This allows students access to their grades, reports 
pertaining to their activity within the course, and also their milestone completions. 

 

1. To customize the tabs, enter the Course and go to Manage > Tab Settings. 
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2. The first option on the Tab Settings page is to determine what page will display when 
users enter the Course. This is the Course page by default, but can be changed by using 
the drop-down list to specify a different page. In this example, you will leave the opening 
page to be the Course page. You do NOT need to designate anything in the Start URL 
field. 

 

3. Beneath the Start Tab Settings section, each tab is listed followed by a Label. The 
“Tab ID” is the name that the ANGEL database uses to denote each tab. The Label is 
the “name” that displays for each tab. This can be changed for any of the tabs by putting 
a different name in the text box associated with the tab to be changed. The Content tab 
is identified with the Label Lessons. 
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For this example, you will change that name to Course Content. 

 

4. The Viewable By column determines what Rights users need to have to access each of 
the pages. To change a tab so that students will not see it, you can either change the 
Viewable By to Disabled or to a level higher than Student. In this example, you will 
delete the Calendar from student view (because it isn’t being used in this Course) by 
changing the Viewable By setting to Course/Group Assistants. 
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Be very careful in designating any tab setting as Disabled, since that 
setting will remove it from everyone’s view – including the Course Editors! 
If you should happen to disable the Manage (Tools) tab, you would be 
unable (as Course Editor) to access the Manage page. (If you happen to 
disable any other tabs, you can still change them again by going back to 
the Tab Settings editor in Manage – but you could not do this if you no 
longer have access to the Manage tab!) 

5. The URL fields are only used if you are specifying a different location for any of the tabs, 
in which case you would input the URL for that location. Click Save to continue. 
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6. The Student view now does not have a calendar and the Lessons tab is changed. 
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How to Create a FAQ (Frequently-Asked Questions) Section in a 

Course 

One user-friendly way to supply information about a course and answer questions that you 
anticipate students will have is to create a FAQ section. This involves first adding a new tab 
called FAQs, creating the web page for the section, and then linking the web page to the new 
section; so that when the student clicks on that tab, the web page of information will appear. 

 

Only ONE page can be linked to a new section. If you need to have 
multiple pages, consider creating a web page as a “menu” for the other 
pages and then linking to those pages within that page. 

1. For adding a new tab: Enter the course to which you want to add the FAQ section and 
go to Manage > Environmental Variables. 

 

2. On the next page, click Add a Variable. 
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3. The Add Variable page will appear. Enter TABS as the Variable Name. 

 

4. For Variable Value, carefully add the following exactly as it is written here: 
HOME=Course,CALENDAR=Calendar,FAQ=FAQs,CONTENT=Lessons, 
RESOURCES=Resources,INTOUCH=Communicate,REPORTS=Report, 
AGENTS=Automate,TOOLS=Manage 

 

In this example, FAQ=FAQs is the tab to be added. The tab name will be 
FAQs. You can name it something different later in the Tab Settings link 
within the Manage section. This will put the FAQ section between the 
Calendar and the Lessons sections. If you want it in a different location, 
then type the new tab information in the location where you want it to 
appear. 
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5. Click Save when you have finished. 

 

6. When you return to the Course Environmental Variables page, click Exit Course 
Variables to continue. 
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Create the Web Page for the FAQ Section 

You will be creating the web page within ANGEL using the HTML Editor. However, you can 
create the web page using other web editing software and then upload it to the course in the 
same location where you will create the web page. 

7. Remaining in the Manage section, click Course Files Manager. 
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8. Click Add Content. 

 

9. On the next page, click Create a Folder so that the page and any files linked to the page 
can be organized within one folder and can be easily located later. 
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10. Name the folder (in this example, FAQs) and then click OK. 

 

11. The folder is now created. Click on it to add content to it. 
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12. Click Add Content. 

 

13. Click Create a File. 

 

If you had already created a web page to upload, you would choose 
Upload Files instead. If the web page has links to other documents and/or 
any images, be sure to upload those also by using either Drag-n-Drop or 
Upload Files. 

 

14. On the next page, name the file (in this case, faq.html). 

 

The file name needs to have the “.html” extension on it to identify it as a 
web page. When naming a file, keep the file name short with no spaces. If 
you want to use several words for the file name, separate them with “_” 
(the underscore character) rather than a space. 
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15. Scroll to the bottom of the File Contents window and click HTML Editor. 

 

16. The HTML Editor toolbar will appear at the top of the window. You can use the toolbar 
to format your page, much like using a word processor. 
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For more information about using the HTML Editor, see the HTML Editor 
Reference Manual in the Guides section of Online Help. 

17. When you have finished developing the page, click OK at the bottom of the window. 

 

18. The web page has now been created. 
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Linking the FAQ Page to the FAQ Section 

19. The final step in the procedure is to have the FAQ page that you either created in 
ANGEL or uploaded into ANGEL appear when the FAQs tab is clicked. 

Within the FAQs folder, as shown in Step 18, do a right-mouse click on the faq.html file 
name. (With a Mac, click and hold.) A menu will appear on the side. 

20. If using Internet Explorer, click Copy Shortcut. 

 

If using Firefox, click Copy Link Location. 
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”  

21. Click Exit Course Files. 

 

22. Staying within the Manage section, click Tab Settings. 
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23. At the FAQs section, paste the link location in the URL column (use Edit > Paste from 
the browser menu, or do a Ctrl-V). This will add the file location for the new tab. 

 

 
If you wanted to rename the FAQs section, you could do that by replacing 
FAQs with a new name within the Label column. 

24. Click Save to finish. 
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25. When the FAQs tab is selected, the new page appears. 

 

 

A FAQ page could also be created and placed in a LOR and then linked 
from that LOR, either as a document within the Lessons tab or by creating 
a FAQs tab as described above and then linking to the document in the 
LOR. 
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How to Check Student Activity Within a Course 

There are two main reports that can be used to check student activity within a course. One of 
the reports generates data about a specific user, while the other one collects data pertaining to 
a group of students. 

1. Go to the Reports tab. This will open the Reports Console. 

 

2. Select the Category of Report from the drop-down list. There are two different types of 
reports that might be chosen. You will demonstrate each one. The first one you might 
select is the Learner Profile. 

 The Learner Profile category will generate a report about a specific user. 
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3. If you want to find out how many times a specific student has logged on, select the 
Logons option in the Report column. 

 

4. In the User(s) column, select the student whose logons you are checking. 

 

5. The Configure Report feature allows you to select the Starting day from which the 
report will begin checking. Note that there are many choices, or you can use the 
calendar to select a specific date. 
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6. The Ending before list will allow you to specify the range needed for the report. In this 
case, you will leave it at Now. 

 

7. Select report view allows you to specify how the report will be formatted. A Chart will 
give a bar graph of logons. A Table will show all dates within the range specified with the 
number of logons by that student per each date. Drill Down gives the most detailed 
information, as you will see. 
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8. Click Run to display the report. 

 

9. The Report will now display. For this example, you can see that the student first 
accessed the course on 1/14/2008. 
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10. Clicking on the “+” beside each date that has logons listed will open up the Activity 
record for that date. In the example below, the “+” has already been clicked. 

 

 
Clicking any of the Activities that are links (as in Assignment 1 above) will 
return you to that activity. 

The other report that can show logon activity is the WhoDunIt Report. 
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1. In the Report Category, choose WhoDunIt from the drop-down list. 

 

2. Choose Last Logon. 

 

3. Since this report is run for a group of users, the selections for User(s) are different. 
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4. These next options allow you to configure the parameters for the report. First select 
whether you want to know which users either have or have not logged on since a 
specified period of time. In this case, you are looking for users who have not logged on 
since last month. 

Next, specify the time period that you need. In this case, you want to see who has not 
logged on since 21 days ago. 

Last, specify the format for the report. Chart will display a bar graph; Table will display 
the names in a table format with the number of days since their last logon. Click Run to 
run the report. 

 

5. In this instance, it has been 26 days since one student logged on, and two other 
students have never logged on (No Data). 
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6. The WhoDunIt report also allows for you to send a mail message to all users within the 
report. Choose Send Mail. 

 

7. The Compose Mail screen will display. Note that all user names to whom the report is 
being sent are in the Bcc: (Blind carbon copy) section. Therefore, they will not see which 
other students are also receiving this mail message. 

8. Compose the mail message, including a Subject: and the message text. 

9. Since these students have not been logging in, it makes sense to have a copy of the 
message go to their external (Internet e-mail) account. Click Send to finish. 

 

 

The message illustrates the use of a token (see $FIRST_NAME$ after the 
“Dear”). When each student receives this email message, the 
$FIRST_NAME$ token will be replaced with that student’s actual first 
name (that is, Ross Hart’s message will begin with “Dear Ross”). This is a 
simple way to personalize this, or any, email message. 
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How to Add or Remove a Student from a Course 

Students can be added or removed from a course using the Roster tool in the Manage tab. This 
tutorial presumes that the student is already in the ANGEL database (that is, the student already 
has an ANGEL account). The ability to add a student account to the ANGEL database may be 
restricted to those with System Administrator rights in many institutions, so that procedure will 
not be demonstrated here. 

1. Open the Course and go to Manage > Roster. 

  

2. This will open the Roster Editor. Click Add a User at the top of the screen. 
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A common error here is to try to enter the name in the Roster Search 
window. However, this tool will ONLY search the names already in the 
Course, so it cannot be used to find students not currently in the course. 

3. On the next page, type in the student’s name or User ID (if known) in the Account 
Search window, and then click Search. You can search by last name, first name, part of 
a name, or user name to find the student. 

 

4. Find the student’s name from the results obtained, and then click the Select button. 

 

5. On the next page, you will designate the Rights needed by the user, as well as the Title. 
In this case, you will give him Student rights, which is the default value. 

 
For more information on the different types of Rights, see Understanding 
Course Rights. 



How to Add or Remove a Student from a Course  385 

6. Select a Title for the user. The default is Student. The Title will display next to the user’s 
name in the Roster and will also be displayed underneath the course name on the user’s 
home page. The Title does NOT determine any rights or permissions. 

 

 

If none of the Titles listed is appropriate for the user being added, you can 
use the Other button to create a new title. The Title created will be limited 
to this Course. 

7. Select the other options required. Hidden will keep the user’s name from displaying on 
the Course Roster nugget. It will appear “grayed out” on the Roster Editor. 

Disabled will disable the user’s Access into the Course, but will keep all associated data 
intact. The name will appear in red on the Roster Editor. Note that you can also assign 
the user to a group or several groups, and you also have the option to send an email 
advising the user of his or her being added to the Course. 

8. Click Save when you are finished. 
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9. The user has now been added to the Course and will appear on the Roster. 
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To delete a user, again go to Manage > Roster to access the Roster Editor. 

1. Click the Delete box next to the user name to be deleted. 

 

When you delete a student, you will no longer be able to access any 
grades for the student or any other data associated with that student in the 
course. If any deleted students should later be added back into the course, 
all data associated with them, including grades and submissions, will then 
still be accessible. Deleting students ONLY deletes them from the course; 
it does NOT delete their user accounts. The data associated with a 
student would only be completely deleted if that student’s user account in 
ANGEL gets deleted. 

 

 

If you are unsure of whether or not to delete users from a course, consider 
disabling their access instead (using the Edit box). This keeps students 
within the course so that you will still see their grades and any reports 
associated with them, but it does not allow the students to get into the 
course. 
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2. The next screen will ask you to confirm the deletion, and it also allows you the option of 
sending the student an email. Click Delete again to continue. 

 

3. If you want to delete several students, you could check the boxes next to each of their 
names and then click the Delete Selected button at the bottom of the page. 
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How to Post an Announcement 

Announcements are a very good way to convey important information to students that they will 
see as soon as they enter a course. Typically, the Announcement nugget is found on the 
Course page, as well as the Communicate page. Announcements can be targeted to be viewed 
by everyone who enters the course, by a specific team, or by a specific User. When creating or 
editing an Announcement, you can specify a date range during which the Announcement is 
visible. 

1. Go to Communicate > Announcements. 

 
You can also add an Announcement by going to the Edit icon on the 
Course Announcement nugget on the Course page. 

 

2. The Announcement Editor page will appear. Click Add Announcement. 
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3. Type your message in the window. The inline HTML Editor allows you to format your 
message. 

 
For more information on using the inline HTML Editor, refer to the HTML 
Editor Reference Manual in the Guides section of Online Help. 

 

4. Select the date range in which you want the Announcement to be viewable. 

 The default is for Announcements to be viewable for one week. 
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Because a Start Date and End Date can be specified, you can create 
Announcements in advance and schedule them to appear when needed. 
For example, you could schedule Announcements reminding students of 
specific assignment due dates or online test dates. 

All Announcements are ordered by the Start Date and time so you can 
change the order of announcements by changing the Start Date and time. 

5. Specify who will be able to view the Announcement in the User drop-down menu. You 
can select Everyone, a specific Team, or an Individual User. 

6. Click Save to post the Announcement. 
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7. The Announcement will be visible on the Course page between the Start and End Dates 
selected. 
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How to Add Assignment Dates to the Calendar 

You can easily add both Assigned dates and Due dates to the Calendar by using the 
Milestones option within the settings for any activity. This means that these dates can be added 
to the Calendar during the process of adding any new activity. 

1. In this example, you will add an Assigned date and a Due date to a Discussion Forum. 
In the Settings for the activity, go to the Assignments tab. 

 
This could be done either when first setting up the activity or by using the 
Settings link once the activity has been created. 

 

2. In the Milestones section, first select a Task Type. A Milestone can be Manually 
marked as completed (that is, the Instructor will manually mark the Milestone as being 
completed within the Milestone option in Reports) or selected here for Item completion 
(that is, as soon as the user submits the Assignment, the Milestone will be marked as 
completed). 

Leaving the Task Type as None will not open the Calendar option. 

 

3. The Assign Date and Due Date sections will open once the Task Type is selected. Put 
in the date that this Assignment was assigned and check the box next to it. Do the same 
for the Date Due. 
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Both dates do NOT have to be assigned. For example, if you do not want 
an Assigned date to appear on the calendar, do not put in a date and do 
not check the box. 

 

4. Add any other settings needed for this activity and click Save. 

 

5. The dates are now on the Calendar. 
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6. When users move the mouse over any of the items on the Calendar, they will see the 
rest of the information when in Grid view as shown below: 

 

7. If they change the Calendar Format to List view… 
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…they will see all the dates and information at once: 

 

8. If you need to add more information to the Calendar postings, you will need to edit the 
posting. In the Grid view, the menu for you to select Edit will appear when you hover the 
mouse over the date/item. 

 

In List view, click the Edit link for that Calendar item. 

 



How to Link to Content Items from a Calendar Event  398 

How to Link to Content Items from a Calendar Event 

One of the more common events listed on a Course Calendar is the due date for a specific 
activity. However, you can also link the event on the Calendar directly to the content item 
associated with it, by using the inline HTML Editor. 

1. In this example, you will link a Discussion Forum Assignment in the Calendar directly to 
that forum within Lessons; so that when users click on the event in the Calendar, they 
can access a link that takes them to the Discussion Forum. To begin, click on the event 
on the Calendar. 

 

 
This same procedure could be done when adding any event to the 
Calendar using the Add link within the Calendar. 

2. Access the Edit link by hovering the mouse over the Calendar event. Click the Edit link. 

 

3. Go to the Notes section of the Event Settings page. 
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4. Type in any text that explains the Assignment, including the text that will hyperlink to 
the actual Assignment. 

 

5. Highlight the text that will be linked to the content item. 

 

6. Click on the Folder/Hyperlink icon on the HTML Editor toolbar. 

 

The Folder/Hyperlink icon  (shown here) will link to items within the 
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Course. 

 

7. A pop-up window will appear. Click on the Map tab. 

 

8. This will display all of the tabs within the Course. Click the expand all link to display all 
of the items within the Lessons tab. 



How to Link to Content Items from a Calendar Event  401 

 

9. Click the content item associated with the Calendar event. In this example, you want to 
link to the Discussion Module 1 Discussion Forum, so you will click on that link. 
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10. The selected text is now linked to that content item. 

 

11. Add any other settings needed and then click Save at the bottom of the Edit Settings 
page. 
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12. When users view the event in the Calendar and roll the mouse over the event, this 
information now appears. 

 

13. Then clicking on the hyperlinked text (Discussion Module 1)… 
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…opens up that content item in Lessons. 

 

 

Because you can link to anything within the Course by using the HTML 
Editor, you could put your entire schedule on the calendar as an 
alternative for students to access their course content. 

14. If the user were viewing the Calendar in List view, the hyperlinked text would appear as 
shown below. 
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How to Set Up Live Chat 

Live Chat allows ANGEL users within a class to hold a “live” (real-time) discussion. The ANGEL 
Live Chat nugget also includes access to a Whiteboard and Desktop Sharing. You can add an 
unlimited number of Live Chat “rooms.” Each instance can be configured for different teams. 

 

If you have different groups working on Group Projects, you could create a 
Live Chat room for each group and give them another option for 
communicating with each other. If you also chose the option to log the Live 
Chat, users will have a transcript of the chat to refer to later. 

1. Go to Communicate > Live Chat. 

2. Hover the mouse over the end of the Live Chat toolbar so that the Edit and other icons 
appear. Click the Edit icon (which looks like a pencil). 

 

3. On the following page, click Add a Live Chat. 

 

4. Input all information on the next page: 

 Title – identifies the Chat (in this example, Group 01) 

 Description – optional; you could input some description or function of the Chat 

 Tracking – set to On will create a log of each Chat session that can be reviewed later by 
all members of that Chat 

 Team – allows you to specify the team to use the Chat; selecting ALL will make it 
available to all users 
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 Viewable By – sets the minimum Rights needed to view this Chat (usually set at 
Students) 

 Start Date/End Date – setting either or both will make it available (and/or unavailable) at 
for the time period set; setting neither will make the Chat continuously available. 

 

5. Click Save to save your settings. 

 

6. The Live Chats Editor page will display, showing the newly-created Chat. Click Exit 
Live Chat Editor to continue. 
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7. The Live Chat now appears on the Communicate page. 
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How to Set Mail Privileges Within a Course 

The default privileges within Mail allow all users full access to emailing anyone within the 
course. However, the Instructor can limit these privileges according the different Course Rights. 

1. To set Mail privileges within a Course, go to Communicate. In the Course Mail nugget 
toolbar, hover over the end so that the Edit icon appears and then click it. 

 The Edit icon is only available to Course Editors. 

 

2. The following page allows you to designate the User Rights for each option. 
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 The Default Minimum Rights is for everyone to have each option. To select a different 
level, use the drop-down list next to each option. 

 

 
For more information on Course Rights, see Understanding Course Rights. 

 Send Internet E-mail allows users to send/forward email messages to the mail 
addresses stored within ANGEL for mail recipients. Those who have this Right will also 
have the option to select whether a copy should go to the recipient’s exterior Internet 
email account when composing the mail message. 

 

While mail messages within ANGEL can be sent to the Internet email 
address associated with users within ANGEL, no email messages from the 
Internet can be sent TO ANGEL mail. Also mail messages from ANGEL 
can ONLY be sent to email addresses already associated with users 
within ANGEL. 

 Send to All Faculty/Leaders permits users to send mail to anyone with Course Editor 
rights within a course. 

 Send to All Students/Members permits users to send mail to anyone with Students 
rights within a Course. 

 Send to Teams allows users to send mail to a Team, which would include all members 
of that team. 

 Send to Individuals permits users to send mail to any individual, including all students 
and faculty. 

 Reply to All permits users to use the Reply to All option when replying to a mail 
message. 
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 In Message Options, checking Send a Copy to Each Recipient’s Internet E-mail will 
automatically send a copy of every mail message sent within the Course to the 
recipient’s Internet E-mail account. 
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How to Create Folders in Course Mail 

The default Folders in Course Mail include Inbox, Trash, Draft, and Sent. You can set up 
additional Folders and move mail into those Folders. This might be done to place mail into 
logical groups. For example, you might want all mail associated with a particular course project 
to be kept in one place. 

1. To create Folders in Course Mail, within any of your courses, go to Communicate > 
View Inbox. 

 

2. On the next page, click the small triangle on the side of My Folders. 

 

3. Select New from the drop-down list. 



How to Create Folders in Course Mail  412 

 

4. A pop-up window will appear. 

Input a name for the Folder and then click Save. 

 

 

When naming folders, remember that the folders will display in ALL your 
courses; so you want to be sure you can distinguish between the different 
courses. In this example, you name the folder Team A so that all of Team 
A’s mail will go there. If you had a Team A in another course and wanted 
to also keep all that team’s mail separated into a folder, you would need to 
have a designation so that you wouldn’t confuse the two. 
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5. The new folder appears beneath the My Folders label. It will appear in the Course Mail 
for all courses belonging to the user who created it. 

 

6. When new mail arrives, it will automatically be placed into the Inbox. 

 

7. To move the mail into a different Folder, click the box next to the mail, and then select 
Send to Folder in the Actions drop-down list. 
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8. Click Go. 

 

9. A pop-up window will appear so that you can designate where the mail is to be moved. 
Note that you have a choice of moving the mail or copying it. In this example, you 
choose Move messages. If you choose the Copy messages option, the original will 
remain in the Inbox with a copy going into the designated folder. Click Continue to 
finish. 

 

10. The following screen shows that the mail is no longer in the Inbox, but has been moved 
to the Team A folder. 
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How to Share and Edit Files Among Multiple Users 

Files can be shared and edited among several persons. How to best accomplish this will 
depend upon the Rights of the persons needing to share the files. If everyone involved has 
Course Editor Rights, the answer is simple: Everyone can edit anything anywhere within the 
Course! 

However, if the need is for students to be able to share and edit files, or a mix of students and 
faculty, a different approach is needed. Student Rights do not allow for the sharing and editing 
of course files. One way to accomplish this would be to use the file-sharing capabilities of 
Teams. 

1. Go to Manage > Teams. 

 

2. This will open the Teams Editor. Click Add a Team. 

 

 
The assumption here is that the members of the Team are already 
selected, which is why the Random Team Generator feature is not used. 
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3. The new Team screen will appear. Give the team a name (for this example, Team A). 
The rest of the options in the General Settings section are optional. 

 

4. In the Team Tools section, change File Sharing to Enabled. 

5. In the Quota field, put in the maximum file size (here 5 MB) for the total files to be 
shared. This size will be based on the types of files being shared, the number of files, 
and your institutional policy. 

6. Click Save to continue. 

 

7. The next screen will allow you to add members to the Team. Check next to each person 
that you want to include in the Team, and then click Add Selected. 
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8. Click the Done button to continue. 

 

 

In this example, there were very few students in the course. If this was a 
much larger course, there could be more than one screen of names. You 
can only add one screen of names at a time; use the Add Selected button 
to choose the names on the screen, then go to the next screen and again 
use the Add Selected button to choose the next set of names. Click the 
Done button when ALL team members have been added. 
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Any Course Editors for the course do not need to be selected as Team 
members; they will be able to access the Team Files even without being a 
member of the team. 

9. The Teams Editor screen now shows that Team A has been created and has 6 
Members. 

 

10. Go to the Communicate section to see the Team Files nugget. 
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11. To add files, click the Team A Files link. On the next screen, click Add Content. 

 

12. All Team A members can now upload files, add folders, or create a file (using the HTML 
Editor) similar to what can be done with files and folders in Lessons. 
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13. Because all Team A Members have Access to this area, they can easily share and edit 
any files within. 

 
Establish a protocol as to how files will be named and renamed, if edited, 
to be able to track who has contributed. 

 

 

Another option for sharing files among non-Course Editors would be to 
create a Group and give all Group members (including students) editing 
rights. Anything created within a Group can be imported into a Course, as 
long as the Course Editor has editing rights to both the Course and the 
Group. 

 

 

Two other ways that Students can share files: 

In a Drop Box, setting Review mode to Peer Review; 

Allowing Students to attach files to a Discussion Forum post. 
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How to Use the HTML Editor: Changing Fonts and Colors 

The HTML Editor works very much like a word processor and is a WYSIWYG-type editor (What 
You See Is What You Get). You can change fonts, add bolding or italicize, align text, and add 
colors. In this example, you will use the Create a Page option to demonstrate the HTML Editor. 
You can also use it by editing an already-created page. 

1. Go to the Course and the location where you want to add a page and click Add 
Content. On the following page, click Page. 

 

2. You will then be able to add the settings and the page text. Add a Title for the page (in 
this example, Chapter 2 Notes). 

 

3. In the Page Text window, add your text. 
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4. The first thing you will do with text is to center the title. Highlight the text to be centered, 

and then click the  icon. 

 

5. Next you will Bold the same text by keeping it highlighted and clicking the B icon. You 
can also italicize and underline text by using their respective icons. 

 

Use “underline” sparingly, if at all. On the web, underlined text generally 
indicates a hyperlink. If you underline text that is not a hyperlink, you may 
confuse your users. 
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6. To change the color of the text, you continue to keep the text highlighted, and click the 
Text Color box. 

  

7. A drop-down “palette” of colors will appear. Select the text color that you want. Here you 
are selecting a dark purple color. 

 

Keep a good contrast between the background color and the text color. 
(That is, if the background is light, choose a dark text.) This will make the 
text much easier to read and will also enable anyone with a color 
deficiency to be able to read the text. (While someone who is unable to 
see blue may not see the text color you intended, they would still be able 
to read it.) 

 

8. You can change the font by keeping the text highlighted and clicking the Font button. 
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9. A drop-down list of all available fonts will appear. The appearance of each one is 
illustrated. Here you are choosing Arial. 

 

 

You may wonder why the choice of fonts is so limited, unlike what you 
may see in other programs. When users view web pages, they can only 
view the fonts that they already have installed in their computers. If the 
font specified is not installed in their computers, the text will revert to a 
default font, often Times New Roman. Best practice is to choose a 
common font that the vast majority of users will already have installed. The 
fonts in the HTML Editor are the most commonly found fonts. 

 

 

A sans-serif font is an easier to read when viewed on a computer screen. 
Sans-serif fonts include Arial, Tahoma, Comic Sans, and Verdana. A serif 
font is easier to read in print, especially when there is a lot of text. 
Common serif fonts are Times New Roman and Courier New. 
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10. The final change will be to make the size of the text larger. Click the Size button. 

 

11. A drop-down list will appear of the sizes available. You will select medium. 

 

12. This is how the text appears after all these changes: 
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How to Backup a Course 

When Backups Should Be Done 

Schools may have different policies as to when backups are to be done and when (or if) 
backups for all courses are done at the System level. However, even if System backups are 
routinely done, they cannot meet the needs for each Course, unless backups were scheduled 
24/7! Therefore, it is up to each Instructor to determine when to do a backup for their individual 
Course(s) and to do their own backups. 

Some circumstances when backups might be warranted: 

 Before adding new content to a course or deleting any content. 

 
This would ensure that a backup was available in case any content is 
accidentally deleted during the addition of new content. 

 After adding new content to a course. 

 This would ensure that a backup contains the latest version of the course. 

 After adding grades. 

 
This would ensure that the backup contains the latest grades. If data were 
lost for any reason, reconstructing and regrading could be difficult. 

 ANYTIME that data that you do not want to lose has been added. You might want to 
backup your Course routinely at least once a week. 

Backing Up a Course 

1. Go to Manage > Backup/Restore. 
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2. Click the Backup Now button to begin the process. 

 

3. The next screen will show the process as it is running. 
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4. When the process has completed, the “clocks” will be replaced with green circles with 
checkmarks in them. Click the OK button to continue. 

  

5. The next screen will show that the backup was successful. There are now more options 
available: Restore Backup and Download Backup. These options are added to this 
screen after a backup has been done for the first time. 

6. You may want to save the backup to another location, such as the hard drive on a 
computer, a flash/thumb drive, or a CD. Should anything compromise the data on the 
server, you would still have an intact backup. 

To save the backup to another location, click the Download Backup button. 
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You may wonder exactly how large the backup file is, since you need to 
ensure you have enough file space to save it. In the above example, it 
says the backup is 3886671 bytes which is the same as about 3887 KB or 
approximately 3.9 MB (1000 bytes = 1 KB; 1000 KB = 1 MB). If you had a 
flash drive that held 1GB (1000 MB = 1 GB), you could download about 
250 copies of this backup file! 

7. Doing so will open up a pop-up window asking whether you want to Open or Save (or 
Cancel) the backup file. Click the Save button. 

 

8. This option will require you to designate where you want the file to be saved. It will also 
allow you to rename the file if you wish. In this case, you are saving it in the Course 
Folder on the C: drive. Once it is saved, it could be burned to a CD or DVD. It could also 
have been saved directly to a removable storage device. 
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If you are using Firefox as a browser, it will default to saving the file to your 
desktop, unless you have changed the settings to download it elsewhere. 

.  

 

The backup file can only be used to RESTORE a course to the way that it 
was when the backup was created. You cannot make changes to any 
content within the backup file. 
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How to Activate/Deactivate a Course 

By default, many institutions create their course shells in a “disabled” state. Students cannot 
view any of their courses when they are disabled. This allows the course designer/faculty to 
develop the course without students accessing it until it is ready. Once the course is ready for 
students to access it, it must be “enabled” or activated. 

Check the course listing in Courses on your Home page in ANGEL to see if the course is 
Disabled. It will appear beneath the course title. 

 

 

In ANGEL 7.3 the default setting is that all disabled courses do not appear 
on the course list unless the Course settings are changed to see them. If 
your institution has not changed this default, you may not be able to see 
your disabled courses. You may need to consult with your System 
Administrator in order to change this setting. 

1. Open the Course, go to the Manage tab and click General Course Settings. 
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2. Select the Access tab. 

 

3. Note that Member Access is set to Editors Only. Using the drop-down list, change to All 
Members and then click Save. 
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The Editors Only setting for Member Access signifies that only Course 
Editors can access the course. This is what designates the course as 
Disabled. 

Changing the setting to All Members will make the course visible to 
anyone enrolled in the course on their Home page. 

 

 

Guest Access: None means that only people listed on the roster can view 
this course. 

Search Engines set to No means that this course will not display in a Find 
a Course search. 

Both of these settings restrict the access to this course. 

If the Guest Access were set to Authenticated or Anonymous, it could 
allow others into the course. They would be able to view any content item 
NOT set to be viewed by Students Only. 

They would be able to find the course via a Find a Course search if that 
option were set to Yes, or via a direct URL link to the course. 

4. Returning to the Home page, note that now the “Disabled” has disappeared from the 
Course listing, indicating that students can now access the Course. 
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If you get calls from students at the beginning of the semester telling you 
that they cannot find your course, the first thing to check is whether or not 
the course is still “disabled”! 

 

 
Reverse this procedure to prevent students from accessing your course 
once the course is over. 
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How to Archive and Export a Course 

By archiving a course, you have a complete copy of the course with all student data within it. 
Should it ever need to be restored, it can be restored from the archived copy that has been 
saved. 

Archiving a Course 

1. Go to Manage .> Export Wizard. 

 

2. Select ANGEL Archive on the next page. 
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3. The next screen will allow you to choose the data that you want to archive. To preserve 
all data (grades, student assignment submissions, discussion postings, and so forth) in 
the Course, leave everything checked. 

 

4. Click the Export button at the bottom of the screen to continue. 

 

5. The next screen will show the progress of the export process. 
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The sections that are still processing have a “clock” icon that will change 
to a checkmark when it is complete. See Lessons\Content and Standard 
Associations in the above illustration. 

6. After all sections have been archived, the Download and Done buttons will be available. 
Click the Download button to save the archive to another location. This might be into a 
folder on your computer’s hard drive or to removable storage media, such as a thumb 
drive. 

 
Once the file has been downloaded to a folder on your computer, it could 
also be written to a CD or DVD. 
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7. This option will require you to designate where you want the file to be saved. It will also 
allow you to rename the file if you want. In this case, you are saving it in the Course 
Folder on the C: drive. Note that the file name ends with .zip. 

 

8. The archive has now been created. It can be used to restore a course with all data intact 
or to populate a new course. 
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How to Populate Course Content into a New Course Shell 

There are several ways to add course content from a previously-developed course into a new 
course shell. 

 

Whenever importing content into a course, always ensure that you are in 
the CORRECT Course. All of these procedures could overwrite content 
already within a course. Note the options available for overwriting content 
and choose them with care. 

Copy Course: A very simple method is to use the Copy Course option within the Import 
Wizard. This can be done as long as the Instructor has Course Editor rights to both the course 
being copied TO and the course being copied FROM. It will copy ALL content from one course 
into another WITHOUT any student data. 

 
Refer to the How to Use the Copy Course Wizard to Copy Content from 
One Course to Another tutorial for the Copy Course option. 

Importing a Saved Archive File 

 

 

This procedure is useful if the Instructor does not have Course Editor 
rights to the course with the content to be used but does have access to 
the archive file, or when a course is no longer available on the ANGEL 
server but a downloaded archive is available. 

1. Enter the course that you want to import content. Go to Manage > Import Wizard. 
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2. Click Content Package. 

 

 

This same option is used to import a test bank from many exam programs, 
such as ExamView®; and also to import content from other course 
management systems, such as BlackBoard™ 

3. On the following screen, click the Browse button to find the file to be imported. 
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4. Find the file to be imported, and then click the Open button in the pop-up window. 

 

Note that in this example, there are 2 files available. The other file has a 
.bak extension, which indicates that it is a downloaded backup of the 
course. The file with the .zip extension is the file that you archived. 
However, a current and complete backup file could also be used to 
populate a course using this same procedure. 

 

5. Click the Upload File button. 
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You would only check the “overwrite existing files” option if the course 
contained content that you want to have deleted when the new content is 
uploaded. 

6. A pop-up window will appear that shows that the file is being uploaded. The process 
could take several minutes if the file is very large. 

 

7. Once the file has finished uploading, a screen will appear showing that the upload was 
successful. Click the OK button to continue. 
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8. The following screen will allow you to designate the portions of the course content to be 
imported. 

 

The archive file that you have uploaded may contain student records, 
grades, emails, submissions, discussion forum postings, and so on, 
depending upon the options selected when the archive was created. 
Uncheck the User Data column so that they will NOT be imported into the 
new course. All assignments will remain, but will not contain any student 
submissions. 

You may also want to uncheck Calendar Items and Announcements if 
you do not want these in the new course. 

 

9. Click the Import Data button at the bottom of the list when finished. 
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10. The next screen will show the progress of the import. When all icons have changed to 
green circles with checkmarks, the process has finished. 

Once it has finished, click the OK button. 

 

11. The process is now complete. 
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Importing Content from a Master Course 

Creating a Master Course is advisable for courses that are being taught frequently. It allows 
you to create a complete course as the “Master” and then import it directly into a new course. It 
never contains any student data. This might be preferable to continually copying courses over 
into new courses semester after semester, which could potentially lead to some degradation of 
links and data. 

Master Courses are also a good solution for a course that has many sections that are taught by 
different faculty. A core group of faculty could develop the Master Course and then make it 
available to all faculty teaching that course. Once the Master Course has been imported into a 
course shell, faculty can edit content within that course. 

1. Create and develop the Master Course. Once a Master Course has been added, it can 
be developed as any other course. 

 

Follow your school policy and procedure for having the Master Course 
shell created. This is often the responsibility of the ANGEL Administrator 
or someone else with System Administration rights. See How to Set Up 
and Use a Master Course for more information. 

2. To import the Master Course that has been developed, open the new course to be 
populated and go to Manage > Import Wizard. 
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3. On the next screen, click Master Course. 

 

4. On the following screen, select the Master Course that you want to have imported. The 
drop-down list will list any Master Course available to be imported to this course. 
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5. Some Master Courses will require a PIN to allow them to be selected and then imported. 
If a PIN is required, you would enter it first in the field beneath the Available Master 
Courses list. 

 

6. Uncheck any of the options that do not apply and then click Import. 

 

 

If this is an empty course, you would not need to check the “backup 
course before import” option or the “replace all existing content” option, 
since they would not apply. 

The “Migrate Quizzes to Assessments” option might be preferable if the 
course being copied from used the Quiz format and you want to change 
to the newer and more feature-rich Assessments format. 
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If you choose to “replace all existing content,” it means that any content 
already added to the course will be overwritten. Leave it unchecked to 
preserve that content, if any. 

7. If you chose the Migrate Quizzes to Assessments option, you will see a pop-up 
window asking if you want to backup any Quizzes before migrating them to 
Assessments. 

 
Creating a backup BEFORE changing formats is generally a very good 
idea! 

 

8. The screen that follows will show the progress of the Copy Course process. The time 
this takes could vary according to the amount of content being copied. Click OK when it 
has finished. 

 

9. The content has now been imported into the new course. 

 

No matter what method is used to import content, it is a good idea  to 
ensure that the import was successful and that there has been no 
duplication of content, especially in the Gradebook, Calendar, and/or 
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Announcements. 
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How to Use the Copy Course Wizard to Copy Content from One 

Course to Another 

Using the Copy Course Wizard in ANGEL allows you to copy all course content from one 
course to another. This includes all items in Lessons, Calendar, Announcements, the Course 
Syllabus, and the Gradebook. Student data, including the Course Roster, Discussion Postings, 
Quizzes and Drop Box Submissions, Grades, and Mail are NOT copied during this procedure. 
The procedure can also be used to copy content from a LOR or Master Course. You need to 
have Course Editor rights for both the course that is being copied from and the course into 
which the content is being copied. 

 

This procedure is used when you need to copy everything from one 
course, LOR, or Master Course to another – excluding student data. It is 
an “all or nothing” process. If you only need to copy certain content items 
from one course to another, use the “Import from Course or Group” or 
“Import from Learning Object Repository” options in Lessons. 

 

 

The Copy Course procedure is useful when teaching more than one 
section of the same course. Develop one section as completely as 
possible, and then copy it to the other section(s). This procedure can also 
be used to copy a course from one semester to the next. 

1. Open the Course that is to receive the copied content. This is usually an empty course 
shell. 

 

Ensure that you are in the CORRECT course. Accidentally copying your 
EMPTY course over the course that you wanted to copy FROM could 
erase everything in that course, leaving you with two empty courses! 

2. Go to the Manage tab and click Import Wizard in the Data Management section. 
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3. Click Copy Course. 

 

4. From the drop-down list on the following screen, choose the course that you want to 
copy the content FROM. 

 You must have Course Editor rights in the course that you are copying 
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FROM, or you will not see the course listed. 

 

5. Uncheck any of the options that do not apply, and then click Import. 

 

 

If this is an empty course, you would not need to check the “backup 
course before import” option or the “replace all existing content” option, 
since they would not apply. 

The “Migrate Quizzes to Assessments” option might be preferable if the 
course being copied from used the Quiz format and you want to change 
to the newer and more feature-rich Assessments format. 

 

 

If you choose to “replace all existing content,” it means that any content 
already added to the course will be overwritten. Leave it unchecked to 
preserve that content, if any. 

6. If you chose the Migrate Quizzes to Assessments option, you will see a pop-up 
window asking if you want to backup any Quizzes before migrating them to 
Assessments. 
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Creating a backup BEFORE changing formats is generally a very good 
idea! 

 

7. The screen that follows will show the progress of the Copy Course process. The time 
this takes could vary according to the amount of content being copied. Click OK when it 
has finished. 

 

8. In this example, you can see that the course content has now been copied to the 
Course Announcements and Calendar sections. 
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